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Siemens Industry Online Support

This document is an article from the Siemens Industry Online Support. The follow-
ing link takes you directly to the download page of this document:

http://support.automation.siemens.com/WW /view/en/62121503

Caution:

The functions and solutions described in this entry are mainly limited to the realiza-
tion of the automation task. In addition, please note that suitable security measures
in compliance with the applicable Industrial Security standards must be taken, if
your system is interconnected with other parts of the plant, the company’s network
or the Internet. For further information on this issue, please refer to Entry ID
50203404.

http://support.automation.siemens.com/WW /view/en/50203404.

If you have any questions about this document, please contact us at the following
e-mail address:

mailto:online-support.industry@siemens.com

For further information on this topic, you may also actively use our Technical Fo-
rum in the Service & Support Portal. Add your questions, suggestions and prob-
lems and discuss them in our large forum community:

http://www.siemens.com/forum-applications
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Warranty and Liability

Warranty and Liability

Note

The application examples are not binding and do not claim to be complete re-
garding configuration, equipment and any eventuality. The application examples
do not represent customer-specific solutions. They are only intended to provide
support for typical applications. You are responsible for ensuring that the de-
scribed products are used correctly. The application examples do not relieve you
of the responsibility to use sound practices in application, installation, operation
and maintenance. When using these application examples, you recognize we will
not be liable for any damage/claims beyond the liability clause described. We
reserve the right to make changes to these application examples at any time
without prior notice. If there are any deviations between the recommendation
provided in this application example and other Siemens publications (e.g. cata-
logs), the contents of the other documentation shall have priority.

We accept no liability for information contained in this document.

Any claim against us — based on whatever legal reason - resulting from the use of
the examples, information, programs, engineering and performance data etc., de-
scribed in this Application Example shall be excluded. Such an exclusion shall not
apply in the case of mandatory liability, e.g. under the German Product Liability Act
(“Produkthaftungsgesetz”), in cases of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or violation of fundamental contractual obligations (“wesentliche Ver-
tragspflichten”). The damages for a breach of substantial contractual obligations
are, however, limited to the foreseeable damage, typical for the type of contract,
except in the event of intent or gross negligence or injury to life, body or health.
The above provisions do not imply a change in the burden of proof to your detri-
ment.

Any form of duplication or distribution of these application examples or excerpts
hereof is prohibited without the express consent of Siemens Industry Sector.

Messages in WinCC (TIA Portal)
V1.0, Entry ID 62121503 4
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1 Preface

1 Preface
1.1 Content

Introduction

In the running process of a system, it is indispensable to output information about
operating states, errors and individual processes visually at a HMI control panel.
The WInCC (TIA Portal) message system offers a message procedure for each

piece of information.

This application provides you with:

e an overview of the different message procedures in WinCC

e support in selecting the adequate message procedure for your application and

the hardware you have

e detailed configuration instructions for the different kinds of messages in WinCC

and STEP 7 Professional.

1.2 Hardware and software components used

The application was set up with the following components:

Hardware components

Table 1-1
Component No. MLFB/order number Note
SIMATIC CPU 317-2 1 6ES7317-2EK14-0AB0
PN/DP
SIMATIC CPU 416-3 1 6ES7416-3ER05-0AB0
PN/DP
SIMATIC HMI TP900 1 6AV2124-0JC01-0AX0
Comfort
Standard software components
Table 1-2
Component No. MLFB/order number Note
SIMATIC STEP 7 1 6ES7822-1AA01-0YA5
Professional V11 SP2
SIMATIC WinCC 1 6AV2101-0AA01-0AA5
Comfort V11 SP2
SIMATIC WinCC 1 6AV2103-0DA01-0AA5
Professional V11 SP2

Messages in WinCC (TIA Portal)
V1.0, Entry ID 62121503
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2 The message system in WinCC (TIA Portal)

2 The message system in WinCC (TIA Portal)

The transmission of a piece of information or of a notice is called a message. In
WinCC (TIA Portal) messages indicate events or operating states.

The WinCC message system and the various message procedures are described
in the following chapters.

2.1 Overview of the message procedures

Introduction

The message system in WinCC (TIA Portal) makes it possible to display and re-
cord operating states and errors which are pending or can occur in a system or a
control panel.

Overview of the message system

The message system processes different message procedures of the control panel
and the PLC. The message procedures are subdivided in system-defined and user-
defined messages:

e user-defined messages are for monitoring the system.
o system-defined messages are for monitoring the control panel and the PLC.

The identified message events are displayed in the control panel. A specific access
to the messages and supplementary information to the individual messages, en-
sure a rapid localization of errors. Downtimes are reduced or avoided.

The following figure shows the structure of the message system in WinCC (TIA
Portal):

Figure 2-1

System-defined alarms User-defined alarms

Ve o

Analog alarm
System messages Discrete alarm PLC alarms
User alarm

Monitoring Monitoring
HMI device / PLC Plant

Messages in WinCC (TIA Portal)
V1.0, Entry ID 62121503 8
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2.2 User-defined message procedure

The user-defined message procedures are for monitoring the system processes.
The message procedures are classified by the type of information required for trig-
gering the message.

User-defined message procedures consist of the following messages:
e analog alarms

e discrete alarms

e PLC alarms

e user alarms

Figure 2-2

User-defined alarms

Analog alarm

Discrete alarm PLC alarms

User alarm

Monitoring
Plant

Note The configured control panel must support PLC alarms and user messages.

Analog alarms

An analog alarm indicates limit value violations during operation. Such an analog
alarm is triggered when a previously defined value of a variable is not reached or is
exceeded.

Example:
If the speed of a motor falls below a certain value, an analog alarm is sent. It con-
tains the following message text: “Motor speed is too low."

Discrete alarms messages

A discrete alarm indicates changes of status during operation. A discrete alarm is
triggered at a defined value (bit) of a variable.

Messages in WinCC (TIA Portal)
V1.0, Entry ID 62121503 9
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Example:

The status of a valve is to be monitored during operation. The status of the valve
can be “open” or “closed”. In this case a discrete alarm is configured for every
status of the valve. When the status of the valve changes, a discrete alarm will be
sent. It contains the following message text: “Valve closed”.

PLC alarms

A PLC alarm indicates the status value of the PLC during operation.

Example:

When the mode switch in the PLC is switched to “Stop”, a PLC alarm is displayed
at the control panel. It contains the following message text: “CPU mode switch to
Stop”.

User messages

A user message monitors the operating actions in the WinCC Runtime Professional
during operation. User messages are triggered by triggering the message number.
A user message can contain the following information:

¢ type and content of the acknowledged message
¢ time of the acknowledgement

e operator
e date
Example:

During the operation of WinCC Runtime Professional, a message of the alarm
class “Errors” is displayed. The operator removes the cause for the error in the sys-
tem and then acknowledges the message in the message display of the Runtime.
In order to monitor which operator removed the error at what time, a user message
to the respective button in the message display is configured.

Messages in WinCC (TIA Portal)
V1.0, Entry ID 62121503 10
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2.3 System-defined message procedures

The system-defined message procedures are for monitoring the control panel or
the PLC.

System-defined message procedures consist of the following messages:
e system-defined PLC alarms
e system alarms

Figure 2-3

System-defined alarms

System messages PLC alarms

Monitoring
HMI device / PLC

Note System-defined PLC alarms must be supported by the configured control panel.
In Chapter 2.4 you will find an overview of the availability of message blocks /
message procedures.

System-defined PLC alarms

A system-defined PLC alarms is for monitoring states and events of a SIMATIC S7
PLC. Diagnose messages and system failures (SFM) of a SIMATIC S7 PLC can be
displayed in a control panel.

Supported message blocks:

e Alarm

e Alarm_8

e Alarm_8P
e Alarm_S

e Alarm_SQ
e Alarm_D

e Alarm_DQ

Messages in WinCC (TIA Portal)
V1.0, Entry ID 62121503 1
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2 The message system in WinCC (TIA Portal)

¢ Notify
¢ Notify_8P

System alarms

A system alarm is put out at the control panel and is for monitoring internal states
of a control panel or a PLC during operation. System alarms inform the operator
about the status of the system indicate communication errors between the control
panel and a PLC.

Example:

If the password for a configured user is entered incorrectly three times in a row, the
control panel shows the following system alarm: ,You tried to log in with a wrong
password three times in a row. You will be blocked and assigned to group no. 0.”

Messages in WinCC (TIA Portal)
V1.0, Entry ID 62121503 12
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2 The message system in WinCC (TIA Portal)

2.4

In this chapter, you will find the various overviews about the availability of message procedures.

Availability of message procedures

Overview control panels and supported types of messages

The following table shows the availability of the various types of messages depending on the control panel used.

Table 2-1

Control panel

Analog alarms

Discrete
alarms

PLC alarms

User alarms

User-defined mes-
sages (diagnostic

System alarms

messages)

Basic Panel X X -- -- - X
OP73, OPT77A, X X - - - X
TP177A

OP77B, TP177B, | X X X - X X
OP177B

TP277, OP277 X X X - X X
MP177, MP277, X X X - X X
MP377

Comfort Panels X X X - X X
WinCC RT Ad- X X X - X X
vanced

WinCC RT Pro- X X X X X X
fessional

Messages in WinCC (TIA Portal)

V1.0, entry ID: 62121503
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2 The message system in WinCC (TIA Portal)

Overview message blocks

The following table gives an overview of the message blocks for PLC alarms.

Table 2-2
Message block | SFB/SFC S7-CPU Acknow- Channels Associated values WinCC WinCC Profes-
ledgement | (signals to be moni- Advanced sional
tored)
ALARM_S SFC 18 S7-300/ 400 - 1 1 X X
ALARM_SQ SFC 17 S7-300/ 400 X 1 1 X X
ALARM_D SFC 108 S7-300/ 400 - 1 1 X X
ALARM_DQ SFC 107 S7-300/ 400 X 1 1 X X
ALARM SFB 33 S7-400 X 1 up to 10 - X
ALARM_8 SFB 34 S7-400 X 8 - - X
ALARM_8P SFB 35 S7-400 X 8 up to 10 - X
NOTIFY SFB 36 S7-400 - 1 up to 10 - X
NOTIFY_8P SFB 31 S7-400 - 8 up to 10 - X
Note The number of configurable message blocks depends on the SIMATIC PLC used.

You will find this information in the device manuals of the respective SIMATIC PLC.

Messages in WinCC (TIA Portal)
V1.0, entry ID: 62121503
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2 The message system in WinCC (TIA Portal)

Overview control panels / message blocks

The following table shows the availability of the various message blocks depending on the control panel used.

Table 2-3

Control panel

ALARM_S

ALARM_SQ

ALARM_D

ALARM_DQ

ALARM_8

ALARM_8P

NOTIFY

NOTIFY_8P

Basic Panel

OP73, OP77A, TP177A

OPT77B, TP177B, OP177B

TP277, OP277

MP177, MP277, MP377

Comfort Panels

WinCC RT Advanced

WinCC RT Professional

XX | X | X|X]|X

XX | X | X|X]| X

XX | X | X|X]|X

XX | X | X|X]|X

Messages in WinCC (TIA Portal)
V1.0, entry ID: 62121503
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3 Configuration of messages in WinCC Basic / Comfort / Advanced

3 Configuration of messages in WinCC Ba-
sic /| Comfort / Advanced

In the following, the configuration of user-defined and system-defined messages
will be explained on the basis of a TP900 Comfort and a WinCC Runtime Ad-
vanced.

Required software components

e  WinCC Basic / Comfort / Advanced
e STEP 7 Professional
Requirements

e A WinCC (TIA Portal) project with configured connections to a S7-300/400 PLC
has been created.

The required knowledge and the procedure for the configuration of a connection
between a control panel in WinCC (TIA Portal) and an S7-300/400 PLC in STEP 7
Professional are not a part of this Application.

3.1 Configuration of user-defined messages

311 Configuration of analog alarms

General configuration of analog alarms

For the configuration of analog alarms in WinCC Basic / Comfort / Advanced,
please proceed as follows:

Table 3-1
No. Action Screens
1. In the project navigation under the folder of the control panel you created, open the “HMI
alarms”.
Devices
HOQ

m 2
2. Open the tab “Analog alarms”.

Panel_S7_300 » HMI_1 [TP900 Comfort] » HMI alarms

=1 Analog alarms H.IJ- Controller alarms ||E System events Hﬂ Alarm classes | 4| r
= % =

Analog alarms
D Meldetext Alarm class | Trigger tag Lirnit Lirnit mode

Messages in WinCC (TIA Portal)
V1.0, Entry ID: 62121503 16
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3 Configuration of messages in WinCC Basic / Comfort / Advanced

No.

Action Screens

In the table, double-click on “<Add new>" to create an analog alarm.

Select the analog alarm you just created and in the inspector window open the tab “Properties
> Properties > General".

‘3 Properties ”‘_i.,lnfo ”& Diagnostics |

Properties Events
General

-
Settings

Trnag=r

Alarm text | Analag Alarm 1

Y

Miscellansous [[&] 1 -

Alarm class: [ Errars Em
Alarm group M alarm group-| 5],

Marne: |Analog_alarm_1

e Under “Alarm text”, please enter the message text in the analog alarm, for example “Ana-
log Alarm 1”

e Under “ID”, please select an alarm number for the identification of this alarm.

e Under “Alarm class”, please select an alarm class for the analog alarm.
In Chapter 3.4 you will find more detailed information about alarm classes.

e If required, please choose an alarm group under “Alarm group” to which the analog alarm
will be assigned.
In Chapter 3.5 you will find more detailed information about alarm groups.

Note

Message texts depend on the language, and depending on your configuration, they can contain
up to 255 characters.

In the inspector window, please open the tab “Properties > Properties > Trigger”.

|Q.Pm|)e|ties ”‘j..lnfo HL[)laqnnstlrs ‘

Properties Events

Trigger

General

Settings

Taaltip Tag:

Miscellansous Delay: |0

Limit Deadband
» Made: | High limit vielation E Maode: | Off E

Value: Ting e Walue: |0

Under “tag”, please create a new tag or choose an existing tag for triggering the analog alarm.

Trigaer

Settings
Tag: |Data_block_1_snalog slarm 1] ...
Delay: [0 2| [Milizecond— [+]
Limit Deadband
Mode: | High limitviolation Iz‘ Maode: | Off |z|
Value: g Value: 0

Under “delay” you can set the time basis after which the analog alarm is to be triggered.

Supported types of data for the trigger tag
e Byte, Char, Word, DWord, Int, DInt, Real, Timer

Note
Only use the tag for triggering the alarm for triggering this alarm.

Messages in WinCC (TIA Portal)
V1.0, Entry ID: 62121503 17
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3 Configuration of messages in WinCC Basic / Comfort / Advanced

No.

Action Screens

Open the drop-down list under “Limit > Value”

Trigger

Settings

Tag: |Data_block_1_tnalog_Alarm_1 | 2]]...

Delay [0 =] [uillis=cond

Limit Deadband

Mede: [High limit viclation Weode: | Off []

T T =
Value . Value: 0

ﬂ Constant
@@ HWl_Tag

e If you want to use a constant as the limit value, select “Constant” and then enter the con-
stant in the “Value” box.

e If you want to use a tag as the limit value, select “HMI_Tag”. Then select the tag or set a
new tag.

Limit “Value > Mode” set the trigger mode of the limit.

Trigger

Settings

Tag: |Data_block_1_Analog_Aarm_1 =],

Delay [0 2| [Milizecond — [+]

Limit Deadband

Made: [ High limit violation 1] Made: [off [

Value Cinck: Value: |0

e “High limit violation”: The alarm will be triggered in case of a violation of the high limit.
e “Low limit violation”: The alarm will be triggered in case of a violation of the low limit.

The configuration of the analog alarm is now complete.

Display of the analog alarm in Runtime on the control panel

If you want to display the analog alarm, an alarm display must have been config-

ured in your project. In this alarm display, the alarm class “Warnings” must be acti-

vated for the display of the analog alarm.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Basic / Comfort / Advanced under system manual, under the

title “Configure alarm display”.

Messages in WinCC (TIA Portal)
V1.0, Entry ID: 62121503
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3 Configuration of messages in WinCC Basic / Comfort / Advanced

Optional settings for analog alarms

Activating the deadband

The deadband prevents that an analog alarm is triggered several times of a proc-
ess value fluctuates around the limit value.

Table 3-2
No. Action Screens
1 Open the analog alarms in the tab “Analog alarms”.
|_n.' Discrete alarms Hﬁ,l Analeg alarms ”_[. Controller alarms ||E System events | 4|k
B =
Analog alarms
1] Meldetext Alarm class Trigger tag Lirnit Lirnit rode
=il [ 2] analog Alarm 1 Errcrs [ Data_bloc. [ [iig~] High limic =]
<Aeld news
2 In the inspector window, please open the tab “Properties > Properties > Trigger”.
|QP|0|)e|ties ”‘j.'.lnfo Hﬂ Diagnostics ‘
Properties Events
Trigger
General N
Settings
Tooltip Tag: |Da(a_|:|-:-:)< 1_Analog_Alarm_
Miscellansous Delay:
fl Limit Deadband
| Madz: [ High limit viclation [=] Mode: off  [+]
i value: | e T C—
In pereent
3 In the drop-down list under “Deadband > Mode” set for which change of alarm status the dead-
band is to be applied.
Trigger
Settings
Tag: |Data_block_1_an
oeley i
Limit Deadband
Macle: | High lirnit violation [~] Mods: of violation
Value: | | NPT 1 case of violation
On exceeding
Onfalling below
4 Under “Value”, please enter a constant that is to be applied or activate the option “in percent” if
the value is to be applied in percent of the limit value.
Trigasr
Settings
Tag: |Data_block_1_an
ey
Limit Deadband
Madz: |High limitvilation [+] Modz: |In case of violation
Value: | Jfind Value: |0
[]in percent

Creating a tooltip

With a tooltip you can provide the system operator with further information and in-
structions in addition to the alarm text.

Messages in WinCC (TIA Portal)
V1.0, Entry ID: 62121503 19
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3 Configuration of messages in WinCC Basic / Comfort / Advanced

Table 3-3
No. Action Screens
1 Open the analog alarms in the tab “Analog alarms”.
|_n.' Discrete alarms Hﬁ,l Analeg alarms ”_[. Controller alarms ||E System events | 4|k
B & =
Analog alarms
1] Meldetext Alarm class Trigger tag Lirnit Lirnit rode
=il [ 2] analog Alarm 1 Errcrs [ Data_bloc. [ [iig~] High limic =]
Aeld e
2 In the inspector window, please open the tab “Properties > Properties > Tooltip”.
‘Q‘Pmpelties "'Li.‘.lnfo Hﬂ Diagnostics ‘
J Properties || Events ‘
Taoltip
General Text
Tricig=r
Taaltip &

Mizcellansous

Under “Text”, please enter the text which is to appear as a tooltip to this analog alarm.

If you want to display a tooltip during operation, a button with the function “ShowHelptext” must
be configured for control panels with a touch-front. For control panels with a keyboard, the
tooltip is displayed when you press the “HELP” button.

Note
The tooltip must not be longer than max. 320 characters.

3. The configuration of the tooltip is now complete.

Configuring a report

If a report is enabled, every alarm and its change of status in runtime will be con-
tinuously displayed at the control panel.

Table 3-4
No. Action Screens
1 Open the analog alarms in the tab “Analog alarms”.
|,n,' Discrete alarms Hﬁ,l Analog alarms ”4] Controller alarms ||E System events | 4|
2 & =

Analog alarms
[} Meldetext Alarm class | Trigger tag Lirnit Lirnit mode

=] [=] Analog Alarm 1 Errars [ Data_bloc. [ g High limit =
<Aeld news
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2. In the inspector window, please open the tab “Properties > Properties > Miscellaneous”.
‘ngpelties H'Li.l.lnfn ||ﬂ Diagnostics |
J Properties H Events |
Miscellanzcus
General Report

[] Enable

Miscellansous

Under “Report”, activate the option box “enable”

Note

Alarms will only be reported, if “Report” is also activated in the “Runtime Properties” concerning
the alarms.

Output of dynamic parameters in the alarm text

It is possible to have a process value or an entry from a textlist displayed in the
alarm text when an analog alarm comes.

Table 3-5

No. Action Screens

1. Open the analog alarms in the tab “Analog alarms”.

Panel_57_300 » HMI_1 [TP900 Comfort] » HMI alarms - EX

‘,n! Discrete alarms ||‘_,l Analog alarms ”4] Controller alarms ||E System events | 4|
=

Analog alarms
D Meldetext Alarm class  Trigger tag Limit Limit mode
= [2] Analog Alarm 1 Errars [ Data_bloc... ]| [#eva] High limi =]

<hid new:

2. In the inspector window, please open the tab “Properties > Properties > General”.

‘g Properties ”‘_i.llnfo ”ﬂ Diagnostics |

Properties Events

General

-
Settings
T

T

Alarm text |Llwal-zg| Hlarm 1

cellancous [ K
Alarmn class [Enors [ &L

Alarm group: | <Mo alarm group

Marne: |Analog_alarm_1

Click the right mouse button in the entry box “Alarm text” or place the cursor in the alarm text
and click on the right mouse button.

Then the context menu will open up.
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No.

Action Screens

Select “Insert tag field” or “Insert textlist field” in the context menu.

Then a dialog for the further configuration of the dynamic parameter (tag) opens up. Please
continue with the section on the chosen tag.

M cut
[

iz Pasts
¥ Delete
£ selectall
gPlopelties : Clear formatting
Properties Events B Eald )
'F- Flashing
General I Italic —
Settings U underine .
oaltip Meldetext | Analog Alarm 1 Aa change to capital letters ]
Mizcellaneaus ID: m
N Alamn class: [Emors =]
Dynamic parameters (tags)
No. Action Screens
4. Add dynamic parameters (tags)
Under “Process > Tag’, please create a new tag or choose an existing tag, which is to be dis-
played in the alarm text.
Note:
If you use a process tag, the acquisition mode for this tag must be set to “cyclic continuous”.
Process
I — )
FLE tag ~
Address:
[<] [T ] ﬂ
|g Prope Format
CPropertes | Events | Display ype: N
roperties ents LE”gth - B ]
General L
General Settings
Meldetext |2nalog Alarn | EETEEACITICE N LS
o TR
J Alarmn class: Emors =]
5. Open the drop-down menu under “Format — Display type” and select the display format for the

process tag.

Note:
The display format must be supported by the data type of the process tag.
Process
Tag: |HMI Tag fi £
FLC tag s
Address: Int
[<] [T ] ﬂ
|g Prope Format
Properties Events |D‘5‘J‘ayt-v|]e' Dzcimal |T‘l Ml
Length: |5 : [
General L
General —
Meldetext |2nalog Alarn | EETEEACITICE N LS
J Alarmn class: Emors =]
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V1.0, Entry ID: 62121503 22




3 Configuration of messages in WinCC Basic / Comfort / Advanced

Copyright © Siemens AG 2012 All rights reserved

No. Action Screens
6. Under “Format > Length”, please enter the number of characters for the display of the tag.
Note:
Choose the length in such a way that all the required characters of the tag entry can be dis-
played.
Process
Tag: |HMI Tag fi £
FLC tag s
Address: Int
[<] il ] ﬂ
|g Prope Format L
JP'DI‘@T"W‘ |D\sp\ayty|:e. ;T‘Tl |
Length: |5 [
General L
mger g
Tooltip Weldatext [2nalog Alarm |EFFEEITITEIEES
Miscellanesus A |
J Alarm class:
7. Confirm the setting by clicking on the symbol.
8. The configuration of the dynamic parameter (tag) is now complete.

Dynamic parameters (tags)

No. Action Screens

9. Add dynamic parameters (textlist)

Process

Textlist "
Tag
ol

FLCtag
[ <] i ] Address ﬂ
|QP|‘0|)e|tie e
JW“W‘ Format
Length -
General L
GM,EI’EI Settings
Weldetext |Analog Alarm 1 -Textlist . 5, Hunresclveds: ]
o
i Alarrn class

Under “Process > Textlist”, please create a new textlist or choose an existing textlist, which is to
be displayed in the alarm text.
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No. Action Screens

10. Under “Process > Tag’, please create a new tag or select an existing tag as an index tag for the
text list.

The tag defines an element / entry of the textlist.

Note:
If you use a process tag as an index tag, the acquisition mode for this tag of this process tag
must be set to “cyclic continuous”.

Process
Textlist | Text_list_1| [
[ El |
FLEC tag Cal
[ <] i ] Address ﬂ
|g Propertie " |
5 Format
Properties Events
Lengeh N
General L]
riger
|: Meldetext |Analog Alarm 1-Text st 5 #unresolvedd: |
Wiscellaneous o
i Amclass [Evors el )
11. Under “Format > Length”, please enter the number of characters for the display of the textlist
entry.
Note:
Make sure to enter the length according to the longest textlist entry.
Process
Tetlist (o) |5
Tag: | HWI_Tag_1 =
FLCtag: A
[ <] [T ] Address: Int ﬂ
E‘.Plopeltie " |
J Properties || Events (At
Length: |5 : [
General —
General :
Trgger SELiEDE
Tookip Meldetent ‘hnalog Alarm 1=Test list: 5 #unresolved#: \
Miscellangous N |
N Alarm class:
12. Confirm the setting by clicking on the symbol.
13. The configuration of the dynamic parameter (textlist) is now complete.
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3.1.2 Configuration of discrete alarms

General configuration of discrete alarms

For the configuration of discrete alarms in WinCC Basic / Comfort / Advanced,
please proceed as follows:

Table 3-6
No. Action Screens
1. In the project navigation under the folder of the control panel you created open the “HMI
alarms”
Devices
RN )

» [ PLC_1 [CPU 217-2 PH/DF]
~ [54 HMI_1 [TP200 Camfart]

2. Open the tab “Discrete alarms”.

Panel_S7_300 » HMI_1 [TP900 Comfort] » HMI alarms -0 EX

E Analog alarms ”4] Controller alarms ||E System events | 4|r
=
=1

|,n,‘ Discrete alarms
> %

Discrete alarms

D Meldetext Alarm class Triggertag Trigge.. Trigger address HMI acl

<t news

3. In the table, double-click on “<Add new>" to create a discrete alarm.
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No. Action Screens
4. Select the discrete alarm you just created and in the inspector window open the tab “Properties
> Properties > General”.
|£,P|o|)e|ties ||‘_i..|nfo ||L Diagnostics |
Properties Events
General
Settings
-< Alarm text: | Discrete Alarm |
1 Alarm class: |Errars ﬂv
Alarm group: | =Ho alarm group= | &L,
Mame | Discrete_alarm_1
e Under “Alarm text”, please enter the message text in the discrete alarm, for example “Dis-
crete Alarm 1”
e Under “ID”, please select an alarm number for the identification of this alarm.
e Under “Alarm class”, please select an alarm class for the discrete alarm.
In Chapter 3.4 you will find more detailed information about alarm classes.
e If required, please choose an alarm group under “alarm group” to which the discrete alarm
will be assigned.
In Chapter 3.5 you will find more detailed information about alarm groups.
Note
Alarm texts depend on the language, and depending on your configuration, they can contain up
to 255 characters.
5. In the inspector window, please open the tab “Properties > Properties > Trigger”.
‘B, Properties ""_i.,lnfo ||L Diagnostics |
Properties Events
Trigger
;Tq‘::‘ Settings
Tag: |<llotag Al
Al nent Bit:
Miscellansaus
Under “tag”, please create a new tag or choose an existing tag for triggering the discrete alarm.
Supported types of data for the trigger tag
e Internal tags as trigger tags Int, Ulnt
e Control tag als trigger tag: Int, Word
Note
Only use the tag for triggering the alarm for triggering this alarm.
6. The configuration of the discrete alarm is now complete.

Display of the discrete alarm in Runtime on the control panel

If you want to display the discrete alarm, an alarm display must have been config-
ured in your project. In this alarm display, the alarm class “Errors” must be acti-
vated for the display of the discrete alarm.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Basic / Comfort / Advanced under system manual, under the

title “Configure alarm display”.
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Optional settings for discrete alarms

Creating a tooltip

With a tooltip you can provide the system operator with further information and in-
structions in addition to the alarm text.

Table 3-7

No. Action Screens

1. Open the discrete alarms in the tab “Analog alarms”.

Panel_S7_300 » HMI_1 [TP900 Comfort] » HMI alarms =N EX

[l Discrete alarms ”ﬂ Analog alarms ||_[| Controller alarms HE System events | 4|r
B =

Discrete alarms

ID Meldetext Alarrn class  Triggertag Trigger bit | Trigger address  HMI acknowledgrnenttag b

LAl 1 |$] Discrete Alarn 1 Enors || Data_bleck_1_4la [ @ = o tag el

2. In the inspector window, please open the tab “Properties > Properties > Tooltip”.
‘g Properties ||‘_i.'.|nfo uﬂ Diagnostics |

Properties Events

Tooltip
General
Tricger Text
Acknowledgment
Mizcellaneous

Under “Text”, please enter the text which is to appear as a tooltip to this discrete alarm.

Note
The tooltip must not be longer than max. 320 characters.

3. The configuration of the tooltip is now complete.

Evaluating the acknowledgement of the discrete alarm in the PLC
The acknowledgement of the discrete alarm can be polled by a tag in the PLC.

Table 3-8
No. Action Screens
1 Open the discrete alarms in the tab “Discrete alarms”.
[l Discrete alarms ”ﬂ Analog alarms ||_[| Controller alarms HE System events | 4|r
= & =

Discrete alarms
D Meldetext Alarrn class | Trigger tag Trigger bit | Trigger address HMI acknowledgmenttag b
LAl 1 |$] Discrete Alarn 1 Enors || Data_bleck_1_4la [ @ = o tag el
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In the inspector window, please open the tab “Properties > Properties > Acknowledgement”.

Properties Events

Acknowledgment

General

HMI
Trigger
Taoltip Tag: "H-: tag) ‘ﬂ
Acknowledgment it [0 [=]

Miscellansous

PLC

Tag: | -lotag 2.

« Under “HMI > Tag”, please choose an existing tag or create a new tag, where the
information can be stored that the discrete alarm has been acknowledged.
e Under “HMI > Bit”, please select the bit that will be set in the selected tag if a discrete alarm

has been acknowledged.

Note

The control panel and the PLC have only read access to the storage area of the acknowledge-

ment tag.

The configuration of the acknowledgement poll is now complete.

You will find more detailed information concerning the acknowledgement concept

in WinCC Basic / Comfort / Advanced in Chapter 3.6.

Configuring the acknowledgement by the PLC

The acknowledgement will be automatic by the PLC without any further operating

action.
Table 3-9
No. Action Screens
1 Open the discrete alarms in the tab “Discrete alarms”.
[l Discrete alarms ”ﬂ Analog alarms ||_[| Controller alarms HE System events | 4|r
= & =
Discrete alarms
ID Meldetext Alarrn class  Triggertag Trigger bit | Trigger address  HMI acknowledgrnenttag b
LAl 1 |$] Discrete Alarn 1 Enors || Data_bleck_1_4la [ @ = o tag el
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2. In the inspector window, please open the tab “Properties > Properties > Acknowledgement”.
Properties Events
Acknowledgment
;‘ecner;.ﬂ HI
Tooltip Tag: [-lia tag EI|
Acknowledgment it [0 [=]
Miscellansous L
E PLC
I Tag: | -lotag ]|
g 2
e Under “PLC > Tag”, select a tag or add a new tag to acknowledge the discrete alarm by the
PLC.
e Under “PLC > Bit” select the bit that with which the PLC is to acknowledge the discrete
alarm.
Note
The control panel and the PLC have only read access to the storage area of the acknowledge-
ment tag.
3. The configuration of the acknowledgement by the PLC is now complete.

You will find more detailed information concerning the acknowledgement concept
in WinCC Basic / Comfort / Advanced in Chapter 3.6.

Configuring a report

If a report is enabled, every alarm and its change of status in runtime will be con-
tinuously displayed at the control panel.

Table 3-10
No. Action Screens
1. Open the discrete alarms in the tab “Discrete alarms”.
[l Discrete alarms ”ﬂ Analog alarms ||_[| Controller alarms HE System events | 4|r
B =
Discrete alarms
D Meldetext Alarrn class | Trigger tag Trigger bit | Trigger address HMI acknowledgmenttag b
LAl 1 |$] Discrete Alarn 1 Enors || Data_bleck_1_4la [ @ = o tag el
<Aed
2. In the inspector window, please open the tab “Properties > Properties > Miscellaneous”.
‘g Properties H‘_i.‘.lnfo ”ﬂ Diagnostics ‘
Properties Events
Miscellanzous
General Report
[7] Enable
Under “Report”, activate the option box “enable”
3 The configuration of the report is now complete.
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Output of a dynamic parameter in the alarm text

It is possible to have a process value or an entry from a textlist displayed in the

alarm text when a discrete alarm comes.
Table 3-11

No. Action

Screens

1. Open the discrete alarms in the tab “Discrete alarms”.

Panel_S7_300 » HMI_1 [TP900 Comfort] » HMI alarms - X

[ Discrete alarms ”d Analog alarms ||ﬂ Controller alarms ”E System events | 4|
= & =
Discrete alarms
D Meldetext Alarm class Triggertag Trigger bit Trigger address HMI| acknowledgmenttag

Ca 1 [Sf Discrete Alarm 1 Errors [ Data_black_1_Ala. [ @ =] Il tag: =

|§.Plopelties ”‘_i.‘.lnfo Hﬂblaqnostl(s |

Properties Events

General
Settings
Alarmn test: | Discrate Alarrm 1
1D:
m Alarm class:
"
[l Alarm graup:
Fl Marne: | Discrete_alarm_1

and click on the right mouse button.
Then the context menu will open up.

2. In the inspector window, please open the tab “Properties > Properties > General”.

Click the right mouse button in the entry box “Alarm text” or place the cursor in the alarm text

3 Select “Insert tag field” or “Insert textlist field” in the context menu.

continue with the section on the chosen tag.

¥ Delete

= Selectall

[<] [

40 Insert tag field

1] Insert textlist field

‘Q Properties E

—

Properties H Events

General

General

Settings

Clear farmatting
B Bcld
-F> Flashing
T italic
U Underline

Aa Change to capital letters

Meldetext | Discrate flanm |

Alarm class:

Then a dialog for the further configuration of the dynamic parameter (tag) opens up. Please
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Dynamic parameters (tags)

No. Action Screens
4. Add dynamic parameters (tags)
Under “Process > Tag’, please create a new tag or choose an existing tag, which is to be dis-
played in the alarm text.
Note:
If you use a process tag, the acquisition mode for this tag must be set to “cyclic continuous”.
Process
[rea 2L |
FLC tag fa
Address:
< L}
G Propert] Format
Properties Events Display type: | Decimal .
General Length: 12 -
General Setti
T ettings | %
Meldetest | Discrete Alarm 1-Tag 5, Funresolved®
cl dgment Kl =
Miscellanzous ) Alarmn class: | Errors [E]...
5. Open the drop-down menu under “Format — Display type” and select the display format for the
process tag.
Note:
The display format must be supported by the data type of the process tag.
Process
Tag: | HWI_Tag_1 1L
FLC tag la
Address: Int
< L}
G Propert] Format
Properties Events | Display type: | Decimal .
General sl -
General Setti
Trigger eHngs vl X
Taaltip Meldetext | Discrete Alarm 1-Tag 5, #unresolveds
c dgrment o |1 =
Miscellanzous N Alarm class: | Errors L.
6. Under “Format > Length”, please enter the number of characters for the display of the tag.
Note:
Choose the length in such a way that all the required characters of the tag entry can be dis-
played.
Process
Tag: | HWI_Tag_1 1L
FLC tag la
Address: Int
< L}
G Propert] Format
,—‘pmpe,ﬁes ’—|E“,m,> Displaytype: | Decimal -
General | L =
General Setti
Trigger eHngs vl X
5 Meldetest | Discrete Alarm 1-Tag 5, Funresolved®
o |1 =
! Alarm class:  Errors L.
7. Confirm the setting by clicking on the symbol.
8. The configuration of the dynamic parameter (tag) is now complete.
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Dynamic parameters (tags)

No. Action Screens
9. Add dynamic parameters (textlist)
Under “Process > Textlist”, please create a new textlist or choose an existing textlist, which is to
be displayed in the alarm text.
Process
Testlist |
Tag |
PLC tag:
4 L} Address: L
[ Properties|
J Properties H Events (Fetmme i
Length: |5 =
Genaral H
General Settings =
Meldetest | Discrete Alarm 1-Textlist: 5. #unresolvedi:
D 1 =
! Alarm class: | Errors ...
10. Under “Process > Tag”, create a new tag or select an existing tag as an index tag for the text list.
The tag defines an element / entry of the textlist.
Note:
If you use a process tag as an index tag, the acquisition mode for this tag of this process tag
must be set to “cyclic continuous”.
Process
Test list: | Text_list_1
[
PLC tag:
4 m Address: L
[ Properties|
J Properties H Events (Fetmme i
Length: |5 =
Genaral H
General Settings =
Meldetest | Discrete Alarm 1-Textlist: 5. #unresolvedi:
D 1 =
! Alarm class: | Errors ...
11. Under “Format > Length”, please enter the number of characters for the display of the textlist
entry.
Note:
Make sure to enter the length according to the longest textlist entry.
Process
Testlist | Text_list_1 [=..
Tag: |HMI_Tag_1 =[...
PLC tag: A
< 1] Address: Int
[ Properties|
J Properties H Events Format
Length: 5 =
Genaral
Gernrera\ Settings =
Meldetest | Discrete Alarm 1-Textlist: 5. #unresolvedi:
D 1 =
an=ous ! Alarm class: | Errors ...
12. Confirm the setting by clicking on the symbol.
v
13. The configuration of the dynamic parameter (textlist) is now complete.
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3.2 Configuration of system-defined alarms
3.21 Configuration of system alarms

For the configuration of system alarms in WinCC Basic / Comfort / Advanced,
please proceed as follows:

Importing system alarms

Importing system alarms is only necessary for projects that were newly created, or
where the system alarms have not been imported.

Table 3-12

No. Action Screens

1. In the project navigation under the folder of the control panel you created, open the “HMI
alarms”.

Project tree

Devices
GO

il ranel 57 300
"’. -
oy Device S
» [ PLC_1[cPu 31
~ [ HMI_1 [TP
1Y ev
% online
1 Puntime settings
vlB
(|
» L5 Hill tags

ks
PLIDP]
} Comfort]

figuration

agnostics

rmanagement

2. Open the tab “System alarms”.

Panel_S7_300 » HMI_1 [TP900 Comfort] » HMI alarms —mEX
|_n1 Discrete alarms ”ﬂ Analog alarms ||_[| Controller alarms | |, System events 4|»

=

System events
D a Meldetext
Global Unkna

Frint: Linki

o e s e R e e

3 Confirm the dialog that appears with “OK”.

Import system events

Do you want to import the system
1 events?

Apparently, no system svents have been
irnported yet

es Ma

The system alarms are then imported into your project.

4. The configuration of the system alarm is now complete.
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Display of the system alarms on the control panel in runtime

If you want to display the system alarms, an alarm display must have been config-
ured in your project. In this alarm display, the alarm class “System” must be acti-
vated for the display of the system alarm.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Basic / Comfort / Advanced under system manual, under the

title “Configure alarm display”.

Defining the duration of the display of system alarms

Table 3-13

No.

Action

Screens

» ] Fanzl_:

50O

B :
iy D netwarks

» [l FLC_7 [CPU 317-2 P/DF]
0 Comfart]

% Online

¥ [ Gereens

Screen management

b g HMI tags
24 Connections
A HMI ala

7 cyeles

1. In the project navigation under the folder of the control panel you created open the “Runtime
settings”
Devices

2. Open the menu “Alarms”:

Manufacturing Practice

Alarm

User administration

Language & font

Note
If you want the system alarms to be permanent, set the display duration to “0”.

Alarms

General

System events

Buffer cl=arancs in percant upan buffer ovsrflov

Alarm group text
Report E

Alarm class colors [

| Dizplay duration in seconds. |

57 diagnostic alarms. | |

With event text: D

Under ,System events > Display duration in seconds*, enter the duration of the display for sys-
tem alarms in the control panel. Input in seconds.

3 The setting of the duration of the display of system alarms is now complete.
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Change message texts for system alarms

The message texts of the system alarms can be adapted or changed if required.
The respective message numbers cannot be changed.

Table 3-14
No. Action Screens
1. In the project navigation under the folder of the control panel you created open the “HMI alarms”.
Devices
RN )
2.
‘_n! Discrete alarms ”ﬁ,t Analeg alarms ”_u Controller alarms =L, System events 4|r
=
System events
D a Meldetext
=l
Select the system alarm for which you want to change the message text.
3 In the inspector window, please open the tab “Properties > Properties > General”.
‘QPlupelties ”"_i..lnfo ||L Diagnostics ‘
Properties Events
General
Settings
Alarm text ‘Re-:u:e does nat contain any data records.
ID: [10112 ]
: Alarmn class: | Systern (&
E HNarne: | SystemEvent_10112 |
Please change the message text of the system alarm under “Alarm text”.
Note
When you change the message text, the number of wildcards must not be modified. A wildcard
example would be: %1.
4. The changing of the message text for the system alarm is now complete.
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3.2.2 Configuration of CPU system diagnostic alarms

The following chapter describes the configuration of the display of system diagnos-
tic alarms of a CPU on an HMI control panel using the following components:

e CPU 317-2 PN/DP
o Diagnostic status DB 127 (RSE_DIAGNOSTIC_STATUS_DB)
e Comfort Panel TP900

System diagnostic data blocks

You will find more information about the diagnostic blocks under the name of the
respective block in the Online Help for STEP 7 Professional.

Table 3-15
Block Block name Block Functional scope
number
Diagnostic status RSE_DIAGNOSTIC_STATUS_DB | 127 Display the system status of
DB a configured component and
the subordinate components.
PROFINET 10-DB RSE_PROFINET_IO_DB 126 Display the status of all the
configured 10 devices, op-
tionally: display exact status
of a device.
PROFIBUS DP-DB RSE_PROFIBUS_DP_DB 125 Display the status of all con-
figured stations of the current
DP master system and the
status of the DP slave.
Settings in STEP 7 Professional
Table 3-16
No. Action Screens
1. In the project navigation under the folder of the CPU you created, open the “Device configura-
tion”.
Project tree m 4
00 b
S
3 Zj Local medules
2. In the graphic view of the device, mark the CPU on the module carrier.
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No. Action Screens
3 In the inspector window, please open the tab “Properties > Properties > System diagnostics” >
“General’.
|QP|0|)elties "_i..lnfo || % Diagnostic
J General ‘
= General
D:A.ctru'a(e systern diagnastics forthis FLC
4. Activate the option box “Activate system diagnostics for this PLC”.
The option box “Send alarms” is activated by default. If this option is deactivated, it must be
activated
General
| Activate system diagnestics for this PLE
send alarms
[ Load system diagnastic black when loading hardware configuration
The option box “Load system diagnostic block when loading hardware configuration” cannot be
activated, since it is already activated by default.
5. In the inspector window, please open the tab “Properties > Properties > System diagnostics” >
“Diagnostic support”.
General
Clock memary S
b e Diagnostis suppart
Diag 4y Additional blocks for diagnostic data
¥ Systern diagn C
General Elock name EBlack nurnber
b _Alarms Diagnastic status DE
‘
erm diagnostic
» anced settings _[¥
» T Extended diagnostic settings
== Query far status "activatedideactivated" after startup
N IESOUrces Send alarm if status changes framite activated or deactivated
< B
Check whether the option box “Diagnostic status DB” is activated.
If the option box is deactivated, active the option box.
6. In the entry box “Block name®, enter the name of the status DB you want to use for the diagnos-

tic function.

Additi I blocks for di ic data

Elock name Elock number

L

Diagnastic status D' | pSE_DIAGHOSTIC_STATUS_DE

You can also assign a different name for the block, if the name is not being used.

Note

The status DBs “PROFINET |0-DB” and “PROFIBUS DP-DB” only have a limited diagnostic
functionality. Therefore, the “Diagnostic status DB is to be preferred.
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No. Action Screens
7. In the entry box “Block number”, enter the respective data block number of the status DB.
You can also assign a different number for the block, if the number is not being used.
Additi I blocks for diag ic data
Black name Elack nurmber
=] Diagnastic status DB: | RSE_DIAGNOSTIC_STATUS_DE  |[[127 |
FROFINET IO DE ‘ | | |
FROFIBUS DF DB | [ ]
8. Right-click on the CPU in the project navigation.
Devices
HO O 2 =8
PLC al
Mame
=]
Open
Open in new aditor
¥ oo crrle
22 Copy CtrleC
g Paste Ctrl+y r
* Delets Del i
Rename F2 el
Texts
Attribut

Hardware configuration

& Goonline ctrlal oftvare
&Y o offline Crrleld Software (rebuild all blacksy
N Online & diagnostics CtrleD

a .-

Select “Compile > Hardware configuration” in the context menu.

Note

After the compilation of the hardware, the following system blocks are created:
e system diagnostics (in this example the DB 127)

e diagnostic FB (pre-set: FB 49)

¢ Instance DB for the diagnostic FB (pre-set: DB 49)

e Global DB (pre-set: DB 50)

e diagnostic FC (pre-set: FC 49

9. Transfer the configuration into the PLC.

The necessary settings in the STEP 7 Professional are now complete.
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Settings in WinCC Basic / Comfort / Advanced

Table 3-17
No. Action Screens
1. In the project navigation under the folder of the control panel you created open the “Runtime

settings”.

Devices
GO@

= ] Panel_s57

Y Runtime settin

¥ [ Gereens
» T}] SoreEn managemeant
b L HMI tags

%2q Connections

L4 HMI alarms

;J Fe

0l His

Open the menu “Alarms”:

2.
Panel_S7_300 » HMI_1 [TP900 Comfort] » Runtime settings -
General Alarms
General
::m'am_m — Buffer clarance in percent upon buffer overflow:
Alarm group text | QGR
Toer administration Report v
Languags &font Alarm class calars: @
System events
Display duration in seconds: |5 |3
57 diagnostic alarms: D With eventtext: D
3 Under “System events”, activate the option box “S7 diagnostic alarms”

Panel_S7_300 » HMI_1 [TP900 Comfort] » Runtime settings -

General
Alarms
General
j Buffer clearance in percent upen butfer overlow:
Manufacturing Fractice
A - | a6
Alarms larrm group text | QGR
User adrministration Repart:

Languags &font Alarrm class calors:

System events

Display duration in seconds: |5 =

57 diagnostic alarms: @ With event et E |

If you want to display the message text next to the message number, the option box “With event
text” must also be activated.
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No. Action Screens
4. The display of the system diagnostic message in WinCC is then in the alarm class “Diagnosis
events”.
" TNo.  [Time  [pate [Stats  [Text B
|3P|opelties ":i..lnfo ||L[)|aqnnst|rs
J Properties || Animations || Events
=% Property list General
?f'ﬁ'”al . Display
CppesTanes @ current alarm states Alarm class Enable
D":I- y [w] Pending alarms Emors =]
Text farmat Unacknawlzdged alarms g g
el ) Alarm butfer =
Column headers - :|
Colurnns =
Filter 8
() &larm lag
You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Basic / Comfort / Advanced under system manual, under the title
“Configure alarm display”.
5 Transfer the configuration into the control panel.
The necessary settings in WinCC are now complete.

Display of the CPU system alarm on the control panel in runtime

Note

If you want to display the CPU system alarm, an alarm display must have been
configured in your project. In this alarm display, the alarm class “Diagnosis events”
must be activated for the display of the CPU system alarm.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Basic / Comfort / Advanced under system manual, under the

title “Configure alarm display”.

The diagnostic buffer of a Simatic CPU with integrated web server can also be
displayed directly on a SIMATIC Panel.
Please find further information on this topic in the entry:

http://support.automation.siemens.com/WW/view/en/59601288
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3.3 Configuration of PLC alarms

Message blocks

The following table shows all the message blocks supported by WinCC Basic /
Comfort / Advanced.

Note The use of the message blocks depends on the control panel used.
In Chapter 2.4 you will find an overview of the availability of message blocks /
message procedures.

Table 3-18
Message SFB / SFC Data type Properties Characteristic Features
block

ALARM_S SFC 18 C_Alarm_s 1 signal, Every call and signal
no acknowledgement, change to the previous
up to 1 associated value block call, creates an

alarm.

ALARM_SQ SFC 17 C_Alarm_s 1 signal, like ALARM_S
acknowledgement possi-
ble,
up to 1 associated value

ALARM_D SFC 108 C_Alarm_s 1 signal, like ALARM_S
no acknowledgement
possible,
up to 1 associated value

ALARM_DQ SFC 107 C_Alarm_s 1 signal, like ALARM_S
acknowledgement possi-
ble,
up to 1 associated value

3.31 Configuration of ALARM_S messages

An ALARM_S is a PLC alarm that generates a message after a signal change (ris-
ing edge) and sends it to all the participants in the message procedure.

An associated value can be configured to an ALARM_S which will be displayed in
addition to the message text.

All the alarms that are sent via the ALARM_S message block imply an acknowl-
edgement. A subsequent acknowledgement is not necessary.

Parameters of the ALARM_S message block

The following table shows all the parameters of the ALARM_S message block.
Table 3-19

Para- Declaration Data type Memory area Description
meters
SIG Input BOOL E,A,MD,L The signal that triggers an
alarm.

ID Input WORD E,A M, D,Lor Data channel for the mes-
constant sages: W#16#EEEE

EV_ID Input C_Alarm_S E,A, M D,Lor Message number of the
constant alarm (no “0” allowed)
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Para- Declaration Data type Memory area Description
meters
SD Input BOOL (not allowed: E,AMD,T,Z Associated value
Bitfield), BYTE, max. length 12 bytes
CHAR, WORD, INT,
DWORD, DINT,
REAL, DATE, TOD,
TIME, S5TIME,
DATE_AND_TIME
RET_VAL Output INT E,A MD,L Error code output.

Configuration in STEP 7 Professional

For the configuration of an ALARM_S message STEP 7 Professional, proceed as
follows:

Creating a function block

Table 3-20
No. Action Screens
1. In the project navigation under the folder of the CPU you created, open the “Program blocks”.
Devices

FHOO

= ] Fanel s
e
i D

i
~ @ FLc_1[cPu3
Iy o=

% Online

2 PI/DR]

nfiguration

Frdd 3

4 II0_FLT1 [0B32]
& I/0_FLT2 [0BE3]
4 RACK_FLT[OBS6]
4 OBNL_FLT [0BS5]
4 Wain [CB1]

» [} Extem
» (@ FLCtags
» L

=

2. Open a function block with a double click (e.g. FB1) in which you would like to configure the
ALARM_S message or create a new function block and open it.
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No. Action Screens
3 Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.
b | Extended instructions
Narne Description
» [7] String + Char ]
» [ s irmage
y [ =
y [0
» [0
» [0 pts
& ALA 5 Generate alarm me
5 Generate alarm meszage with
Determine the ackr grnel
write a user dia
Read aut dynamically a
Delete dynarnically assi
ol
-\m\-hm‘:tl‘_’-n;
EIE
b |TE(|‘II|0|0(Jy
> |C0mmunicatiun
4. Drag & drop the message block “ALARM_S” into an empty network of your function block.
w Block title: ..
Comment
v §4Network 1:  Alann_s
Comment
ALARM_S
— EN
fp— 1
10
EV_ID RET_VAL
a0 ENO —
Mo tags used
5. In the block interface of the function block, declare the static variables the parameters of the

message block.

Please find the required parameters in the chapter "Parameters in the ALARM_S message
block”.

g b AEREEED C6s = &

Interface
Hamne Data type Offset  Default.. Visible in

1 < = Input
2 @ I Bool 00 false =]
3 as. EV_ID c_Alarm_s 2.0 =]
4 40 - Output
5 = RET_VAL_1 Int 80 0 =]
& 40 = Indut
7 = Adlel nes
8 40 - Static
9 g S0 Waord 100 0 =]
10 €0 - Temp
1
1

Note on the input “ID”

The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE". In this sample configuration the value is directly written at the input without using
an additional variable.

If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.
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No. Action Screens
6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.
2 s=1 o4 = = =]
» Blocktitle: ..
- Metwork 1:  Alarm_s
_Is ALARM_S
w #I1G
fai? FobAWT
Note
In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.
7. The configuration of the ALARM_S message in the function block is now complete.

Creating an instance data block

No. Action Screens
8. Open an organization block (e.g. OB1) in your project.
9. Call the function block where you configured the ALARM_S message block in this organization
block (e.g. OB1).
Then a dialog for creating the instance data block opens up.
T L :
Camment SR “
Data black
» £3MNetwork 1:  AL:RM_S E [AL&RM_S_DE [+]
Comment EEI S
Single ) Manual
Instance —
e @ Autormatic
"ALARM_S" The called function block saves its data in its own instance
data black
Ell ENC
316 RET_VAL_1
[[x]
BV D More
10. Click on “OK?” to confirm.
Now, all the required parameters are automatically connected and a message number is cre-
ated. The message number is entered at the input “EV_ID” automatically.
w Block title:  "Main Program Sweep (Cycle)"
Carnrment
- Network 1:  AL4RM_S
Camment
OB
“ALARM_S_DE"
WFET
"ALARI_S"
EN ENC
false =i 51 RET_WAL_1
10
DWW 52E000_
1 —{EV_ID
11. The instance data block is now created and is called by the organization block.

Messages in WinCC (TIA Portal)
V1.0, Entry ID: 62121503




Copyright © Siemens AG 2012 All rights reserved

3 Configuration of messages in WinCC Basic / Comfort / Advanced

Configuring the message text of the ALARM_S message

No.

Action Screens

12.

In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Project tree

Devices
40O

ks
317-2 PH/DF]

b [ Program
» ZHT?‘:h
» @ External

» r\n L lles
¥ 53 HMI_1 [TP900 Comfart]
v [§§ common data

13.

Select the ALARM_S message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.

PLC alarms

Mame Type D Range Location Meldetext Infotext Alarm class

1 [ Alarm_s Alarm_s 1 Alarm_5_FB g % &7 -nocla

;

Ld. Properties ||1i.'.lnfo H | Diagnostics

General

General

Texts

Atributes

Hame Text
1 | info text P
2 Alarm text &'
3 Additional text 1 &'

e Under “Alarm texts” please enter the message text for the ALARM_S.

e Optionally, a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.
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No. Action Screens
14. In the inspector window, please open the tab “Properties > Properties > Attributes”.
|ng|)elties H'Li.llnfo Hﬂ Diagnostics |

J General ‘

?::ml Attributes
(o] Display class [ repore
Priarity __ [& with acknowledgment
Alanm class Ea
Group 10

e Under “Alarm class”, please select “System_Acknowledgement”.

In Chapter 3.4 you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM_S.”

e  Under “Priority”, choose a priority for the display of the ALARM_S.” The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM_S. Alarms that belong to
the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledgement

is possible. If you use alarm blocks without the possibility of an acknowledgement, this option

has not function.
15. Right-click on the CPU in the project navigation.
16. Select “Compile > Software (rebuild all blocks)” in the context menu.
PLC al
Marne
Open _m
ot s
Crl+y
X Deletz Del ! c’e"‘"l
Goto librar
»
G Download to device »
P & Goanline Curleke :
» el
* ctrl+l
vl
17. Transfer the configuration into the PLC.

The configuration of the ALARM_S is now complete.
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Display of the Alarm_S on the control panel in Runtime

If you want to display the Alarm_S, an alarm display must have been configured in
your project. In this alarm display, the alarm class “System_Acknowledgement”
must be activated for the ALARM_S.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Basic / Comfort / Advanced under system manual, under the
title “Configure alarm display”.
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3.3.2

Parameters of the ALARM_SQ message block

Configuration of ALARM_SQ messages

An ALARM_SQ is a PLC alarm that generates a message after a signal change
(rising edge) and sends it to all the participants in the message procedure.

An associated value can be configured to an ALARM_SQ which will be displayed in
addition to the message text.

All the alarms that are sent via the ALARM_SQ message block imply an acknowl-
edgement. The alarm can be acknowledged on the control panel.

The following table shows all the parameters of the ALARM_SQ message block.

Table 3-21
Para- Declaration Data type Memory area Description
meters
SIG Input BOOL E,AMD,L The signal that triggers an
alarm.
ID Input WORD E,A M, D,Lor Data channel for the mes-
constant sages: W#16#EEEE
EV_ID Input C_Alarm_S E,A MD,Lor Message number of the
constant alarm (no “0” allowed)
SD Input BOOL (not allowed: E,AMDT,Z Associated value
Bitfield), BYTE, max. length 12 bytes
CHAR, WORD, INT,
DWORD, DINT,
REAL, DATE, TOD,
TIME, S5TIME,
DATE_AND_TIME
RET_VAL | Output INT E,A M D,L Error code output.
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Configuration in STEP 7 Professional
For the configuration of an ALARM_SQ message STEP 7 Professional, proceed as
follows:

Creating a function block
Table 3-22

No. Action Screens

1. In the project navigation under the folder of the CPU you created, open the “Project blocks”.

Project tree

Devices
Q@

=vices & networks
= [ PLC_1[CPU 317-2 PI/DF]

I o

4 II0_FLT1 [0B32]

& I/0_FLT2 [0BE3]

4 RACK_FLT[OBS6]
4 OBNL_FLT [0BS5]
4 Wain [CB1]

& Elock_1 [FE1]

v [} Extemal
» (@ FLCtags

CAFLC alarms
E] Text lists
2. Open a function block with a double click in which you would like to configure the ALARM_SQ
message or create a new function block and open it.
3 Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.
~ | Extended instructions
Narne Description
» [ string + Char ]

Write a user d

Deleta dynamically ass

snal functions E"z‘

b |TE(|‘II|0|0(Jy

> |C0mmunicatiun
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No. Action Screens
4. Drag & drop the message block “ALARM_SQ” into an empty network of your FB.
w Block title:
v 3Network1:
ALARM_SQ
-
E;_\D RET_VAL
Mo tags used
5. In the block interface of the function block, declare the static variables the parameters of the
message block.
Please find the required parameters in the chapter “Parameters of the ALARM_SQ mes-
sage block®.
Wl o i B Egt W el == § 7
Interface
- Hame Data type Offset Default . Visible in
1 < = Input
2 @ I Bool 00 false =]
3 as. EV_ID c_Alarm_s 2.0 =]
4 4 - Output
5 @ RET_VAL_1 Int 80 i} =]
6 4l - InOut
] @: Etatl;.:‘l:‘ll%
9 @ sD Word 100 [i} =]
10 <@ = Temp
1 = Add nes
12
Note on the input “ID”
The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without
using an additional variable.
If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.
6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.
2 s=1 o4 = = =]
» Blocktitle: ..
- Network 1:  slarm_sg
ALARM_SQ
—EN
V&1 "=EJE#E‘:_ I;G
w #I1G
fai? FobAWT
Note
In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.
7. The configuration of the ALARM_SQ message in the function block is now complete.
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Creating an instance data block

No. Action Screens
8. Open an organization block (e.g. OB1) in your project.
9. Call the FB in your application program, for example in the OB1.
Then a dialog for creating the instance data block opens up.
™ Bloclctities o Frogrem Swecp (G [Caf options =R
o Data black
~ 3 Metwork 1:  ALARM_5Q Hams |ALRKI_50_DE [+
Comment namber [ 3]
|\;:t5\:ia D) e
e = @ Automatic
MALARNM_SQ" The called function black saves s data in itz own instance
- o — data black.
—5IG RET_VAL
EV_ID
oo Maore..

Mo tags used

10. Click on “OK?” to confirm.

Now, all the required parameters are automatically connected and a message number is cre-
ated. The message number is entered at the input “EV_ID” automatically.

w Block title:  "Wain Program Sweep (Cycle)"

Cormment

- Network 1:  ALaRW_SQ

Carnment
%DB1
"ALARNW_SC_DE"
%FB1
“"ALARM_SQ"
EN ENC
faloe — 516 FET_VAL
EV_ID
Els)
11. The instance data block is now created and is called by the organization block.

Configuring the message text of the ALARM_SQ message

No. Action Screens

12. In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Project tree
Devices

10O

~ [ PLC_1[CPU 317-
Y oevie

% onlin

b [ Program

» r:ﬂT?‘:hl

» @ External

v Lg FLC

» (g FLC dlata

P Local mo
» [ HMI_T [TP900
v [§§ common data

Comfart]
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No. Action Screens
13. Select the ALARM_SQ message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.
PLC alarms
Marne Type ] Range Location Meldetext Infotext Alarm class
1 [ Alarn_S5Q Alanmn_s 1 ALARM_SG_FE P &9 enocla
|§,Plopelties H‘_i..lnfo HL Diagnostics
-_E:%:m‘ ‘ Texts
o MName Text
1 Infotext P
2 | Alarmtex =
3 Additional test 1 &
e Under “Alarm texts” please enter the message text for the ALARM_S.
e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.
14. In the inspector window, please open the tab “Properties > General > Attributes”.
‘QPlupelties H"_i..lnfo ||L Diagnostics |
General
f::rdl Attributes
Display class | @ - tepart
Frierity |0 - [ with acknowledgment [ %
alarm class | <no class: -
Graup D |0 .

e Under “Alarm class”, please select “System_Acknowledgement”.

In Chapter 3.4 you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM_SQ.”

e Under “Priority”, choose a priority for the display of the ALARM_SQ.” The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM_SQ. Alarms that belong
to the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledge-

ment is possible. If you use alarm blocks without the possibility of an acknowledgement, this

option has not function.
15. Right-click on the CPU in the project navigation.
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No. Action Screens
16. Select “Compile > Software (rebuild all blocks)” in the context menu.
Devices
HOO # |2®c
PLC al
* | ] Panel_! Narne
K =
Open

: i

Curl+

cerleC
Crl+y Jm

¥ Delete

Fename

Goto device
Goto librar

.v
GE~---

e Online & diagnostics

how force valuss

Del
F2

General
Texts
Attribut

ctrlek
Crlell
Ctrl+

are (rebuild all blocks)

17. Transfer the configuration into the PLC.

The configuration of the ALARM_SQ is now complete.

Display of the Alarm_SQ on the control panel in Runtime

If you want to display the Alarm_SQ, an alarm display must have been configured
in your project. In this alarm display, the alarm class “System_Acknowledgement”

must be activated for the ALARM_SQ.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Basic / Comfort / Advanced under system manual, under the
title “Configure alarm display”.
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3.3.3

Parameters of the ALARM_D message block

Configuration of ALARM_D messages

An ALARM_D is a PLC alarm that generates a message after a signal change (ris-
ing edge) and sends it to all the participants in the message procedure.
An associated value can be configured to an ALARM_D which will be displayed in
addition to the message text.

All the alarms that are sent via the ALARM_D message block imply an acknowl-
edgement. A subsequent acknowledgement is not necessary.

The following table shows all the parameters of the ALARM_D message block.

Table 3-23
Para- Declaration Data type Memory area Description
meters
SIG Input BOOL E,AMD,L The signal that triggers an
alarm.
ID Input WORD E,A M, D,Lor Data channel for the mes-
constant sages: W#16#EEEE
EV_ID Input C_Alarm_S E,A MD,Lor Message number of the
constant alarm (no “0” allowed)
CMP_ID Input DWORD E,A M, D,Lor ID for the subsystem to
constant which the message is as-
signed (not allowed: 0)
Recommended values:
e low word: 1to 65535
e high word: 0
SD Input BOOL (not allowed: E,AMDT,Z Associated value
Bitfield), BYTE, max. length 12 bytes
CHAR, WORD, INT,
DWORD, DINT,
REAL, DATE, TOD,
TIME, S5TIME,
DATE_AND_TIME
RET_VAL Output INT E,A MD,L Error code output.
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Configuration in STEP 7 Professional

For the configuration of an ALARM_D message STEP 7 Professional, proceed as

follows:
Creating a function block
Table 3-24
No. Action Screens
1. In the project navigation under the folder of the CPU you created, open the “Project blocks”.
Devices
FHOO

i D

i
= [ PLC_1[CPU 317-2 PI/DF]

& netyvorks

i ~dd newblack
4 II0_FLT1 [0B32]
& I/0_FLT2 [0BE3]
4 RACK_FLT[OBS6]
4 OBNL_FLT [0BS5]
4 Wain [CB1]

& Elock_1 [FE1]

5 Fragrarm infa

CAFLC alarms
E] Text lists
2. Open a function block with a double click in which you would like to configure the ALARM_D
message or create a new function block and open it.
3 Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.
~ | Extended instructions
Narne Description
» [7] String + Char ]

» [ ] Module parameter.
» [ Intzrrupts

v [ Alarming

Generate alarm message

Determine the ackr lgrner

Write a user dia

dynarnically

namically as

sing

nal functions E"z‘

b |TE(|‘II|0|0(Jy

> |C0mmunicatiun
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No. Action Screens

4. Drag & drop the message block “ALARM_D” into an empty network of your FB.
w Block title: ..

Comment

> 3 Network 1:;

Cormment

ALARM_D
» e
o
Z:;‘jo RET_VAL
50 EMNO —
Mo tags used
5. In the block interface of the function block, declare the static variables the parameters of the

message block.
Please find the required parameters in the chapter “Parameters of the ALARM_D
message block®.

%S == i EE%!

Interface

CQCO’B" == f %

Narne Data type Offset Default value Wisible in ..
| <l ~ Input
2 q4@n 351G EBool 00 false
3 4. EV_ID c_tlarm_s 20
4 |41 = CMP_ID Dward 60
S <0 - Output
6 4w RET_VAL Int
8
9
10

0 DE®

< = InOut
= Add new
9 40 - Static

a= 5D Werd E 20 0 =]
11 4@ ~ Temp

Note on the input “ID”

The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without
using an additional variable.

If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.

6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.

¥ Block title: ..

Comment

- Netwark 1:

Comment

ALARM_D
—EN
#5316 — 516
#16HEEEE — ID
HEV_ID — EV_ID
#CWP_ID — CMP_ID RET_VAL — #RET_VAL
#5D — 5D EHNO =

w HIG
EV_ID
#CMP_ID

#RET WAL

Note

In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.

7. The configuration of the ALARM_D message in the function block is now complete.
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Creating an instance data block

No. Action Screens
8. Open an organization block (e.g. OB1) in your project.
9. Call the FB in your application program, for example in the OB1.
Then a dialog for creating the instance data block opens up.
™ Block titleran fresram weep (G '
Data block
> E3Network 1:  ALARM_D [ [ALARM_D_DE [=]
Cormment Mumber [ TZ]
. () Manual
T (@) Automatic
"ALARIM_D" The called function block saves its data in its own instance
T el data block.
- 516G FET_VAL
EV_ID
CMP_ID Mare..
e tags used
10. Click on “OK?” to confirm.
Now, all the required parameters are automatically connected and a message number is cre-
ated. The message number is entered at the input “EV_ID” automatically.
w Block title:  "Main Frogram Sweep (Cyele)”
Carmment
- Network 1:  ALARM_D
Comment
%DE1
"ALARM_D_DE"
WFB1
"ALARM_D"
EN ENG
faloe = 351G RET_VAL
| CMP_ID
11. The instance data block is now created and is called by the organization block.

Configuring the message text of the ALARM_D message

No.

Action Screens

12.

In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Project tree

Devices
40O

Y oevie
%/ onlin
b [ Prog
» r:ﬂT?‘:hl 5
b @ External source files

lex
¥ 53 HMI_1 [TP900 Comfart]
v [§§ common data
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No.

Action Screens

13.

Select the ALARM_D message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.

PLC alarms

Marne Type ] Range Location Meldetext Infotext Alarm class

1 5 ALARM_D Alanm_s 1 ALARM_ D g

£ = oo da

<|m »

|3 Properties H‘_i..lnfo HL Diagnostics

General

General

Texts

Attributes

MName Text
1 | Infotext &
2 Alarmtext I
3 | Additional tst 1 &

e Under “Alarm texts” please enter the message text for the ALARM_D.

e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.

14.

In the inspector window, please open the tab “Properties > Properties > Attributes”.

iy Info ||L[l|aqnost|r.s |

‘Q Properties H

General

General

Attributes

Texts

Artributes

[ report

Display class |0
[ with acknowledgment [

Friarity | 0

Alarm class | <no class:

RN ELN K

Group D 0

e Under “Alarm class”, please select “System_Acknowledgement”.
In Chapter 3.4 you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM_D.”

e  Under “Priority”, choose a priority for the display of the ALARM_D.” The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM_D. Alarms that belong
to the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledge-
ment is possible. If you use alarm blocks without the possibility of an acknowledgement, this
option has not function.

15.

Right-click on the CPU in the project navigation.
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No. Action Screens
16. Select “Compile > Software (rebuild all blocks)” in the context menu.
Devices
HOO ZF |28
PLC al
MNarne
T
Open
Cpenin nev editor _m
;C cut ctrl+ —
55| Copy crrleC
gl Faste Crl+y Jm
¥ Delete Del - ]
Renarne F2 el
Texts

Attribut

cerl+l

el Software (rebuild all blocks)

e Online & diagnostics Ctrl+

.v
GE~---

how force valuss

17. Transfer the configuration into the PLC.

The configuration of the ALARM_D is now complete.

Display of the Alarm_D on the control panel in Runtime

If you want to display the Alarm_D, an alarm display must have been configured in

your project. In this alarm display, the alarm class “System_Acknowledgement”

must be activated for the ALARM_D.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Basic / Comfort / Advanced under system manual, under the

title “Configure alarm display”.
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3.34

Configuration of ALARM_DQ messages

An ALARM_DQ is a PLC alarm that generates a message after a signal change
(rising edge) and sends it to all the participants in the message procedure.

An associated value can be configured to an ALARM_DQ which will be displayed
in addition to the message text.

All the alarms that are sent via the ALARM_DQ message block imply an acknowl-
edgement. The alarm can be acknowledged on the control panel.

Parameters of the ALARM_DQ message block
The following table shows all the parameters of the ALARM_DQ message block.

Table 3-25
Para- Declaration Data type Memory area Description
meters
SIG Input BOOL E,AMD,L The signal that triggers an
alarm.
ID Input WORD E,A M, D,Lor Data channel for the mes-
constant sages: W#16#EEEE
EV_ID Input C_Alarm_S E,A MD,Lor Message number of the
constant alarm (no “0” allowed)
CMP_ID Input DWORD E,A M, D,Lor ID for the subsystem to which
constant the message is assigned (not
allowed: 0)
Recommended values:
e Jow word: 1to 65535
e high word: 0
SD Input BOOL (not allowed: | E,A,M,D, T, Z Associated value
Bitfield), BYTE, max. length 12 bytes
CHAR, WORD,
INT, DWORD,
DINT, REAL,
DATE, TOD, TIME,
S5TIME,
DATE_AND_TIME
RET_VAL Output INT E,AMD,L Error code output.

Configuration in STEP 7 Professional

For the configuration of an ALARM_DQ message STEP 7 Professional, proceed as

follows:
Creating a function block
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Table 3-26

No.

Action Screens

In the project navigation under the folder of the CPU you created, open the “Project blocks”.

Project tree

Devices
Q@

i D=
= [ PLC_1[CPU 317-2 PI/DF]

iguration

¢ & diagnostics
= g Pragram blocks

4 II0_FLT1 [0B32]

48 /0_FLT2 [0BE3]

4 RACK_FLT[OBS6]
4 OBNL_FLT [0BS5]
4 Wain [CB1]

& Elock_1 [FE1]

» [ Techn
v [} Extemal
» (@ FLCtags

LA PLC alarms

E] Text lists

Open a function block with a double click in which you would like to configure the ALARM_DQ
message or create a new function block and open it.

Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.

~ | Extended instructions

Name Description

» [7] String + Char ]

» [ FrofiEnergy

» [ ] Module parameter.

Generate alarm message

Generatz alarm

Determing the

Write a user diag

Read

b |TE(|‘II|0|0(Jy

> |C0mmunicatiun

Drag & drop the message block “ALARM_DQ” into an empty network of your FB.

¥ Block title: .

Comment

a )

Cormment

ALARM_DO
— EN
- —lslg
[
EV_ID
CHF_ID RET_VAL
50 ENO —

Mo tags used
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No. Action Screens
5. In the block interface of the function block, declare the static variables the parameters of the
message block.
Please find the required parameters in the chapter “Parameters of the ALARM_DQ mes-
sage block®.
Wi S S A me (g €y '='= T
Interface
Narne Data type Offset Default value Wisible in ..
1 <@ = Input
2 @@= 516 false =]
3 a@e B Y 20 =]
4 qqe CMP_ID Cwerd 60 E
5 40 v Output
& @@= RETVAL Int =)
7 4 = InOut
8 = Add new
9 40 - Static
olas 30 Ward E| 20 0 =]
11 4@ « Temp
12 = Add new
Note on the input “ID”
The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without using
an additional variable.
If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.
6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.
w Block title: ..
- Network 1:
ALARM_DG
;”;IG: ::é
#16HEEEE [[x]
aii}{luz E:@‘jn RET_VAL — #RET_WAL
#50D ) ENOD =
w 56
v
SRET_VAL
Note
In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.
7. The configuration of the ALARM_DQ message in the function block is now complete.
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Creating an instance data block

No. Action Screens
8 Open an organization block (e.g. OB1) in your project.
9 Call the FB in your application program, for example in the OB1.
Then a dialog for creating the instance data block opens up.
w Block title:  "Main Frogram Sweep (Cycle)" - v
F— I ]
[ata block
w {3Network 1:  ALARM_DO Harne | sLaRKI_DO_DE [~
Comment wamber [ [Z]
Single () Manual
? Instance —
TFET (® Autornatic
"ALARN_DO" The callzd function block saves its data in its own instance
i Enob—| data black
—{5lG RET_VAL
Ev_ID
CMP_ID Mare...
a0

Mo tags used

10. Click on “OK” to confirm.

ated. The message number is entered at the input “EV_ID” automatically.

w Block title:  "Wain Program Sweep (Cyle)"

Cornrment

- Network 1:  ALARM_DOQ

Now, all the required parameters are automatically connected and a message number is cre-

Camment
%DE1
"LLARK_DG_DE"
WFE1
"ALARN_DQ"
EH ENG
falze — 516G FET_VAL
DWRT6H
0 EV_ID
1 CWP_ID
50
11. The instance data block is now created and is called by the organization block.

Configuring the message text of the ALARM_DQ message

No. Action Screens

Project tree

Devices
40O

» (g FLC dlata
» [ Watch ar

lex
¥ 53 HMI_1 [TP900 Comfart]
v [§§ common data

12. In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Messages in WinCC (TIA Portal)
V1.0, Entry ID: 62121503

65




Copyright © Siemens AG 2012 All rights reserved

3 Configuration of messages in WinCC Basic / Comfort / Advanced

No. Action Screens
13. Select the ALARM_DQ message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.
PLC alarms
Mame Type D Range Location Meldetext Infotext Alarm class
1 [ ALARW_DQ  Alarm_s 1 ALARM_DQ_ g I &7 -nocla
4| m ¥
‘g Properties ||:i..lnfo Hi Diagnostics
General
-:;:I g Texts
Attributes
1 I\\\l;-;";xt — P
2 Alarm text &3
3 Additional text 1 e
e Under “Alarm texts” please enter the message text for the ALARM_S.
e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.
14. In the inspector window, please open the tab “Properties > Properties > Attributes”.
|3Pm|)elties H'Li..lnfo H& Diagnostics |
J General ‘
?::ml Attributes
B )
Display class | © - Report E
I Frierity | 0 = [ with acknowledgment ¥
Alarm class | <no class -
Group 1D | -
e Under “Alarm class”, please select “System_Acknowledgement”.
In Chapter 3.4 you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM_DQ.”

e  Under “Priority”, choose a priority for the display of the ALARM_DQ.” The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM_DQ. Alarms that belong
to the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledgement

is possible. If you use alarm blocks without the possibility of an acknowledgement, this option

has not function.
15. Right-click on the CPU in the project navigation.
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No. Action Screens
16. Select “Compile > Software (rebuild all blocks)” in the context menu.
Devices
oy, 2|28
PLC al
Marne
e
Open
: i
Curl+ —
cerleC
Crl+y
Gener:
X Delete Dl _—
Fename F2 Tets
Go to device Attribut
Goto librar
»
» o n
4 Curleke Software
ar Ctleld
* | % online & diagnastics ctrl+D
» [ [ Fecaive slamms
Ry farce values
17. Transfer the configuration into the PLC.

The configuration of the ALARM_DQ is now complete.

Display of the Alarm_DQ on the control panel in Runtime

3.3.5

If you want to display the Alarm_DQ, an alarm display must have been configured
in your project. In this alarm display, the alarm class “System_Acknowledgement”

must be activated for the ALARM_DAQ.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Basic / Comfort / Advanced under system manual, under the

title “Configure alarm display”.

Configuration of Simotion alarms

The configuration of Simotion alarms will be available with a later version of WinCC

(TIA portal).
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3.4 Using alarm classes

During the operation of the system, alarms of various priorities occur. These mes-
sages are categorized in different alarm classes depending on their importance.

The system operator can see which messages have a higher priority and impor-
tance and must be handled first.

Function of the alarm classes

When new messages are created, every message must be assigned to an alarm
class.

The alarm class defines the following aspects of the message assigned to this
alarm class:

o the display
o the acknowledgement concept
o the storage

Note The scope of functions of the alarm classes depends on the configured control
panel used.

Types of messages classes
WinCC (TIA Portal) provides the following types of alarm classes.
e Pre-defined alarm classes

You will find pre-defined alarm classes on the tab “Alarm classes” under “HMI
alarms” in the project tree. The alarm classes cannot be deleted and can only be
edited in part.

e User-defined alarm classes

For every control panel, you can add more alarm classes on the tab “Alarm
classes” under “HMI alarms” in the project tree. In these alarm classes the display
and the acknowledgement concept of the respective message can be configured
individually.
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3.5

Using alarm groups

During system operation, messages concerning different processes and sections
occur. In order to organize these message to get a better overview (for example
depending on the sector of the system), you can classify these messages in alarm
groups.

Function scope of alarm groups in WinCC Basic / Comfort / Advanced

Usage

In WinCC Basic / Comfort / Advanced you can monitor certain sectors of the sys-
tem separately by means of alarm groups and you can acknowledge the respective
alarms together, if required. Only alarms that need to be acknowledged can be
grouped in alarm groups, irrespective of the alarm class used.

Example

If several alarms requiring an acknowledgement are assigned to an alarm group,
and if you acknowledge one of these alarms, all the alarms in this alarm group are
acknowledged at the same time.

We recommend using alarms groups for the following messages:

e error alarms with the same cause.

e similar messages.

e alarms from one sector of the plant (e.g. Press_1).

¢ messages that are part of a process (e.g. temperature monitoring)
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3.6 The acknowledgement concept in WinCC Basic / Com-
pact / Advanced

Define the acknowledgement concept for an alarm class. All the messages that are
part of this alarm class will then be acknowledged according to the same concept.

In WinCC Basic / Compact / advanced, there are the following acknowledgement
concepts:

e Message with acknowledgement
o Message with a single acknowledgement

In the following chapter, the acknowledgement concepts are explained in greater
detail.

3.6.1 Message with acknowledgement

After a message without acknowledgement, the operator does not necessarily have
to react to the message. The message comes and goes without an acknowledge-
ment being necessary.

3.6.2 Message with a single acknowledgement

During the operation of the system, messages can occur that the operator obvi-
ously must take notice of. If an acknowledgement has been configured this means
that the message will remain pending until the operator has acknowledged it.

Note Alarms concerning critical and dangerous states in a process must always be
configured as needing acknowledgement.

General definition

If a message needing acknowledgement is acknowledged by an operator, the op-
erator confirms that he has treated or removed the event that caused the alarm.

If required, the acknowledgement can be recorded and saved.

Note It depends on the control panel in how far the message can be recorded and
saved.

Possibilities of an acknowledgement
There are the following possibilities of acknowledging a message in runtime:
¢ manual acknowledgement by an authorized operator at the control panel

e automatic acknowledgement by the system without any action from the opera-
tor by:

- variables

- PLC

- system functions in function lists
- system functions in scripts
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Acknowledgement by the operator at the control panel

Note

The message is triggered by an event.

The message is displayed in a message
display / in a message window with the
status “Come”.

The operator registers this message as requiring an acknowl-
edgement and acknowledges the message.

The status of the message changes
to “Come + “acknowledged”.

The operator removes the cause that caused the event.

The status of the message changes
to “Gone + acknowledged”.

Depending on the configuration, the operator can acknowledge a message in the
following way in runtime:

e by means of the “acknowledgement” button in the message

Note The button has to be activated before: under Properties of the
Message displays -> Toolbar -> Buttons.

e by means of the function keys and configured buttons with a configured func-
tion “MessageDisplayAcknowledgeMessage” in images.

e by means of the <ACK> button on a control panel with a keyboard.
Critical alarms should only be acknowledged by authorized operators. Therefore

you should add the respective authorization to all the operating and display ob-
jects for the acknowledgement of alarms.

Acknowledgement by the PLC

In addition to the acknowledgement of messages on the control panel, they can
also be acknowledged by the control program. Then the message is acknowl-
edged by means of the PLC acknowledgement variable, which can be configured
for every message requiring an acknowledgement. In the chapter “Configuration of
discrete alarms”, you will find more detailed information about alarm classes.
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Acknowledgement of several messages at one time

If you want to acknowledge several alarms at one time, these alarms must be as-
signed to the same alarm group. This means that if one alarm from this alarm
group is acknowledged, all the other alarms from this alarm group will also be ac-
knowledged. Therefore it is no longer necessary to acknowledge each alarm sepa-
rately.

In the chapter “Using alarm groups”, you will find more detailed information about
alarm groups.
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3.7

3.71

Associated values in messages

Associated values are process values / text list entries that are displayed as addi-
tional information with the message text.

The number of associated values that can be configured depends on the message
block used.

Structure of an associated value

Associated values are integrated into the message as a block.

The block consists of the number, the element type and the format instruction of
the associated value.

@<No. of the AssociatedValue><ElementType><Format>@.

Number of the associated value

For message blocks with only one possible associated value, the number “1” is
used for the associated value.

For message blocks with several possible associated values, the respective num-
ber where an associated value is configured is used e.g. Input SD_" = associated
value “2”.

Element type

The element type defines the data type of the associated value.

Table 3-27
Element type Data type
Y BYTE
w WORD
X DWORD
I INT
D DINT
B BOOL
C CHAR
R REAL
Format
With the format you define the output format fin the control panel or the associated
value. The character “%” precedes the format instruction.
The following fixed format instructions are applicable for message texts:
Table 3-28
Format Description
Yolilx Hexadecimal number with “” digits
Yolilu Unsigned decimal number with “i” digits
%lild Signed decimal number with “i” digits
%lilb binary number with “i” digits
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Format Description

%lill-yIf

Fixed point number

Signed value of the form dddd: one or several

numbers with “y” digits after the decimal point and

“n

i” total digits

%li]s

wy

Character string (ANSI string) with “i” digits

Characters are printed up to the first O byte
(OOHex).

%t#<Name of the text library> Access to text library.

3.7.2

Configuration of an associated value

In the following the configuration of an associated value in a message text will be
explained.

Displaying the associated value in a message

The further procedure requires a PLC alarm that has already been configured (e.g.
an ALARM_S message)

Table 3-29

No.

Action

In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Project tree

Devices
40O

~ [ FLC_1 [CPU 317-2 FR/DF]
Y oevie

%/ onlin

b [ Program

» :ﬁT?ChI

» @ External

v [d FLC tags

LC data types

Ul Lac adules
¥ 53 HMI_1 [TP900 Comfart]
v [§§ common data

In the tab “PLC alarms”, select the message, in which the associated value is to be integrated.

In the inspector window, please open the tab “Properties > Properties > Texts”.

=) B
= w

PLC alarms
Mame Type D Range Location Weldstext Infotext Alarm class
1 [ Alarm_s Alarm_s 1 Alarm_5_FB g I &7 -nocla
<[ m )
‘Q,Propelties ||1i..lnfo Hi[llaqnostl(s
General
General
Texts
Texts
Attributes
Hame Text
1 | Infotext &
2 Alarmn test &

3 Additional text 1 &'
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No. Action
4. Under “Alarm text”, please add the block of the associated value in the alarm text, for example
Pump failed @ 1W%6d@.
Note
If you change the alarm text in the tab “Alarm instances” for the message, you might have to
reset the instance value to the type value. Click on the type symbol displayed next to the alarm
text to do so.
|£,P|o|)e|ties ”"_i..lnfo ||L Diagnostics ‘
General
Attnibutes
1 T:waf?teext - el
2 Alarm test @1Whed® [
5 Addmonal e
4 | Additional text 2 el
5 Additional text 3 P
& | Additional text4 e
5. The configuration of the associated value is now complete.

Displaying the text list entry in a message

When text list entries are put out in PLC alarms, the associated value automatically
references the index in the text list. Depending on the value of the associated value
the respective text list entry will be displayed.

A textlist is put out by the following block format of an associated value:

e  @<No. of the AssociatedValue><ElementType><Format><Name of the Text
Libaray>@.
Example for a block which puts out the content of a text list:

o @1W%t#TextList@ - associated value 1 of the data type WORD is the index,
with which the text to be integrated is references in the text library TextList.

The further procedure requires a PLC alarm (e.g. an ALARM_S message) and a
text list in STEP 7 that have already been configured.
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Table 3-30
No. Action
1. In the project navigation under the folder of the CPU you created, open the “PLC alarms”.
Devices
50O
» @ External
v Lg FLC
» (g FLC data types
¥ (G2 Watch ar
les
¥ 53 HMI_1 [TP900 Comfart]
v [§§ common data
2. In the tab “PLC alarms”, select the message, in which the text list entry is to be integrated.
3 In the inspector window, please open the tab “Properties > Properties > Texts”.
PLC alarms
Mame Type D Range Location Meldetext Infotext Alarm class
1 [ Alarm_s Alarm_s 1 Alarm_5_FB g I &7 -nocla
L T ?
Ld. Properties ||1i.'.lnfo Hﬂ Diagnostics
General
Gene Texts
Attributes
Mame Text
1 Infotext P
2 | Alarm text &
3 Additional text 1 e
4. Under ,Alarm text‘, please add the block of the associated value in the alarm text, for example
Pump in system sector @ 1W %t#TextList@ failed.
|QP|0|)e|tie-; ”"_i.‘.lnfo ||ﬂ Diagnostics ‘
General
General 7 n
Texts
Attributes
Name Text
1| Infatest <)
[ T Harm tex 1A TextListe =l
| 5 Additional text 1 B
l 4 | Additional text 2 el
| 5 Additional text 3 el
F g | Additional text 4 Pl
Note
If you change the alarm text in the tab “Alarm instances” for the message, you might have to
reset the instance value to the type value. Click on the type symbol displayed next to the alarm
text to do so.
5. The configuration of the associated value is now complete.
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4,

411

1

Configuration of messages in WinCC Pro-
fessional

In the following, the configuration of user-defined and system-defined messages
with WinCC Runtime Professional will be explained.

Required software components
e  WinCC Professional

e STEP 7 Professional
Requirements

¢ A WinCC Runtime Professional project with configured connections to a S7-
300/400 PLC has been created.

The required knowledge and the procedure for the configuration of a connection
between a control panel in WinCC (TIA Portal) and an S7-300/400 PLC in STEP 7
Professional are not a part of this Application.

Configuration of user-defined messages

Configuration of analog alarms

General configuration of analog alarms

Table 4-1

For the configuration of analog alarms in WinCC Professional, please proceed as
follows:

No.

Action

1.

In the project navigation under the folder of the control panel you created open the “HMI
alarms”

Project tree
Devices

i Devices & networks
» [l PLC_1 [CPU 418-3 PN/DF]
= [0 PC-Sy [SIMATIC FC station]
i [y pevic
P % online & ics
- - i:] HMI_FT_1 [WinCC RT Professional]

i
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Open the tab “Analog alarms”.

ProfessionalRT_57_400 » Professional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professiong

|_n.‘ Discrete alarms |H: Analog alarms ‘h] Controller alarms ”_!: User alarms HE System events
=
Analog alarms
1] Meldetext Alarm class Trigger tag Acknowledg.. Ackno.  Single.

In the table, double-click on “<Add new>" to create an analog alarm.

Select the analog alarm you just created and in the inspector window open the tab “Properties >
Properties > General".

|gPlopelties ”‘_i.'.lnfo Hﬂ[}laqnostlcs |

Properties Events
General

.
Settings

Trigger

L TR

Alarm class ]
Alarrn graup: | Mo alarmn group: !
Mame: | 2nalog_alarm_1

Status

Alarm annunsiator

Display suppr

Frisrity

e Under “ID”, please select an alarm number for the identification of this alarm.

e Under “Alarm class”, please select an alarm class for the analog alarm.
In Chapter 4.4 you will find more detailed information about alarm classes.

e If required, please choose an alarm group under “Alarm group” to which the analog alarm
will be assigned.
In Chapter 4.5 you will find more detailed information about alarm groups.

e Under “Priority”, choose a priority for the display of the alarm.
The priority influences the display of the message in an alarm display. Alarms with a high
priority come before alarms with a low priority.

Note

If you assign different priorities, the analog alarms will be sorted according to the priority and
not the date.

In the inspector window, please open the tab “Properties > Properties > Trigger”.

‘gPlopelties ”"j.‘.lnfo ||ﬂD|agnost|cs |

JPmpelties ” Events ‘

Trigaer

General

- Settings

Tag: |-latag: B
Delar iecon 7]

wledgment

Status

Alarm annunciator

Display supprassion

e Under “tag”, please create a new tag or choose an existing tag for triggering the analog
alarm.

e Under “delay” you can set the time basis after which the analog alarm is to be triggered
when the limit value was violated.

Note
Only use the tag for triggering the alarm for triggering this alarm.
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In the inspector window, please open the tab “Properties > Properties > Alarm texts”.

|gPlupelties ||:i.‘.|nfo Hﬂblaqnostl(s ‘

JPIUpEItiES || Events |

Alarm texts

General .
Settings

Trigger
Taaltp Additional text 1 |

Acknowledgment
Status

Additional text 2 |

Elarrm annunciator

Display suppress... Additional text 4 |

|
|
|
Additional text 3 | ]
|
|

Additional text 5 |

e Under “Alarm text” please enter the message text in the analog alarm, for example “Analog
Alarm 17

e  Optionally, you can enter more texts for the analog alarm under “Additional text”.
The additional texts can be displayed in a separate column in an alarm.

Note

Message texts depend on the language, and depending on your configuration, they can contain
up to 255 characters.

Assigning the limit value

Open the tab “Analog alarms” again.

..sofessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMIalarms — il i X

C4 Discrete alarms |IC] Analog alarms Controller alarms ”;!J User alarms ‘ |
=

Analog alarms

o] Meldetext Alarm class Trigger tag Acknowledg... | Ackno. |Single ach
CA 1 <! £nalag alarm 1 Errors 1o tag) 1o tag

<Add new:
<] ] B

Select the analog alarm which you have already created under number 2 of the table.

In the lower sector of the window, click on “Add new”> under “Limits for analog alarms” to add a
new limit for the analog alarm.

...sofessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMI alarms — il i X

"_n! Discrete alarms "14' Analog alarms ”—ll Controller alarms ||'_!_‘ User alarms ‘ 4(r
Ed -y =

Analog alarms

D Meldetext Alarm class  |Triggertag | Acknowledg . |Ackno. |single act
=5 % Analog alarm 1 Errars o] <Me tag | “llo tag

<Add news
[<] [ B

e

Limits for analog alarm for ID1

Lirnit Limit mode | Deadband m . Deadbandva  |Deadbandin . Display suppr

Select the limit you just created and in the inspector window open the tab “Properties > General
> Trigger”.

|§.Plupelties H‘_i.'.lnfo ||ﬂ[)|aqnostlcs |

General

Trigger
General
e Limit Deadband
Made: | High limit violation [+] Mode
value: | i T —
D Display suppression In percent
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Open the drop-down list under “Limit > Value”

9.
Trigger
Limit Deadband
Made: | High limit violation [~] Mods
Valuz: | gl Value: |0
[ pisplay suppression ok CoONSTANT in percent
<1 HWI_Tag
e If you want to use a constant as the limit value, select “Constant” and then enter the
constant in the “Value” box.
e If you want to use a tag as the limit value, select “HMI_Tag”. Then select the tag or set a
new tag.
10. Open the drop-down list under “Mode” and select a trigger mode.
Trigger
Limit Deadband
[[uzde] | High limit violation [=] ade:
fale 0
Low limit violation In percent
Mot equalto limit
o “Equal to limit”: When the value is equal to the limit value, the alarm is triggered.
o “Not equal to limit”: When the value is not equal to the limit value, the alarm is triggered.
o “High limit violation”: When the value exceeds the limit value, the alarm is triggered.
e “Low limit violation”: When the value falls below the limit value, the alarm is triggered.
11. The configuration of the analog alarm is now complete.

The analog alarm will now be triggered by the trigger tag depending on the limit you set.

Display of the analog alarm in runtime

If you want to display the analog alarm, an alarm display must have been config-
ured in your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure
alarm display”.
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Optional settings for analog alarms

Activating the deadband

The deadband prevents that an analog alarm is triggered several times of a proc-
ess value fluctuates around the limit value.

Table 4-2

No.

Action

created.

1. In the tab “Analog alarms”, select the analog alarm and then, in the lower window, the limit you

...57_400 » Professional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] * HMI alarms — il il X

Analog alarms
D Alarmn text Alarrn class
=N = Analog alarm 1 Errors

<Add new:

A Analog alarms ”_u Controller alarms ||_!: User alarms ”E System events ||1, Alarm classes ‘ 4|r
)
=1

Trigger tag Acknowledg... Ackno. Single ackno.. Alarm am
i test w| <Mo tag:

[ <] i

Limits for analog alarm for ID1

Lirnit Limit rode Deadband m... Deadband va.. Deadbandin .. Display suppr...

L A Tag 1[I J<m-] High limic _ [=] off [=o

=]

<Add new:

2. In the inspector window, please open the tab “Properties > Properties > Trigger”.

|gPlu|)elties H"_i.'.lnfo Hﬂ[}laqnostlcs |

General

Trigger

General

- Limit

Deadband

Meds: | High limit viclation

& N ——

Value
[] Display suppressian

4

el [l

in pereent

3 In the drop-down list under “Deadband
band is to be applied.

Trigger

> Mode” set for which change of alarm status the dead-

Made: | High limit vislation [+]

Value: [HMI_Tag_1

[ Dizplay supprassion

Limit Deadband

In case of violation
Onexceeding
onfalling below

Valus

the value is to be applied in percent of

Trigger

4. Under “Value”, please enter a constant that is to be applied or activate the option “in percent” if

the limit value.

Made: | High limit vislation [+]

Value: [HMI_Tag_1

[ Dizplay supprassion

Limit Deadband

Wade |On excesding

[]

i percent

5. The configuration of the deadband for the analog alarm is now complete.
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Creating a tooltip

With a tooltip you can provide the system operator with further information and in-
structions in addition to the alarm text.

Table 4-3
No. Action
1. Open the analog alarms in the tab “Analog alarms”.
2. In the inspector window, please open the tab “Properties > Properties > Tooltip”.
|§.Pl0pelties ||‘_i.'.lnfo ||ﬂ Diagnostics |
Properties Events
Toaltip
T
Alarm texts | A
.:\t:It\ll‘:aHHUIT-ZM(C-\ E
Display suppress |}

e Under “Text”, please enter the text which is to appear as a tooltip to this analog alarm. By
means of the respective button in the message display, you can call the tooltip to this mes-
sage.

Note

The tooltip must not be longer than max. 320 characters.

3. The configuration of the tooltip for the analog alarm is now complete.

Evaluating the acknowledgement of the analog alarm in the PLC

Table 4-4

The acknowledgement of the analog alarm can be polled by a tag in the PLC.

No.

Action

Open the analog alarms in the tab “Analog alarms”.
...00 » PC-System_1 [SIMATIC PC station] » HMI_RT_1 [WinCC RT Professional] »* HMIalarms — W' B X

4 Analog alarms H_u Controller alarms ”_!: User alarms ||E System events ‘ 4| r

By =
Analog alarms
D Alarrm text Alarm class Trigger tag Acknowledg... |Ackno. Single ackno.. Alarm annur
= [%] analog alarm 1 Errars [l HMTag 1 [ <Hotag- [0 J J
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In the inspector window, please open the tab “Properties > Properties > Acknowledgement”.

|QP|D|)e|ties ||"_i.‘.|nfo ||ﬂ Diagnostics |

Properties Events

Acknowledgrment

HMI

] Tag: |-l tag ‘i_l
Toy

Acknovdedgment |

[ Single acknowledgment

Status N

Alarm annunaiator |

Display suppress... [

e Under “HMI > Tag”, please choose an existing tag or create a new tag, where the informa-
tion can be stored that the discrete alarm has been acknowledged.

e Under “HMI > Bit”, please select the bit that will be set in the selected tag if a discrete alarm
has been acknowledged.

e If required, activate the option box “Singe acknowledgement”

Note

The control panel and the PLC have only read access to the storage area of the acknowledge-
ment tag.

The configuration of the acknowledgement poll is now complete.

You will find more detailed information concerning the acknowledgement concept
in WinCC Professional in Chapter 4.6.

Query the status

Table 4-5

Under “Status” the status of an alarm can be saved in a status tag.

No.

Action

Open the analog alarms in the tab “Analog alarms”.

...fessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMI alarms — & i X

|_,L.‘ Discrete alarms H11 Analog alarms ”—ﬂ Controller alarms H_!: User alarms | ’4_|_D|
= =
Analog alarms
D Alarm text Alarm class | Trigger tag Acknowledg..  Ackno. Single a
= [] Analog alarm 1 Errors [l test [l atotag- [0 C

<Add new:

2. In the inspector window, please open the tab “Properties > Properties > Status”.
‘gPlopelties ”‘_i.'.lnfo uﬂ Diagnostics ‘
Properties Events
Status

o

Alarm texts Tag [<Hotag &=

Eit

Earrn annunciator

Display suppress.. ||

e Under “Tag’, select a tag and the respective bit, or create a new tag where the status of the
alarm/alarm group is to be saved.

3 The configuration of the status tag for analog alarms is now complete.
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Alarm annunciator

By activating the “Alarm annunciator” an alarm can be annunciated by optical or
acoustic signals in addition to the alarm display.

Table 4-6
No. Action
1 Open the analog alarms in the tab “Analog alarms”.
...fessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMI alarms — &l il X
|_,L.‘ Discrete alarms H11 Analog alarms ”—ﬂ Controller alarms H_!: User alarms | 4(»
e =
Analog alarms
D Alarm text Alarm class Trigger tag Acknowledg.. Ackno. Single a
= [] Analog alarm 1 Errors [l test [l atotag- [0 C
<hdd new
2 In the inspector window, please open the tab “Properties > Properties > Alarm annunciator”.
‘gPlupelties ||‘_i.‘.|nfo uﬂ Diagnostics ‘
Properties Events
Alarm annunciator
Al s [ ] #larm annunciatar ’
ledgrment Ll
Status :
:
Display suppression ||
3 Under “Alarm annunciator”, activate the option box “Alarm annunciator”
Alarm annunciatar
Settings
T iy
4 The configuration of the alarm annunciator for the analog alarm is now complete.

You will find more detailed information on the Alarm annunciator in Chapter 4.6.4.

Suppressing the display

By activating the Display suppression, it is possible to suppress alarms depending

on the states of the system.

Table 4-7
No. Action
1. Open the analog alarms in the tab “Analog alarms”.
Note
If you want to use the display suppression, the respective alarm must be assigned to an alarm
group.
...fessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMI alarms — &l il X
|_,L.‘ Discrete alarms H11 Analog alarms ”—ﬂ Controller alarms H_!: User alarms | 4(»
e =
Analog alarms
D Alarm text Alarm class | Trigger tag Acknowledg.. Ackno. Single a
= [] Analog alarm 1 Errors [l test [l atotag- [0 C
<Add new:
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2. In the inspector window, please open the tab “Properties > Properties > Display suppression”.
‘gPlopelties ||:i.‘.|nfo uﬂ Diagnostics ‘
J Properties || Events |
Display suppression
_\;T‘::‘a‘ Settings
Alarm tits Mask
.lern’annun-:\a(m i
!
3 Under “Mask’, please select a status from the drop-down list for which you want to suppress the
display.
Dizplay suppression
Settings
Wask || ECREEEEEEN -]
4. The configuration of the display suppression for the analog alarm is now complete.

Output of a dynamic parameter in the alarm text

When an analog alarm comes, it is possible to display alarm parameters within the
alarm text in an output box.

Table 4-8
No. Action
1 Open the analog alarms in the tab “Analog alarms”.
...fessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMI alarms — i il X
|_n.' Discrete alarms Hﬂ Analog alarms h Controller alarms H_!: User alarms ‘ 4|r
B E
Analog alarms
D Alarrm text Alarm class Trigger tag Acknowledg.. |Ackno. Single a
= [2] analog alarm 1 Errars el test L totag- [0 ]
<Add news
2 In the inspector window, please open the tab “Properties > Properties > Alarm text”.

|g Properties ""j.llnfn Hﬂ Diagnostics |

J Properties || Events ‘
Alarmn texts
General Settings
Alarmtest |
Toolip Additional text 1 |

Ack

Status

lgrnent -
a Addlitional text 2 [

Alarm annunciato

Display suppr Additional text 4 |

\
\
\
Additional text 3 | |
\
\

Adelitional et 5 |

e Click the right mouse button in the entry box “Alarm text” or place the cursor in the alarm
text and click on the right mouse button.

Then the context menu will open up.
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No. Action
3 Select “Insert parameter field” or “Insert system parameter” from the context menu.
|§. Properties ”:illnfo ||ﬂ Diagnostics |
J Properties || Events ‘
Alarm texts
E:::I Settings

Elarm texts Alarm test | Analog alarm 1|
o sddtionaltett ||
sddtionaltetz ||
Addtionaltets ||

Alarm annunci

Display suppressio

Additional text 4 =

Additional text 5

ameter fisld

SYSTEIT parametar..

Additianal text &
Additional text 7

sdditional text @ ,7 Aa hange to capital letters

Clear formatting

I

continue with the section on the chosen tag.

Then a dialog for the further configuration of the dynamic parameter (tag) opens up. Please

Parameter field (limit, deadband, current value)

No. Action
4 Inserting a parameter field
Open the drop-down list under “Parameters” and select a parameter.
Farameters:| | Limit .
Deadband
Format Current value
e
ength [113]
ED Decimal places:
[ Properties | Events | Algnment: [fght  [+]
Leading zeros: [ i
Alarm texts
_fl:::l Settings
Alarm texts Alarmtext [Analag alarm 1 <Tag 1, #unresclveds- |
Additional text 1 | |
Additional et 2 | ]
e Limit
e Deadband
e  Current value
5 Select a display type under “Format > Display type” for the parameter you selected.
Parameters: [Lmt [~
Format
| Display type |De‘:|ma\ F‘l
Length: |1 :
B Decirnal places
J Properties || Events Agnment [fghe |+
Leading zeras. [~ [
Alarm texts
Settings
Alarm text | Analog alarm 1 <Tag: 1, #unresclveds: |
Additional text 1| |
Additional text 2 | ]

Messages in WinCC (TIA Portal)
V1.0, Entry ID: 62121503

86



Copyright © Siemens AG 2012 All rights reserved

4 Configuration of messages in WinCC Professional

Display type

Decirnal e

Note

played.

No. Action
6. Under “Format > Length”, please select the number of characters for the display of the parame-
ter.
Parameters ﬂ
Format

| Length. |1 = |
B Decimal places: [0 z
; :
J Properties || Events Ahgnment. | Right [~
Leading zeros. [~
Alarr texts
General N
Settings
Trigger
Alarm texts Alarm text | Analog alarm 1 <Tag: 1, #unresclveds:

Additional text 1|

Additional text 2 |

4]
|

Choose the length in such a way that all the required characters of the parameters can be dis-

7. Under "Format > Decimal places”, select the number of decimal places for the parameter.

Parameters

Lirnit

1]

Alarm texts

owlzdgrent

Format
Display type: | Decimal
Length
B |Demma|p\aces 0 =] | I
J Properties || Events ettt 4EM—‘I“
Leading zeras. [~ [
Alarm texts
General .
:n(me\ Setings
Alarm texts Alarm text | Analog alarm 1 <Tag: 1, #unresclveds: |
P Addlitional text 1| ]
2 QR lEEE R Additional text 2 | ]
8 Under “Format > Alignment”, set the alignment of the output box.
Format
oy e
Lenath
ER Decimal places: [0 z I
J Properties || Events | Alignmene [ iohe [
Leading zeros. [~ [
Alarr texts
General .
:H(I(I?\ Settlngs
g Alarm text | Analog alarm 1 <Tag: 1, #unresclveds: |
P Additional text 1| |
2 el Additional text 2 | ]
9 Optionally, you can activate "Format > Leading zeros”.
Parsmesers: [Lne [+
Format
biplayope [Deomal 7]
Lenath
B Decimal places I
J Properties || Events Ahgnmene [pohe ||
I
Alarr texts
;’.T‘:;‘\a‘ Settings
i Alarm text | Analog alarm 1 <Tag: 1, #unresclveds:

Additional text 1|

Additional text 2 |

4]
|
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No. Action
10. Confirm the setting by clicking on the symbol. v
11. The configuration of the parameter field for analog alarms is now complete.

System parameters (application, user name, computer name, comment)

No.

Action

12. Inserting system parameters

Open the drop-down list under “Parameters” and select a parameter.

‘gPropelties ||"_i..lnfo ||&[)|aqnostlrs ‘

Properties Events

Alarm texts
General

Trigger Settings

Alarm texts

Status
Alarm annunciator

Display suppression |4

»

o “Application”:

e “User name:”

e “Comment:”

Alarm text
Additional text 1
Additional text 2
Additional text 3
Additional text 4
Additional text 5
Additional text &

Additional text 7

Name of the logged on user.

e “Computer name:”
Name of the computer used by the user.

Analag alarm 1 =Computerhlame:

System paramneter

Info

Uzer name

Application — Application that triggers the alarm.

The comment to an alarm entered by the user.

W

13. Confirm the setting by clicking on the symbol.

14. The configuration of the parameter field for analog alarms is now complete.
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41.2 Configuration of discrete alarms

General configuration of discrete alarms

For the configuration of discrete alarms in WinCC Professional, please proceed as
follows:

Table 4-9

No. Action

1. In the project navigation under the folder of the control panel you created open the “HMI
alarms”

Project tree

Devices
QO

~ 7 ProfessionalfT_57_400

v@
E duled tasks
S
v [5]) Reports
2 Open the tab “Discrete alarms”.
.. » Professional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMI alarms — i il X
|\q Discrete alarms ||;,t Analog alarms H-ﬂ Contreller alarms H_!_‘ User alarms | 4(r
=% E
Discrete alarms
D Alarrn text Alarrn class Triggertag Trigge. Acknowledg.. Ackno.  Single.

<Al new:

In the table, double-click on “<Add new>" to create a discrete alarm.
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No.

Action

Select the discrete alarm you just created and in the inspector window open the tab “Properties
> Properties > General”.

|ng|)elties ||"j,||1fo ||L[)|agnost|rs |

J Properties " Events |
General
.
Settings
Trigger

Alarm texts

o: [2 =
Alarm class: |Errors Hl..

Alarm group: | Mo alarm group- |=)]...

Alarm annunciator |y Mamne: |Discrete_alarm_1
Display suppression

* . =
Friority: |0 |9

e Under “ID”, please select an alarm number for the identification of this alarm.

e Under “Alarm class”, please select an alarm class for the discrete alarm.
In Chapter 4.4 you will find more detailed information about alarm classes.

e If required, please choose an alarm group under “Alarm group” to which the discrete alarm
will be assigned.
In Chapter 4.5 you will find more detailed information about alarm groups.

e Under “Priority”, choose a priority for the display of the alarm.
The priority influences the display of the message in an alarm display. Alarms with a high
priority come before alarms with a low priority.

Note

If you assign different priorities, the analog alarms will be sorted according to the priority and
not the date.

In the inspector window, please open the tab “Properties > Properties > Trigger”.

|8PI'0|)BItiBS ||1i..lnfo ”i[}laqnostlrs ‘

Properties Events

Trigger

General

Settings

Tag He tag ...
Bit:
Made: | Onrising sdge Iz‘

Status

Alarm annunciator 4
Display suppression

»

e Under “tag’, please create a new tag or choose an existing tag for triggering the discrete
alarm.

e Under “Mode”, select the trigger mode when the discrete alarm is to be triggered.
“On rising edge”: The trigger bit changes from 0 to 1.
“On falling edge”: The trigger bit changes from 1 to 0.

Note on trigger tags

e Use the data types “Bool”, “USInt” or “UDInt” for the trigger tags.
e  Only use the tag for triggering the alarm for triggering this alarm.
e Use every bit of a trigger tag for only one alarm.
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No.

Action

In the inspector window, please open the tab “Properties > Properties > Alarm text”.

|§.P|u|)elties ||:i.'.lnfo ”ﬂ[}laqnostlcs ‘

JPlopelties ” Events |

Alarm texts

General

Settings

Alarmtext |

Additional text 1|

Additionaltest 2 |

Status

Alarm annunciator |y Additional test4 |

Display suppression tdditional text 5 |

\
\
\
Additional text 3 | J
\
|
seldifinnal tevt 6 | 1

e Under “Alarm text” please enter the message text in the discrete alarm, for example “Dis-
crete Alarm 1”

e Optionally, you can enter more texts for the discrete alarm under “Additional text”.
The additional texts can be displayed in a separate column in an alarm.

Note

Message texts depend on the language, and depending on your configuration, they can contain

up to 255 characters.

The configuration of the discrete alarm is now complete. The alarm will now be triggered after a

change of signals of the trigger tag.

Display of the discrete alarm in runtime

If you want to display the discrete alarm, an alarm display must have been config-

ured in your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.
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Optional settings for discrete alarms

Creating a tooltip

With a tooltip you can provide the system operator with further information and in-
structions in addition to the alarm text.

Table 4-10
No. Action
1. Open the discrete alarms in the tab “Discrete alarms”.
...Professional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMI alarms — i i@ X
[l Discrete alarms "1 Analog alarms "—ﬂ Controller alarms ||_!_' User alarms | 4| r
= =
Discrete alarms
o] Alarm text Alarrn class Trigger tag Trigge.. Acknowledg.. | Ackno. | Si
=]E [ %] Discrete alanm | Errars [l -tetag- []0 Notag- [0
<Add new:
2. In the inspector window, please open the tab “Properties > Properties > Tooltip”.
‘gPlopelties ”:i.llnfo uﬂ Diagnostics |
J Properties H Events |
Toaltip
G.?n?ral Text
Trigger
| exts ~
Alarm pararneter
Acknowledgment
Status
Alarm annunciator :
Display suppression [
: A
e Under “Text”, please enter the text which is to appear as a tooltip to this discrete alarm. By
means of the respective button in the message display, you can call the tooltip to this mes-
sage.
Note
The tooltip must not be longer than max. 320 characters.
3. The configuration of the tooltip for discrete alarm is now complete.

Evaluating the acknowledgement of the discrete alarm in the PLC

The acknowledgement of the discrete alarm can be polled by a tag in the PLC.

Table 4-11

No.

Action

Open the discrete alarms in the tab “Discrete alarms”.

...00 » PC-System_1 [SIMATIC PC station] » HMI_RT_1 [WinCC RT Professional] »* HMIalarms — W' B X

Cql Discrete alarms ||1 Analog alarms ||_u Controller alarms ||_!_' User alarms ‘ 4|r

EXS Y
Discrete alarms
D Meldetext Alarm class Triggertag | Trigger bit Acknowledgmenttag Acknowledgment bit | Single ¢

L1 Bl piscretealam 1 Emors [L[HMLT. [0 2] <liotag Eo
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In the inspector window, please open the tab “Properties > Properties > Acknowledgement”.

|QP|0|)e|tie-; ”"_i.‘.lnfo ||ﬂD|aqnost|Ls ‘

Properties Events

Tag: |<lo tag: IE ||

[ single acknowledgment

Alarm pararneter

Acknowlsdgment

Status

Alarm annunsiator

Display suppress...

e Under “HMI > Tag”, please choose an existing tag or create a new tag, where the informa-
tion can be stored that the discrete alarm has been acknowledged.

e Under “HMI > Bit”, please select the bit that will be set in the selected tag if a discrete alarm
has been acknowledged.

e If required, activate the option box “Singe acknowledgement”

Note

The control panel and the PLC have only read access to the storage area of the acknowledge-
ment tag.

The configuration of the acknowledgement poll is now complete.

You will find more detailed information concerning the acknowledgement concept
in WinCC Professional in Chapter 4.6.

Query the status

Under “Status” the status of an alarm can be saved in a status tag.

Table 4-12

No.

Action

Open the discrete alarms in the tab “Discrete alarms”.

...Professional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMI alarms — i i@ X

[l Discrete alarms "1 Analog alarms "—ﬂ Controller alarms ||_!_' User alarms | 4| r

= * =
Discrete alarms
o] Alarm text Alarrn class Trigger tag Trigge.. Acknowledg.. | Ackno. | Si

=]E [ %] Discrete alanm | Errars [l -tetag- []0 Notag- [0

<Ad news

In the inspector window, please open the tab “Properties > Properties > Status”.

|E‘.Pro|)elties H:i.llnfn ||ﬂ Diagnaostics |

Properties Events

Status

; Settings
Alarm texts Tag. [0 tag [E1F
Taoltip st [0 [3]

Alarm parameter

Alarm annunciator

Display suppression

e Under “Tag’, select a tag and the respective bit, or create a new tag where the status of the
alarm/alarm group is to be saved.
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No.

Action

The configuration of the status tag for the discrete alarm is now complete.

Alarm annunciator

By activating the “Alarm annunciator” an alarm can be annunciated by optical or
acoustic signals in addition to the alarm display.

Table 4-13
No. Action
1 Open the discrete alarms in the tab “Discrete alarms”.
...Professional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMI alarms — i i@ X
[l Discrete alarms "1 Analog alarms "—ﬂ Controller alarms ||_!_' User alarms | 4| r
= =
Discrete alarms
o] Alarm text Alarrn class Trigger tag Trigge.. Acknowledg.. | Ackno. | Si
=]E [ %] Discrete alanm | Errars [l -tetag- []0 Notag- [0
<Add new:
2 In the inspector window, please open the tab “Properties > Properties > Alarm annunciator”.
|E‘. Properties ||1i.'.lnfo ”ﬂ Diagnostics ‘
Properties Events
Alarm annunciator
General .
— Settings
Zlarm tests ["] Alarm annuneiator
Etratu. B
:
Dizplay suppression [
e Under “Alarm annunciator”, activate the option box “Alarm annunciator”
3 The configuration of the alarm annunciator for the discrete alarm is now complete.

You will find more detailed information on the Alarm annunciator in Chapter 4.6.4.
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Suppressing the display

By activating the Display suppression, it is possible to suppress alarms depending
on the status of the system.

Table 4-14
No. Action
1. Open the discrete alarms in the tab “Discrete alarms”.
...Professional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMI alarms — i i@ X
[l Discrete alarms "1 Analog alarms "—ﬂ Controller alarms ||_!_' User alarms | 4| r
= =
Discrete alarms
o] Alarm text Alarrn class Trigger tag Trigge.. Acknowledg.. | Ackno. | Si
=]E [ %] Discrete alanm | Errars [l -tetag- []0 Notag- [0
<Add new:
Note
If you want to use the display suppression, the respective alarm must be assigned to an alarm
group.
2. In the inspector window, please open the tab “Properties > Properties > Display suppression”.
‘g Properties ”:i.llnfo uﬂ Diagnostics |
J Properties H Events |
Display suppression
o
Alarmm terts Mask:
Taaltip
Alarm parareter
Acknowledgment
Status
Alarm annunciator :
Display suppr [
3 Under “Mask’, please select a status from the drop-down list for which you want to suppress the
display.
Dizplay suppression
Settings
Wask || ECREEEEEEN -]
4. The configuration of the display suppression for the discrete alarm is now complete.
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Output of a dynamic parameter in the alarm text

When a discrete alarm comes, it is possible to display process values and system
parameters in the output box.

Table 4-15
No. Action
1. Open the discrete alarms in the tab “Discrete alarms”.

...Professional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMIalarms — il I X

Al Discrete alarms ||ﬂ,t‘ Analog alarms H_u Controller alarms ”_!_‘ User alarms | 4|r
EX =

Discrete alarms

D Alarm text Alarmclass  Trigger tag Trigge.. Acknowledg.. |Ackno.. Si

tA2 [&] Discrete alarm 1 Errars [ =tiorag- [0 AMorage [0

<Add news:

2. In the inspector window, please open the tab “Properties > Properties > Alarm text”.
|§P|D|)Elties "‘_i.llnfn ||ﬂ Diagnostics |
Properties Events
Alarm tets
:?1(&;‘ Settings
Alamtea | ]
Tactip Aelditional text1 | J
Alarra pararneter dditional text 2 ‘ ‘
Acknowledgment 5
— Additional text 3 | |
Alarm annunziator : Additional text 4 ‘ ‘
Display suppression [ Additional text 5 | J
’ selditinnal teut & | 1
e Click the right mouse button in the entry box “Alarm text” or place the cursor in the alarm
text and click on the right mouse button.
Then the context menu will open up.
3 Select “Insert parameter field” or “insert system parameter” from the context menu.

‘Q‘ Properties ”"j.‘.lnfo Hﬂ Diagnostics ‘

J Properties || Events ‘
Alarm texts
General .
Settings
Trigger
i e Alarm text |Analog alarm 1] W cur
Taaltip Additional text 1 B3 copy
Alarm pararmster sddtionaltns | | = Faste ]
Acknowlzdgment
Additional text 3 ¥ Dalete
Status
Alarm annuneiator Additional text 4 = el
Display suppression | Additional text 5
il m parameter.
n Additional tesxt & ;
v - -
2rMAtn;
F Additional text 7 namng
additional text 8 ’7 Aa change to capital lstters *‘

e Then a dialog for the further configuration of the dynamic parameter (tag) opens up. Please
continue with the section on the chosen tag.
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Parameter field (tag)

No. Action
4. Inserting a parameter field (tag)
Open the drop-down list under “Parameters” and select a parameter (for example Parameter 1).
|Parameters: | Fararmeter: 1 |T||
Process
Tag: |[HMI_Tag_1 ...
FLC tag: o
Address: Int
Format
Display type: |De-:i|‘na| |'|
(<] i | Length: |5 [3] |
4 pro Decimal places:
J Properties | Events Alignment. | Right []
Leading zeras: [ I
Alarrm texts
General Setti
Alarm texts Alarrn text |c|i3crete alarm 1 <Tag : 5, #unresaolve d#- |
Taaltip Additional text 1 | |
Note
Alternatively, you can assign tags to parameters beforehand under “Properties > Properties ->
Alarm parameters”.
5. Select a tag under “Process > Tag” or create a new tag.
Farameters [Farameter 1 |]
Process
FLCtag: o
Address: Int
Note
Alternatively, you can assign tags to parameters beforehand under “Properties > Properties ->
Alarm parameters”.
6. Select a display type under “Format > Display type” for the parameter you selected.

Format

|Disp|ayq‘pe |D=.-:Hna| F‘I
Length' |5 :
Decirnal places

dignwene (mabe [+]

Leadingzeras [
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No. Action
7. Under “Format > Length”, please select the number of characters for the display of the parame-
ter.
Farmat
Display type- | Decimal -
Length: |5 =
Decimal places: |0 =
Alignrment: | Right hd
Leading zsros: [
Note
Choose the length in such a way that all the required characters of the parameters can be dis-
played.
8. Under "Format > Decimal places”, select the number of decimal places for the parameter.
Format
Display type: | Decimal -
Length. |5 =
Alignment. | Right -
Leading z=ras [
9. Under “Format > Alignment”, set the alignment of the output box.
Format
Display type: | Decimal -
Length. |5 =
Decirnal places: |0 =
|.‘~.\iqnmen( [ Right "‘l
Leading z=ras [
10. Optionally, you can activate "Format > Leading zeros”.
Format
Display type: | Decimal -
Length. |5 =
Decirnal places: |0 =
Alignment: | Right —
11. Confirm the setting by clicking on the symbol.
'
12. The configuration of the parameter field for discrete alarms is now complete.
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System parameters

No.

Action

13.

Inserting system parameters

Open the drop-down list under “Parameters” and select a parameter.

e] i

Systern parameter ||

E i

Properties Events

Alarrn teits

General p—
]
J
J

User name

Trigger

Alarm texts Alarm test | discrete alarm 1 =Carnputerilarme-

Tooltip Additional text 1|
Elarm pararnster

Additional text 2 |

e “Application”:

Application — Application that triggers the alarm.
e “User name:”

Name of the logged on user.
e “Computer name:”

Name of the computer used by the user.

e “Comment:”
The comment to an alarm entered by the user.

14.

Confirm the setting by clicking on the symbol.

15.

The configuration of the system parameter for discrete alarms is now complete.
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41.3

Configuration of user alarms

General configuration of user alarms

For the configuration of user alarms in WinCC Professional, please proceed as fol-

lows:

Table 4-16

No.

Action

In the project navigation under the folder of the control panel you created open the “HMI
alarms”

Project tree
Devices

QO

» [ FLC_1 [CFU 416-3 FR/DF]
~ [0 PC-Sy [SIMATIC PC station]

Y Devic iquration
% online & diagn
= w |5 HWI_ET_1 [WincC RT Professio

Ore

..rofessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » HMlalarms — i il X

1l User alarms F‘_ System events H_“ Alarm classes ||_U' Alarm groups ‘ 4|r
= |

=1
User alarms
D Alarm text Alarm class  Acknowledg . Ackno | Single ackno  Alarm anr

<Addd new:

In the table, double-click on “<Add new>" to create a user alarm.
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No. Action
3. Select the user alarm you just created and in the inspector window open the tab “Properties >
Properties > General".
‘gPlopelties ”‘_i.'.lnfo ||ﬂ Diagnostics ‘
Properties Events
General
m Settings
~ dgment 1]
?‘tatu: o Alarm class:
| bl grotpe o s o ]
i Harne:
I Priorty.
e Under “ID”, please select an alarm number for the identification of this alarm.
e Under “Alarm class”, please select an alarm class for the user alarm.
In Chapter 4.4 you will find more detailed information about alarm classes.
e If required, please choose an alarm group under “Alarm group” to which the user alarm will
be assigned.
In Chapter 4.5 you will find more detailed information about alarm groups.
e Under “Priority”, choose a priority for the display of the alarm.
The priority influences the display of the message in an alarm display. Alarms with a high
priority come before alarms with a low priority.
Note
If you assign different priorities, the user alarms will be sorted according to the priority and not
the date.
4. In the inspector window, please open the tab “Properties > Properties > Alarm texts”.
|§.P|u|)elties ||:i.'.lnfo ”ﬂ Diagnostics ‘
J Properties ” Evfllts |
Alarm texts
e s
Taaltp Alarm text | ]
Ac dagment Additianal text 1| ‘
t;(a'.:u: - Additional tet 2 | |
;Iic:::‘l‘a, :U|:‘\:‘\-?‘.:; M Additienaltext 3 | ‘
H Additional textd | |
" Additional text 5 | |
e Under “Alarm text” please enter the alarm text in the user alarm, for example “User Alarm
1
e  Optionally, you can enter more texts for the user alarm under “Additional text”. The addi-
tional texts can be displayed in a separate column in an alarm.
Note
Message texts depend on the language, and depending on your configuration, they can contain
up to 255 characters.
5 The configuration of the user alarm is now complete.
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Triggering a user alarm

A user alarm is triggered by means of a script and the respective ID belonging to
the user alarm.

The following table describes the procedure with a user alarm that has already
been created.

Prerequisite:

e auser alarm must already have been created
Figure 4-1

...ofessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] * HMl alarms — W B X

L User alarms ||E System events ||_.,, Alarm classes ||_U* Alarm groups | | 4 | P|

H
User alarms

D - Alarm text Alarm class  Acknowledgmenttag  Acknowledg... Single acknowle.. Alarm annunciator

L 1o |#| useralarm 1 Errors m Useralarm_ack E 0 El = |

=hdd ne. .

e a button created in any image if the WinCC Professional project

Table 4-17
No. Action
1. Open the image where the button is configured.
2. Click on the button and hen open the tab “Properties > Events”.
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No. Action

3 Configure the following VB script to the event “Click”.

...._Runtime [SIMATIC PC station] » HMI_RT_3 [WinCC RT Professional] » Screens » Screen_1

|
‘E‘. Properties ||"jl||1fo uﬂ Diagnostics

‘Plopemes ” Animations H Events |
FIEERSE BT

B Script
Sub OnClick(ByVal item)

-

2
3 Dim Userllarm

4 Dim ID_TA

5 Dim State_Userilarm

6 ID_Ua = rion

7 State_Userllarm = "1"

& !3et Userdlarm = HMIRuntime.Rlarms (ID_UA)
S Userdlarm.3tate = Jtate_Userldlarm

10 [Userilarm. Comment = "empty Comment'

11 [Userdlarm.UserName = "Max Mustermann'
12 Userilarm. Create "Mylhpplication™

Object chang

14 End Sub

Sub OnClick(ByVal item)

Dim UserAlarm

Dim ID_UA

Dim State_UserAlarm

ID_UA ="10"

State_UserAlarm = "1"

Set UserAlarm = HMIRuntime.Alarms(ID_UA)
UserAlarm.State = State_UserAlarm
UserAlarm.Comment = "empty Comment"
UserAlarm.UserName = "Max Mustermann"
UserAlarm.Create "MyApplication”

End Sub

e  The user alarm used has the ID “10” in this example.
See prerequisite > a user alarm must already have been created.

4. The configuration for triggering the user alarm is now complete. The alarm will be triggered in
runtime by clicking on the button.

Display of the user alarm in runtime
If you want to display the user alarms, an alarm display must have been configured
in your project.
You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure
alarm display”.
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Optional settings for user alarms

Creating a tooltip

With a tooltip you can provide the system operator with further information and in-
structions in addition to the alarm text.

Table 4-18
No. Action Screens
1. Open the user alarms in the tab “User alarms”.
...rofessional_Runtime [SIMATIC PC station] »* HMI_RT_3 [WinCCRT Professional] » HMlalarms — il il X
Ll User alarms HE System events Hﬂ Alarm classes Hj’ Alarm groups ‘ 4| »
=
User alarms
D Alarm text Alarm class  Acknowledg.. |Ackno.. Single ackno... Alarm anr
= [&] Useralam Errars [ =totag- L]0 J J
<Add news
2. In the inspector window, please open the tab “Properties > Properties > Tooltip”.
‘g Properties ""j.llnfn Hﬂ Diagnostics |
J Properties || Events ‘
Tooltip
General Text
Alarr tests
e Under “Text”, please enter the text which is to appear as a tooltip to this user alarm. By
means of the respective button in the message display, you can call the tooltip to this mes-
sage.
Note
The tooltip must not be longer than max. 320 characters.
3. The configuration of the tooltip for the user alarm is now complete.

Evaluating the acknowledgement of the user alarm in the PLC

The acknowledgement of the user alarm can be polled by a tag in the PLC.

Table 4-19

No.

Action

Open the discrete alarms in the tab “User alarms”.

...00 » PC-System_1 [SIMATIC PC station] » HMI_RT_1 [WinCC RT Professional] » HMIalarms — i il X

Cil User alarms ||E System events ”_n Alarm classes ”j' Alarm groups ‘ 4 [ r
=

="
User alarms

D Alaren text Alarm class Acknowledgrn...  Ackno. Single ackno...  Alarm annun..
=ilE [2] Useralamm 1 Errars [ Hatag o ] J

<Add news
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In the inspector window, please open the tab “Properties > Properties > Acknowledgement”.

|QP|D|)e|ties ||"_i.‘.|nfo ||ﬂ Diagnostics |

Properties Events

Acknowy

edarment

Teokip - Tag: |--H-:-tac_\ ‘ﬂ
Acknewledgment Bit:

Status

[ single acknowledgment

Alarm annunciator 4

Display suppressiol

e Under “HMI > Tag”, please choose an existing tag or create a new tag, where the informa-
tion can be stored that the discrete alarm has been acknowledged.

e Under “HMI > Bit”, please select the bit that will be set in the selected tag if a discrete alarm
has been acknowledged.

e If required, activate the option box “Singe acknowledgement”

Note

The control panel and the PLC have only read access to the storage area of the acknowledge-
ment tag.

The configuration of the acknowledgement poll is now complete.

You will find more detailed information concerning the acknowledgement concept
in WinCC Professional in Chapter 4.6.

Query the status

Under “Status” the status of an alarm can be saved in a status tag.
Under “Status” the status of an alarm can be saved in a status tag.

Table 4-20

No.

Action

1.

Open the user alarms in the tab “User alarm”.

...rofessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCCRT Professional] » HMlalarms — & & X

Ll User alarms HE System events Hﬂ Alarm classes Hj’ Alarm groups ‘ 4| »
=

=
User alarms

[ Alarm text Alarm class | Acknowledg.. |Ackno.. Single ackno... Alarm anr

= [&] Useralam Errars [ =totag- L]0 J J

<Add new:

2. In the inspector window, please open the tab “Properties > Properties > Status”.
‘gPlopelties ||‘_i.'.lnfo Hﬂ Diagnostics |
Properties Events
oot ST
Tag: |llo tag: =1
Bic
Alarre annunciatar
Display suppressien ||
e Under “Tag’, select a tag and the respective bit, or create a new tag where the status of the
alarm/alarm group is to be saved.
3. The configuration of the status tag for the user alarm is now complete.
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Alarm annunciator

By activating the “Alarm annunciator” an alarm can be annunciated by optical or
acoustic signals in addition to the alarm display.

Table 4-21

No. Action

1. Open the user alarms in the tab “User alarm”.

...rofessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCCRT Professional] » HMlalarms — & & X

Ll User alarms HE System events Hﬂ Alarm classes Hj’ Alarm groups ‘ 4| »

=
User alarms
D Alarm text Alarm class  Acknowledg.. |Ackno.. Single ackno... Alarm anr
= [&] Useralam Errars [ =totag- L]0 J J
<Add news
2 In the inspector window, please open the tab “Properties > Properties > Alarm annunciator”.

‘gPlopelties ”‘_i.'.lnfo ||ﬂ[}|aqnostlcs ‘

Properties Events

Alarm annunciator

General N
Settings
Alarrm texts
[ Alarm annunciatar

vledgment

Status

Alarm annunciator

Display suppression

e Under “Alarm annunciator”, activate the option box “Alarm annunciator”

3 The configuration of the alarm annunciator for the user alarm is now complete.

You will find more detailed information on the Alarm annunciator in Chapter 4.6.4.

Suppressing the display

By activating the Display suppression, it is possible to suppress alarms depending
on the status of the system.

Table 4-22

No. Action

1. Open the user alarms in the tab “User alarm”.

...rofessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCCRT Professional] » HMlalarms — & & X

Ll User alarms HE System events Hﬂ Alarm classes Hj’ Alarm groups ‘ 4| »
=

—a

User alarms

D Alarm text Alarm class  Acknowledg.. |Ackno.. Single ackno... Alarm anr
= [&] Useralam Errars [ =totag- L]0 J J
<Add news
Note
If you want to use the display suppression, the respective alarm must be assigned to an alarm
group.
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In the inspector window, please open the tab “Properties > Properties > Display suppression”.

‘gPlopelties ”‘_i.'.lnfo ||ﬂ[}|aqnostlcs ‘

Properties Events

Display suppression

General

Settings

S T i

Alarrm texts

Status

Alarm annunciator

Display suppression

4
*

Under “Mask’, please select a status from the drop-down list for which you want to suppress the
display.
Display suppression

Settings

The configuration of the display suppression for the user alarm is now complete.

Output of system parameters in the alarm text

When a user alarm comes, it is possible to display system parameters within the
alarm text in an output box.

Table 4-23

No.

Action

Open the discrete alarms in the tab “User alarms”.

...rofessional_Runtime [SIMATIC PC station] » HMI_RT_3 [WinCCRT Professional] » HMlalarms — & & X

Ll User alarms HE System events Hﬂ Alarm classes Hj’ Alarm groups ‘ 4| »

=
User alarms
D Alarm text Alarm class  Acknewledg.. Ackne.. Single ackne... Alarm anr
= [&] Useralam Errars [ =totag- L]0 J J

<Add new:

In the inspector window, please open the tab “Properties > Properties > Alarm text”.

‘g Properties ”'Li.l.lnfo ||ﬂ Diagnostics ‘

JPIUDEItiES ” Events |
Alarm texts
General N
Settings
Taakp Alarm text |

Acki
Status

dgment Additional text 1 |

Additional text 2 |

Alarm annunciator

Display suppressi

Additional textd |

]
]
\
sdditional text 3 | \
\
\

Additionalte s |

e Click the right mouse button in the entry box “Alarm text” or place the cursor in the alarm
text and click on the right mouse button.

Then the context menu will open up.
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No. Action
3 Select “Insert system parameter” from the context menu.
|QP|D|)elties ""_i.‘,lnf-) uﬂ Diagnostics ‘
J Properties || Eve_nts |
Alarm texts
g
T Alarm text || VY cut
e o sdditionaltetl | oo ]
jltatf‘/' o Additonalteez [ | e ]
D\:\:\a;-:u\:‘|:‘|"e::;-:‘n 5 il i 2 |: :l
sdditionalteta | ]
[ Additional text 5 ameterfield.. —‘
[T I: tern parameter... :l
additionaltmey [ | -=erfermatung ]
edditional test 8 ,— Aa thange to capital letters —‘
e Then a dialog for the further configuration of the dynamic parameter (tag) opens up.
4. Open the drop-down list under “Parameters” and select a parameter.
System pararmetsr | Computer nams
Infa
e “Application”:
Application — Application that triggers the alarm.
e “User name’’
Name of the logged on user.
e “Computer name:”
Name of the computer used by the user.
¢ “Comment:”
The comment to an alarm entered by the user.
5. Confirm the setting by clicking on the symbol.
6. The configuration of the system parameter for a user alarm is now complete.
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4.2

421

Configuration of system-defined alarms

Configuration of system alarms

The following chapter describes how to do the following in WinCC professional:

e importing the system alarms

¢ changing message texts of the system alarms and inserting additional texts
e adding tooltips to the system alarms

e configuring the alarm annunciator for a system alarm

Importing system alarms

Importing system alarms is only necessary for projects that were newly created, or

where the system alarms have not been imported.

Table 4-24

No.

Action

In the project navigation under the folder of the control panel you created open the “HMI alarms”

Project tree

Devices
400

i D= netwarks
» (il PLC_1 [CPU 415-3 PH/DP]
« [0 PC-Sy [SIMATIC PC station]
i [l pevice co
%/ online
= w5 HWI_FT,

Open the tab “System alarms”.
Projekt1 » PC-System_1 [SIMATIC PC station] » HMI_RT_1 [WinCC RT Professional] » HMl alarms — il B X

=l Analog alarms ||4| Contraller alarms ”,!I User alarms  ||EL System events  [B3 Alarm classes 4|
=)

Controller alarms

D Meldetext Common alar... PLC single ackno Alarm annun
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No. Action
3 Confirm the dialog (see figure) that appears with “OK”.
Import system events
Do you want to import the system
n events?
Apparently, no system events have been
irmported yet
e o
e The system alarms are then imported into your project.
4. The system alarms are now imported into your project.

Display of the analog alarm in runtime

If you want to display the system alarms, an alarm display must have been config-
ured in your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.

Changing message texts of the system alarms

The message texts of the system alarms can be adapted or changed if required.
The respective message numbers cannot be changed.
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Table 4-25
No. Action
1. In the project navigation under the folder of the control panel you created open the “HMI alarms”
Devices

EQO

~ ] PrafessianalRT_s7_400
": e
i De ks

» [ PLC_ 1 [cPU 416

= w5 HUIET_1

Oy o=

2.
System events
D Meldetext Alarm annun
=) e Dot 0 B
= 0
= Chann 0
B Tag value fal D
= 0
= 0
= 0O
e Select the system alarm for which you want to change the message text.
3 In the inspector window, please open the tab “Properties > Properties > Alarm text”.
‘g Properties H"_i.‘.lnfo ||ﬂ Diagnostics ‘
Properties Events
Alarr texts
General Settings
Tookip Alarmn test | WCCRT @ 100%s@ Error during leading of object 2ngine Bl
Alarrn annunciator Additional text 1 | @
L Additional text 2 | 2]
I Additional texe 3 | o=
M Additianal testd | 3]
[ sdditicnal test 5 | X1
e Please change the message text of the system alarm under “Alarm text”.
e  Optionally, you can add more texts concerning the system alarm under “Additional texts”.
Note
Never delete the wildcards (for example @100%s@ in the system alarms).
4. The changing of the message text for the system alarm is now complete.
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Adding tooltips

With a tooltip you can provide the system operator with further information and in-
structions in addition to the alarm text.

Table 4-26
No. Action
1. Open the system alarms in the tab “System alarms”.
..sjekt1 » PC-System_1 [SIMATIC PC station] » HMI_RT_1 [WinCC RT Professional] » HMlalarms — il & X
||E System events ‘l;, Alarm classes ||_U' Alarm groups ||§ Alarm text blocks | 4|
=
System events
D Meldetext Alarm annun
1 0 ] L]
o 0
= o
= 0
= 0
=N 0
K W =]
2. In the inspector window, please open the tab “Properties > Properties > Tooltip”.
‘g Properties H‘_i.‘.lnfo ”ﬂ Diagnostics ‘
Properties Events
Taoltip
General T
Al texts ext
=
Alarm annunciater
e Under “Text”, please enter the text which is to appear as a tooltip to this system alarm. By
means of the respective button in the message display, you can call the tooltip to this mes-
sage.
Note
The tooltip must not be longer than max. 320 characters.
3. The configuration of the tooltip for the system alarm is now complete.

Alarm annunciator

By activating the “Alarm annunciator” an alarm can be annunciated by optical or
acoustic signals in addition to the alarm display.
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Table 4-27

No. Action

1. Open the system alarms in the tab “System alarms”.

..sjekt1 » PC-System_1 [SIMATIC PC station] » HMI_RT_1 [WinCC RT Professional] » HMIalarms — il i X

||E System events ‘l;, Alarm classes ||_U' Alarm groups ||§ Alarm text blocks | 4|

‘gPlopelties H‘_i.‘.lnfo ”ﬂ Diagnostics ‘

Properties Events

Alarm annunciator

General .
Settings
Alarrn texts

Taol

Alanm annunciator

[] Alarm annunciator

e Under “Alarm annunciator”, activate the option box “Alarm annunciator”

=
System events
D Meldetext Alarm annun

= @ Errar 0 [«]
E @:Error during loa. . D
= ¢ ldn 0

E @ Tag value falls b D

= ofthe a

= a

B 1o = 2:5cale of tag a

2 In the inspector window, please open the tab “Properties > Properties > Alarm annunciator”.

3 The configuration of the alarm annunciator for the system alarm is now complete.

You will find more detailed information on the Alarm annunciator in Chapter 4.6.4.
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422 Configuration of CPU system diagnostic alarms

The following chapter describes the configuration of the display of system diagnos-
tic alarms of a CPU in WinCC Runtime Professional using the following compo-
nents:

e CPU 416-3 PN/DP
o Diagnostic status DB 127 (RSE_DIAGNOSTIC_STATUS_DB)
¢  WinCC Runtime Professional (PC station)

System diagnostic data blocks

You will find more detailed information concerning the diagnostic blocks in the
Online help for STEP 7 Professional.

Table 4-28
Block Block name Block Functional scope
number

Diagnostic status RSE_DIAGNOSTIC_STATUS_DB | 127 Display the system status

DB of a configured compo-
nent and the subordinate
components.

PROFINET 10-DB RSE_PROFINET_IO_DB 126 Display the status of all

the configured 10 devices,
optionally: display exact
status of a device
PROFIBUS DP-DB RSE_PROFIBUS_DP_DB 125 Display the status of all
configured stations of the
current DP master system
and the status of the DP
slave.

Settings in STEP 7 Professional
Table 4-29

No. Action

1. In the project navigation under the folder of the CPU you created, open the “Device configu-
ration”.

Project tree
Devices

» [ Online backups

B Frogram info

2. In the graphic view of the device, mark the CPU on the module carrier.
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No. Action

3 In the inspector window, please open the tab “Properties > Properties > System diagnostics”
> “General’”.

|£, Properties ||‘_i..|nfo H& Diagnostics

General

b General

» MFIDF interface [x1]

» FROFINET interface [x5]
Startup D Activate system diagnostics fer this PLC

General

»

4. Activate the option box “Activate system diagnostics for this PLC”.

The option box “Send alarms” is activated by default. If this option is deactivated, it must be
activated

General

| Activate systern diagnostics for this PLC
send alarms

[ Load system diagnostic block when loading hardware configuration

Note

The option box “Load system diagnostic block when loading hardware configuration” cannot
be activated, since it is already activated by default.

5 In the inspector window, please open the tab “Properties > Properties > System diagnostics”
> “Diagnostic support”.

|£,P|o|)e|ties ||‘_i..|nfo H&[)lagnosnrs ‘

General
b General . .
» MFIDF interface [x1] IDbEmesie suppe:
b FROFINET interface [X5] Additional blocks for diagnostic data

Startup

Elock name Black number
Diagnostic status DE:
» Alarms Extended diagnostic settings
Blocks Query for status "activated/deactivated” after startup

Send alarm if status changes from/to activatzd or deactivated
Clack
Petentive mernary

e  Check whether the option box “Diagnostic status DB” is activated.
If the option box is deactivated, active the option box.
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No.

Action

In the entry box ,Block name®, enter the name of the status DB you want to use for the diag-
nostic function.

Additional blocks for diagnostic data

Elock name Elock number

=) Diagnastic status DB | pSE_DIAGNOSTIC_STATUS_DE  |f| |
FROFINET 10 DE: | I |
FROFIBUS DF DB | [ ]

Note
You can also assign a different name for the block, if the name is not being used.

The status DBs “PROFINET |0-DB” and “PROFIBUS DP-DB” only have a limited diagnostic
functionality. Therefore, the “Diagnostic status DB” is to be preferred.

In the entry box “Block number”, enter the respective data block number of the status DB.

Additional blocks for diagnostic data

Elock name Elock number

=] Diagnastic status DB | pSE_DIAGNOSTIC_STATUS DB [|[127 |
FROFINET 10 DE: | I |
FROFIBUS DF DB | [ ]

Note
You can also assign a different number for the block, if the number is not being used.

Right-click on the CPU in the project navigation.

Project tree m 4
Devices

PLC alar
Harne
1 = Al

» [F Al

o>

> 3
==

M o Ctrl+ &

& cony

g Fast=

¥ Delete

Fename

Ctrl+C
Ctrley
Del
F2

1517 (<l (37 00 [ g
S

L3

Ctrl+k

ctrlenl Software (rebuild all blocks)
ctrl+D

e Select “Compile > Hardware configuration” in the context menu.

After the compilation of the hardware, the following system blocks are created:
e system diagnostics (in this example the DB 127)

e diagnostic FB (pre-set: FB 49)

¢ Instance DB for the diagnostic FB (pre-set: DB 49)

e global DB (pre-set: DB 50)

e diagnostic FB (pre-set: FC 49

Transfer the configuration into the PLC.
The necessary settings in the STEP 7 Professional are now complete.
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Display of the CPU system diagnostic alarms in runtime
If you want to display the CPU system alarm, an alarm display must have been
configured in your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.
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4.3 Configuration of PLC alarms

Message blocks

The following table shows all the message blocks supported by WinCC Basic /
Comfort / Advanced.

Note The use of the message blocks depends on the control panel used.
In Chapter 2.4 you will find an overview of the availability of message blocks /
message procedures.

Table 4-30
Message SFB / SFC Data type Properties Characteristic Features
block

ALARM_S SFC 18 C_Alarm_s 1 channel, no acknowl- Every call and signal
edgement, up to 1 asso- | change to the previous
ciated value block call, creates an alarm

ALARM_SQ SFC 17 C_Alarm_s 1 channel, acknowl- like ALARM_S
edgement possible,
up to 1 associated value

ALARM_D SFC 108 C_Alarm_s 1 channel, no acknowl- like ALARM_S
edgement possible,
up to 1 associated value

ALARM_DQ SFC 107 C_Alarm_s 1 channel, acknowl- like ALARM_S
edgement possible,
up to 1 associated value

ALARM SFB 33 C_Alarm 1 channel, acknowl- Sends one message at
edgement possible, each coming or going edge
up to 10 associated
values

ALARM_8 SFB 34 C_Alarm_8 8 channels, acknowl- Sends one message or
edgement possible, no more messages at each
associated values coming or going edge

ALARM_8P SFB 35 C_Alarm_8p | 8 channels, acknowl- Like ALARM.
edgement possible,
up to 10 associated
values

NOTIFY SFB 36 C_Notify 1 channel, no acknowl- Like ALARM.
edgement possible,
up to 10 associated
values

NOTIFY_8P SFB 31 C_Notify_8p | 8 channels, no acknowl- | Like ALARM.
edgement possible,
up to 10 associated
values
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431

Parameters of the ALARM_S message block

Configuration of ALARM_S alarms

An ALARM_S is a PLC alarm that generates a message after a signal change (ris-
ing edge) and sends it to all the participants in the message procedure.

An associated value can be configured to an ALARM_S which will be displayed in
addition to the message text.

All the alarms that are sent via the ALARM_S message block imply an acknowl-
edgement. A subsequent acknowledgement is not necessary.

The following table shows all the parameters of the ALARM_S message block.

Table 4-31
Parame- Declaration Data type Memory area Description
ters
SIG Input BOOL E,AMD,L The signal that triggers an
alarm.
ID Input WORD E,A M, D,Lor Data channel for the mes-
constant sages: W#16#EEEE
EV_ID Input C_Alarm_S E,A MD,Lor Message number of the alarm
constant (no “0” allowed)
SD Input BOOL (not al- E,AMD,T,Z Associated value
lowed: Bitfield), max. length 12 bytes
BYTE, CHAR,
WORD, INT,
DWORD, DINT,
REAL, DATE,
TOD, TIME,
S5TIME,
DATE_AND_TIME
RET_VAL | Output INT E,A M D,L Error code output.
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Configuration in STEP 7 Professional

For the configuration of an ALARM_S message STEP 7 Professional, proceed as

follows:

Creating a function block
Table 4-32

No.

Action

In the project navigation under the folder of the CPU you created, open the “Project blocks”.

Project tree
Devices

OO

- ] Frajektl

~ [ PLC_1[CPU 41

» [ Technolog
b [} External

§ Frograrm infa
LA PLC alarms

E] Text lists

Open a function block with a double click in which you would like to configure the ALARM_S

2.
message or create a new function block and open it.
3 Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.
~ |§Exten(le(l instructions
Name Description Version
» [] ProfiEnergy V1
Report up to sight sign \. .
Create PLC alarms wat.. V1.1
Creats PLC alarms wit.. W11
Report a signal change V11
Create PLC alarms Vi
G?Héldté alarm m V1.0
Create PErmansn
- |Technn|ngy
4. Drag & drop the message block “ALARM_S” into an empty network of your FB.

¥ Block title:

Camment

~ §3Network 1:  Alarm_3

Comment
ALARMI_S
— EN
—5IG
1s]
EV_ID RET_WAL
S0 ENO —
<l tags used=
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No. Action
5. In the block interface of the function block, declare the static variables the parameters of the
message block.
Please find the required parameters in the chapter "Parameters of the ALARM_S message
block®.
G i B RRBEEE 6 = &
Interface
tName Data type Offset Default . Visible in
1 < = Input
2 = siG Bool 0.0 false =]
3 as. EV_ID c_Alarm_s 2.0 =]
4 4 - Output
5 @ RET_VAL_1 Int 80 i} =]
6 4l - InOut
8 4@ : 5tc1tl;..‘.“IT
9 4= Associated_value Word 100 i} =]
10 <@ = Temp
1 = Add nes
12
Note on the input “ID”
The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE". In this sample configuration the value is directly written at the input without using
an additional variable.
If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.
6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.
2 s=1 o4 = = =]
» Blocktitle: ..
- Metwork 1:  Alarm_s
_Is ALARM_S
w HIG
fai? FobAWT
Note
In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.
7. The configuration of the ALARM_S message in the function block is now complete.
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Creating an instance data block

No. Action
8. Open an organization block (e.g. OB1) in your project.
9. Call the function block where you configured the ALARM_S message block in this organization

block (e.g. OB1).
Then a dialog for creating the instance data block opens up.

w Blocktitle:  "Main Frogram Sweep (Cycle)” i- Foptions “
Camment
Data block
v S Network 1:  ALRN_S F Harne [AL5R_S_DB [~]
Cammant DB T N |
Single () Wanual
nstance —
A
SR (@ Autamatic
"ALARM_S" The called function block saves its data in its own instance
data black
ENO —|
. —sig RET_VAL_1
I
EV_ID More
o tags used

10. Click on “OK?” to confirm.

Now, all the required parameters are automatically connected and a message number is cre-
ated. The message number is entered at the input “EV_ID” automatically.

w Block title:  "Main Program Sweep (Cycle)"

Comment

- Network 1:  AL4RM_S

Camment
OB
“ALARM_S_DE"
WFET
"ALARI_S"
EN ENC
false =i 51 RET_WAL_1
10
DWW 52E000_
1 —{EV_ID
11. The instance data block is now created and is called by the organization block.

Configuring the message text of the ALARM_S message

No. Action

12. In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Project tree

Devices
OO

BE Prograrn info
E] Textlists
3 rj] Local modules
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No.

Action

13.

Select the ALARM_S message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.

PLC alarms

Mame Type D Range Location Meldetext Infotext Alarm class

1 [ Alarm_s Alarm_s 1 Alarm_5_FB g I &7 -nocla

< m »

‘g Properties ||:i..lnfo H % Diagnostics

General

General

Texts

Atributes

Hame Text
1 | info text 3
2 | Alarm text
3 Additional text 1 &'

Wy ¥

e Under “Alarm texts” please enter the message text for the ALARM_S.

e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.

14.

In the inspector window, please open the tab “Properties > Properties > Attributes”.

|g Properties H'Li..lnfo H& Diagnostics |

J General ‘

General

Attributes

Texts

Attributes

[ report

Display class | o E
[w) with acknovdedgment [ %

Friarity | 0

Alarm class | <noe class

IR

Group D | ©

e Under “Alarm class”, please select “System_Acknowledgement”.

In Chapter 3.4, you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM_S.”

e  Under “Priority”, choose a priority for the display of the ALARM_S.” The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM_S. Alarms that belong to
the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledgement
is possible. If you use alarm blocks without the possibility of an acknowledgement, this option
has not function.

15.

Right-click on the CPU in the project navigation.
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No. Action
16 Select “Compile > Software (rebuild all blocks)” in the context menu.
Devices
PLC alar
w ] ProfessionalRT_57_400 Narne
1 = Al
2 | (FaAk
3 | F AL
Open 4 = Al
Openin new editor 5 AL
MUY cu Ctrlax 8 = Al
» 1B copy ctrleC 7 = Al
» §[0g Faste ctrlay 8 e
* 15 Delets Del - =l
D Fename F2
»
o <lw
: ° - o Alarm ir
2 Al
] v Hardware canfiguration
» 5 Ctrl+k re
' ot
» g O ol
» [ s
Show force values
17 Transfer the configuration into the PLC.
The configuration of the ALARM_S is now complete.

Displaying the Alarm_S in runtime

If you want to display the Alarm_S, an alarm display must have been configured in

your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.
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4.3.2

Configuration of ALARM_SQ messages

An ALARM_SQ is a PLC alarm that generates a message after a signal change
(rising edge) and sends it to all the participants in the message procedure.

An associated value can be configured to an ALARM_SQ which will be displayed in
addition to the message text.

All the alarms that are sent via the ALARM_SQ message block imply an acknowl-
edgement. The alarm can be acknowledged on the control panel.

Parameters of the ALARM_SQ message block
The following table shows all the parameters of the ALARM_SQ message block.

Table 4-33
Parame- Declaration Data type Memory area Description
ters
SIG Input BOOL E,AMD,L The signal that triggers an
alarm.
ID Input WORD E,A M, D,Lor Data channel for the mes-
constant sages: W#16#EEEE
EV_ID Input C_Alarm_S E,A MD,Lor Message number of the
constant alarm (no “0” allowed)
SD Input BOOL (not al- E,AMD,T,Z Associated value
lowed: Bitfield), max. length 12 bytes
BYTE, CHAR,
WORD, INT,
DWORD, DINT,
REAL, DATE,
TOD, TIME,
S5TIME,
DATE_AND_TIME
RET_VAL Output INT E,A MD,L Error code output.
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Configuration in STEP 7 Professional

For the configuration of an ALARM_SQ message STEP 7 Professional, proceed as

follows:

Creating a function block
Table 4-34

No.

Action

In the project navigation under the folder of the CPU you created, open the “Project blocks”.

Project tree

Devices
OO

- ] Frajektl

» [ Technolog
b [} External

arn infa

LA PLC alarms

E] Text lists

¥ Block title:

Corament

v £4Network 1:  larm_s0

Cornment
ALARM_SQ
—ENl
»—3lG
14
EV_ID RET_VAL
sD ENO —
<Moo tags used=

2. Open a function block with a double click in which you would like to configure the ALARM_SQ
message or create a new function block and open it.
3 Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.
- |5Exten(le(l instructions
Name Description Version
» [] FrofiEnergy Vi
» (] Mac ran 20
» [ Interrupts /2.0
Reportup to eight sign... \. ()
Create PLC alarms wit [
Create PLC alarms wit [
Report a signal change V1.1
Create PLC alarms 11
Generate alarm m 1
Generate alarm m 1
Create PErmansn
ble PLC alarms V1.0
dynamically V10
Wynamically ass.. V1.0
- |Techno|ogy
4. Drag & drop the message block “ALARM_SQ” into an empty network of your FB.
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No. Action

5. In the block interface of the function block, declare the static variables the parameters of the
message block.

Please find the required parameters in the chapter "Parameters of the ALARM_SQ mes-

sage block”.

Wil P g El:%z., e = H T

Interface
Hame Data type Offset  Default.. visible in

1 < = Input

2 e L Bool 0.0 false =]
3 as. EV_ID c_Alarm_s 2.0 =]
4 4@ - Output

5 @ RET_VAL_1 Int 80 i} =]
& 4@ v InOut

7 = Adlel nes

8 40 - Static

9 |4 = Associated_value Word 100 1} =]
10 <@ w Temp

1

1

Note on the input “ID”

The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without
using an additional variable.

If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.

6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.
2 s=1 o4 = = =]

» Block title: .

- Network 1:  slarm_sg

Corarment

ALARN_SQ
—EN
A5G — SIG
VA1 EHEEEE (s}
HEV_ID — EV_ID RET_VAL — #RET_VAL
#3D 5D ENO —
w HIG
SEV_ID
"Tag_1" Fb W1
Note

In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.

7. The configuration of the ALARM_SQ message in the function block is now complete.
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Creating an instance data block

No. Action
8. Open an organization block (e.g. OB1) in your project.
9. Call the FB in your application program, for example in the OB1.
Then a dialog for creating the instance data block opens up.
™ Bloclctities o Frogrem Swecp (G [Caaptions ———————————————————%'
o Data block
~ 3 Metwork 1:  ALARM_5Q Hams |ALRKI_50_DE [+
Comment wnber [ %]
() Wanual
e @ Automatic
MALARNM_SQ" The called function black saves s data in itz own instance
- o — data block.
—sIG RET_VAL
EV_ID
oo Mare. .
Mo tags use=d
10. Click on “OK?” to confirm.
Now, all the required parameters are automatically connected and a message number is cre-
ated. The message number is entered at the input “EV_ID” automatically.
w Block title:  "Wain Program Sweep (Cycle)"
Carmment
- Network 1:  2LaRM_sQ
Carnment
%DB1
"ALARM_SOQ_DE"
%FB1
“"ALARM_SQ"
EN ENC
faloe — 516 FET_VAL
ow
EV_ID
Els)
11. The instance data block is now created and is called by the organization block.
Configuring the message text of the ALARM_SQ message
No. Action
12. In the project navigation under the folder of the CPU you created, open the “PLC alarms”.
Devices
0O
» [ FLC data
» [ Watch ar & tables
4 Prograrm
E] Textli
3 rj] Local modules
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No. Action
13. Select the ALARM_SQ message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.
PLC alarms
Marne Type ] Range Location Meldetext Infotext Alarm class
1 [ Alarn_S5Q Alanmn_s 1 ALARM_SG_FE P &9 enocla
|§,Plopelties H‘_i..lnfo HL Diagnostics
General
-_:i:m‘ Texts
Artributes
MName Text
1 Infotest P
2 | Alarmtex =
3 Additional test 1 &
e Under “Alarm texts” please enter the message text for the ALARM_SQ.
e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.
14. In the inspector window, please open the tab “Properties > Properties > Attributes”.

+

‘QPlupelties H_A..Info ||L Diagnostics |
General
aeneral .
Attributes
Texts
Display class | © - [ Repart
Frierity |0 - [ with acknowledgment [ %
Alarm class no class: -
Graup D |0 hd

e Under “Alarm class”, please select “System_Acknowledgement”.
In Chapter 3.4 you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM_SQ.”

e Under “Priority”, choose a priority for the display of the ALARM_SQ.” The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM_SQ. Alarms that belong
to the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledge-
ment is possible. If you use alarm blocks without the possibility of an acknowledgement, this
option has not function.
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15. Right-click on the CPU in the project navigation.

16 Select “Compile > Software (rebuild all blocks)” in the context menu.
Devices
ST A EEE
PLC alar
7 ProfessionalRT_57_400 Narme
1 =
r (F Al
b A
a 2
5 = AL
» Ctrlax 6 =
3 ctrl+C 7 3 Ak
3 Ctrly 8| &nec
* 15 Delete Ol e
4 F2
3
[ ]
: B o Alarm ir
>3 .
3 1 device 3 re canfiguration
» EIII G Ctrl+k Software
» Ctrl+ D
y s

17. Transfer the configuration into the PLC.
The configuration of the ALARM_SQ is now complete.

Displaying the Alarm_SQ in runtime

If you want to display the Alarm_SQ, an alarm display must have been configured

in your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.
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433 Configuration of ALARM_D messages

An ALARM_D is a PLC alarm that generates a message after a signal change (ris-
ing edge) and sends it to all the participants in the message procedure.

An associated value can be configured to an ALARM_D which will be displayed in
addition to the message text.

All the alarms that are sent via the ALARM_D message block imply an acknowl-
edgement. A subsequent acknowledgement is not necessary.

Parameters of the ALARM_D message block

The following table shows all the parameters of the ALARM_D message block.

Table 4-35
Parame- Declaration Data type Memory area Description
ters
SIG Input BOOL E,AMD,L The signal that triggers an
alarm.
ID Input WORD E,A M, D,Lor Data channel for the mes-
constant sages: W#16#EEEE
EV_ID Input C_Alarm_S E,A MD,Lor Message number of the
constant alarm (no “0” allowed)
CMP_ID Input DWORD E,A M D,Lor ID for the subsystem to which
constant the message is assigned (not
allowed: 0).
Recommended values:
e low word: 1to 65535
e high word: 0
SD Input BOOL (not al- E,AMD,T,Z Associated value
lowed: Bitfield), max. length 12 bytes
BYTE, CHAR,
WORD, INT,
DWORD, DINT,
REAL, DATE,
TOD, TIME,
S5TIME,
DATE_AND_TIME
RET_VAL | Output INT E,A M D,L Error code output.
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Configuration in STEP 7 Professional

For the configuration of an ALARM_D message STEP 7 Professional, proceed as
follows:

Creating a function block
Table 4-36

No.

Action

In the project navigation under the folder of the CPU you created, open the “Project blocks”.

Project tree

Devices
OO

2 Main [0B1]
» [ Tech
b [} External
» L@ FLCtags
v [ lata types

LA PLC alarms

E] Text lists

Open a function block with a double click in which you would like to configure the ALARM_D
message or create a new function block and open it.

Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.

~ |§Exten(le(l instructions

Hame Description Version
» [ ] ProfiEnzrgy

2 HNOTIFY_8F Feport up to sight sign
Create FLC alarms wit..
Create PLC alarms wit.. W
Report a signal change
Create PLC alarms wit.. W

Generate alarm mess

Generate alarm m:

Create permanentl

Determine the ack
l auserdiagnostic.. V1.0

Send archive data

Enable PLC alarms

PLC alarms

~ [ Technology
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No. Action
4. Drag & drop the message block “ALARM_D” into an empty network of your FB.
w Block title: ..
~ §4Network 1:  2larm_D
- ALARM_D
7.7 m—5IG
Zj;ljo RET_VAL
e END =
=Motags used=
5. In the block interface of the function block, declare the static variables the parameters of the
message block.
Please find the required parameters in the chapter “Parameters of the ALARM_D message
block”.
Wik E F B E%! e = &7
Interface
- Name Data type Offset  Defaultvalue  Visible in ..
I < - Input
2 @ SIG Bool o0 false =)
s an. EV_ID c_Alarm_s 20 =]
4 41 = CMP_ID Dward &0 E
S 4 - Qutput
6 |amw RET_VAL Int =]
7 4l - InCut
8 = Add new
9 4l - Static
ioj@= S Word E 20 0 =
11 40 - Temp
12 L] Add new
Note on the input “ID”
The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without
using an additional variable.
If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.
6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.
w Block title: ..
- Network 1:
ALARM_D
;”;IG: ::l’]
#16HEEEE [[x]
a;i[:i Zﬁjo FET_VAL — #RET_WAL
#3D 50D END =
w HIG
Py
#RET AL
Note
In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.
7. The configuration of the ALARM_D message in the function block is now complete.
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Creating an instance data block

No. Action
8. Open an organization block (e.g. OB1) in your project.
9. Call the FB in your application program, for example in the OB1.
Then a dialog for creating the instance data block opens up.
™ Block titleran fresram weep (G '
Data block
> E3Network 1:  ALARM_D [ [ALARM_D_DE [=]
Cormment EB Mumber [ TZ]
Single O Manual
? nitance —
T (@) Automatic
"ALARIM_D" The called function block saves its data in its own instance
T el data block
- 516G FET_VAL
EV_ID
CMP_ID Mare..
e tags used
10. Click on “OK?” to confirm.
Now, all the required parameters are automatically connected and a message number is cre-
ated. The message number is entered at the input “EV_ID” automatically.
w Block title:  "Main Frogram Sweep (Cyele)”
Carmment
- Network 1:  ALARM_D
Comment
%DE1
"ALARM_D_DE"
WFB1
"ALARM_D"
EN ENG
falze = 516 RET_VAL
| CMP_ID
11. The instance data block is now created and is called by the organization block.

Configuring the message text of the ALARM_D message

No.

Action

12.

In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Project tree

Devices
OO

» [ FLC tags
» [ FLC data types

arn info

[ PLC alarms

E] Textlists
3 rj] Local modules
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No. Action

13. Select the ALARM_D message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.

=g
PLC alarms
Marne Type ] Range Location Meldetext Infotext Alarm class
1 7 ALARM_D Alarm_s 1 ALSRM D g % &0 wnocla
<[m »
|§,Plopelties H‘_i..lnfo HL[)laqnostl(s
General
General
Texts
Artributes
Mame Text
1 | Infotext &
2 | Alarmtex =
3 Additional test 1 &

e Under “Alarm texts” please enter the message text for the ALARM_S.

e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.

14 In the inspector window, please open the tab “Properties > Properties > Attributes”.
‘QPlupelties H"_i..lnfo ||L Diagnostics |
General
General .
Texts Attributes
Display class |0 - DF‘.epnrt
Friority | 0 - [ with acknowledgment [+
Alarm class | <no class: -
Group 1D |0 =

e Under “Alarm class”, please select “System_Acknowledgement”.
In Chapter 3.4, you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM_D.”

e  Under “Priority”, choose a priority for the display of the ALARM_D.” The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM_D. Alarms that belong
to the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledge-
ment is possible. If you use alarm blocks without the possibility of an acknowledgement, this
option has not function.

15. Right-click on the CPU in the project navigation.

16. Select “Compile > Software (rebuild all blocks)” in the context menu.
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No. Action
Project tree m 4
Devices
EHQO 2 |28 o
PLC alar
w ] ProfessionalRT_57_400 Narne
B Add new device 1 = Ale
7 & netwarks 2 | (FaAk
3|y Fan
Open 4 = Al
Openin new sditer 5 =
MUY cu Ctrlax 8 = Ali
* g copy ctilsC 7 = Al
» §[0g Faste ctrlay 8 e
* 1% Delets Del B e
D Rename F2
3
[ ]
: Alarm ir
v Al
» Gt Hardware configuration
» 5 ctrlek Software
» [ onl § il
v [ sy
Show force values
17 Transfer the configuration into the PLC.
The configuration of the ALARM_D is now complete.

Displaying the Alarm_D in runtime

If you want to display the Alarm_D, an alarm display must have been configured in

your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.
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434 Configuration of ALARM_DQ messages

An ALARM_DQ is a PLC alarm that generates a message after a signal change
(rising edge) and sends it to all the participants in the message procedure.

An associated value can be configured to an ALARM_DQ which will be displayed
in addition to the message text.

All the alarms that are sent via the ALARM_DQ message block imply an acknowl-
edgement. The alarm can be acknowledged on the control panel.

Parameters of the ALARM_DQ message block
The following table shows all the parameters of the ALARM_DQ message block.

Table 4-37
Parame- Declaration Data type Memory area Description
ters
SIG Input BOOL E,AMD,L The signal that triggers an
alarm.
ID Input WORD E,A M, D,Lor Data channel for the mes-
constant sages: W#16#EEEE
EV_ID Input C_Alarm_S E,A MD,Lor Message number of the
constant alarm (no “0” allowed)
CMP_ID Input DWORD E,A M D,Lor ID for the subsystem to which
constant the message is assigned (not
allowed: 0).
Recommended values:
e low word: 1to 65535
e high word: 0
SD Input BOOL (not al- E,AMD,T,Z Associated value
lowed: Bitfield), max. length 12 bytes
BYTE, CHAR,
WORD, INT,
DWORD, DINT,
REAL, DATE,
TOD, TIME,
S5TIME,
DATE_AND_TIME
RET_VAL | Output INT E,A M D,L Error code output.
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Configuration in STEP 7 Professional

For the configuration of an ALARM_DQ message STEP 7 Professional, proceed as

follows:

Creating a function block
Table 4-38

No.

Action

In the project navigation under the folder of the CPU you created, open the “Project blocks”.

Project tree

Devices
OO

- ] Frajektl

» [ Technolog
b [} External

arn infa

LA PLC alarms

E] Text lists

v Blocktitle: .

Comment

v f4MNetwork 1:  &larm 0o

Comment

ALARM_DQ
—_EN
p—
Lz}
EV_ID
CMP_ID RET_VAL
a0 EMC —

<Matags used-

2. Open a function block with a double click in which you would like to configure the ALARM_DQ
message or create a new function block and open it.
3 Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.
- |5Exten(le(l instructions
Name Description Version
» [] FrofiEnergy Vi
» (] Mac ran 20
» [ Interrupts /2.0
Reportup to eight sign... \. ()
Create PLC alarms wit [
Create PLC alarms wit [
Report a signal change V1.1
Create PLC alarms 11
Generate alarm m 1
Generate alarm m 1
Create PErmansn
ble PLC alarms V1.0
dynamically V10
Wynamically ass.. V1.0
- |Techno|ogy
4. Drag & drop the message block “ALARM_DQ” into an empty network of your FB.
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No. Action

5. In the block interface of the function block, declare the static variables the parameters of the
message block.

Please find the required parameters in the chapter Parameters of the ALARM_DQ message

block.
Wik F F g B Eg! e = &7
Interface
Narne Data type Offset Default value Wisible in ..
| <@~ Input
2 qqw sig Bool 0.0 false =]
3 a. EV_ID C_tlarm_s 20 =)
4 4w CMP_ID Dward =)
S <0 - Output
6 o= RET_VAL Int =)
7 4 = InOut
8 = Add new
9 40 - Static
10|qm= SO Werd Bl 20 0 =)
11 4@ « Temp

Note on the input “ID”

The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without
using an additional variable.

If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.

6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.

w Block title: ..

Comrment

- Network 1:

Comment

ALARM_DQ
—ENn
#5316 — 516
#16HEEEE — ID
HEV_ID — EV_ID
#CWP_ID — CMP_ID RET_VAL — #RET_VAL
#5D — 5D END =

w 56

#CMP_ID

Note

In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.

7. The configuration of the ALARM_DQ message in the function block is now complete.

Creating an instance data block

No. Action
8. Open an organization block (e.g. OB1) in your project.
9. Call the FB in your application program, for example in the OB1.
Then a dialog for creating the instance data block opens up.
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No. Action
w Block title:  "Main Fragram Sweep (Cycle)" Tall options “
Comment Ld
Data block
w 4 Network 1:  ALARM DO F Harne | sLaRM_DO_DE [~
Single () Manual
nstance —
BT (@) Autornatic
"ALARN_DG" The called function block saves its data in its own instance
N ENG b data block
—si& RET_VAL|

EV_ID

CMF_ID Mare

50

Mo tags used

10. Click on “OK?” to confirm.

Now, all the required parameters are automatically connected and a message number is cre-
ated. The message number is entered at the input “EV_ID” automatically.

w Block title:  "Wain Program Sweep (Cyle)"

Cornrment

- Network 1:  ALARM_DOQ

Camment

WDB1
"LLARK_DG_DE"
WFE1
"ALARN_DQ"
ENG
RET_VAL
1 CWP_ID
i — 5D
11. The instance data block is now created and is called by the organization block.

Configuring the message text of the ALARM_DQ message

No. Action

12. In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Project tree

Devices
OO

= ] Projekel

~ [l PLC_1 [CPU 418-3 PH/DF]

Iy o=

» @ Extarnal
r [dFLCta
» [ FLC data

08 Prograrn info
E] Textlists
3 rj] Local modules
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No.

Action

13.

Select the ALARM_DQ message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.
PLC alarms

Narne Type D Range Location WMeldetext Infotext Alarm class
1 [ ALARW_DQ  Alarm_s 1 ALARM_DQ_ g

P 7 o

< m »

‘g Properties ||:i..lnfo H % Diagnostics

General

General

Texts

Atributes

Hame Text
1 | Infotext &
2 Alarmn test &
3 Additional text 1 &'

e Under “Alarm texts” please enter the message text for the ALARM_S.

e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.

14.

In the inspector window, please open the tab “Properties > Properties > Attributes”.

|g Properties H'Li..lnfo H& Diagnostics |

J General ‘

General

Attributes

Texts

Attributes

[ report

Display class | o E
[w) with acknovdedgment [ %

Friarity | 0

Alarm class | <noe class

IR

Group D | ©

e Under “Alarm class”, please select “System_Acknowledgement”.

In Chapter 3.4, you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM_DQ.”

e Under “Priority”, choose a priority for the display of the ALARM_DQ.” The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM_DQ. Alarms that belong
to the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledge-
ment is possible. If you use alarm blocks without the possibility of an acknowledgement, this
option has not function.

15.

Right-click on the CPU in the project navigation.
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No. Action
16. Select “Compile > Software (rebuild all blocks)” in the context menu.
- ) EEE
PLC alar

Narne

N

3 3
Open 4
Openin new editor 5
» x cut Crlx @
* 1B copy ctrl+C 7 i
» U [0g Faste Ctrley 8 =
* 15 Delete Del 9| = Ne
D Renarme F2
»
<[]
4 -
Alarm ir

=]
—

et Hardware configuration
e 9

» 5 ctrlelc o

corlebt Software (rebuild all blocks)

ctrl+D

» [ onl §

v [ sy

Show foree values

17. Transfer the configuration into the PLC.
The configuration of the ALARM_DQ is now complete.

Displaying the Alarm_DQ in runtime

If you want to display the Alarm_DQ, an alarm display must have been configured

in your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.
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4.3.5

Configuration of alarm messages

An ALARM message is a PLC alarm that generates two messages after a signal

change (rising edge and falling edge) and sends them to all the participants in the
message procedure.
An associated value can be configured to an ALARM message which will be dis-
played in addition to the alarm text.

Parameters of the ALARM message block

Table 4-39

The following table shows all the parameters of the ALARM message block.

Parame-
ters

Declaration

Data type

Memory area

Description

EN_R

Input

BOOL

E,A M,D,Lor
constant

Control parameter enabled to receive
causes the outputs ACK_UP and
ACK_DN to be updated when the mes-
sage block is called (EN_R=1) or not
updated (EN_R=0). EN_R=0 means
that the output parameters ACK_UP
and ACK_DN remain unchanged.

SIG

Input

BOOL

E,AMD,L

The signal to be controlled.

Input

WORD

E,A M, D,Lor
constant

Data channel for the messages:
Wi#16#EEEE

EV_ID

Input

C_ALARM
(DWORD)

E,A M,D,Lor
constant

Message number (not allowed: 0)

EV_ID is only evaluated at the first call.
Afterwards, the message number used
for the first call is applicable for every
call of “ALARM” with the respective
instance DB.

The message number is assigned
automatically. This ensures the consis-
tence of the message numbers. The
message number must be unique
within the user program.

SEVERITY

Input

WORD

E,A M,D,Lor
constant

Weight of the event.

Possible values: 0 to 127 (value 0
means the highest weight)

This parameter is not relevant for proc-
essing the alarm.

DONE

Output

BOOL

E,A M,D,Lor
constant

Status parameter DONE:
Message generation completed.

ERROR

Output

BOOL

E,AMD,L

Status parameter: ERROR

ERROR=TRUE means that an error
occurred during editing. See "STATUS"
parameter for details.

STATUS

Output

WORD

E,AMD,L

Status parameter STATUS: Display
error information

ACK_DN

Output

BOOL

E,AMD,L

Event gone was acknowledged on a
display device.
Initialization status: 1
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Parame- Declaration Data type Memory area Description
ters
ACK_UP Output BOOL E,A, MD,L Event come was acknowledged on a

display device.
Initialization status: 1

SD i, Output BOOL (not | E,A,M,D, T, Z i-th associated value
1<i<10 allowed:
Bitfield),
BYTE,
CHAR,
WORD,
INT,
DWORD,
DINT,
REAL,
DATE,
TOD,
TIME,
S5TIME,
DATE_AN
D_TIME.

Note: When ANY-pointer accesses a
DB, the DB must always be specified.
(e.g.: P# DB10.DBX5.0 Byte 10)

Configuration in STEP 7 Professional

For the configuration of an ALARM message in STEP 7 Professional, proceed as
follows:

Creating a function block
Table 4-40

No. Action

1. In the project navigation under the folder of the CPU you created, open the “Project blocks”.

Project tree
Devices

OO

2. Open a function block with a double click in which you would like to configure the ALARM mes-
sage or create a new function block and open it.
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No. Action

3 Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.

~ |§Exten(le(l instructions

Narme Description Version

Reportup to eight sign. V1.0

Create PLC alarms wit.. V1.1
2 ALARM_SF Create PLC alarms wit.. W
2 HNOTIFY R

asignal change V11

t.. V11

ate PLC alarms

Generate alarm mes

Generate alarm mess

Create permanentl

Create acl

Determine the

Write a user diagn

Send archive data V1.1

Enable PLC alarms V10

e FLC alanms

- |Technn|ngy

4. Drag & drop the message block “ALARM” into an empty network of your FB.

w Block title:

Cormment

- Metwork 1:  Alarm

#ALARM Instance

Comment
AALARM_Instance
ALARM
—EN
FALSE == EN_R
FALDE mem S1G
VA1EXEEEE lx]
27 EV_ID
V16340 SEVERITY
s0_1
sp_2
sD_3
s0_4
sD_S DOMNE —
50_6 ERROR —
SD_7 STATLIS
sD_8 ACK_DH —
sD_9 ACK_UF —
sD_10 ENO —
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No. Action
5. In the block interface of the function block, declare the static variables the parameters of the
message block.
Please find the required parameters in the chapter “Parameters of the ALARM message block.
iinterface’
Narne Data type Offset Default value Visible in ..
140~ Input
2 . EM_FR Bool 0.0 false =)
3 |- 516 Eool 01 false =]
4 @ EV.ID € Alamm 20 =]
5 4= SEVERITY Ward 6.0 E
G 40 - Output
7 am = DONE Bool 8.0 false ]
8 @ " ERROR Boul 81 false =]
9 a= STATUS d 10 o =]
10 |an = ACK_DH 12 false =]
11 |am = ACK_UP Bl 12.1 false =]
12 40 » InOut
12 |40 = SO_, Werd 14.0 E
14 4 - Static
15 40 = » ALARM_Instance ALARM 160 E
16 40 « Temp
17 = Addd nes
Note on the input “ID”
The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without
using an additional variable.
If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.
6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.
» Block title: ..
- Metwork 1:  Alarm
HALARM _Instance
ALARM
.='!EII_P: : :_R
#5lG— 351G
#SEVERITY SEVERITY
s ERE sornor
s0_7 STATUS STATUS
Coom
Note
In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.
7. The configuration of the ALARM message in the function block is now complete.
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Creating an instance data block

No. Action
8. Open an organization block (e.g. OB1) in your project.
9. Call the FB in your application program, for example in the OB1.

Then a dialog for creating the instance data block opens up.

w Block title:  "Main Pragram Sweep (Cycle)”

Comment Camrsptione X
Diata block
v 4 Network 1:  ALARM e [ALARI_DE [+
Single ) Manual
o instance -
TEET @ Automatic
"ALARNT The called function block saves its data in its own instance
EN ENO data black
.= EN_FR DONEM .
—i5IG ERRCE
Ev_ID STATUS More.
SEVERITY ACK_DME ..
30_i ACK_UPH
QK 1 | Cancel
I ————
Mo tags used

10. Click on “OK?” to confirm.

Now, all the required parameters are automatically connected and a message number is cre-
ated. The message number is entered at the input “EV_ID” automatically.

w Block title:  "WMain Program Sweep (Cycle)”
Comment

- Network 1:  AL4RM

Comnment
%DE1T
“ALARNI_DE"
HFB1
"ALARM"
Ell ENO
false = EN_R DONE -4
false — 515 ERROR -
B#16%1 — EV_ID STATUS - .
0 — SEVERITY ACK_DHA .
S0_i ACK_UP 4

11.

Configuring the message text of the ALARM message

No. Action

12. In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Project tree

Devices
OO

= ] Projekel

[ PLC alarms

E] Textlists
3 rj] Local modules
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No. Action
13. Select the ALARM message you created, under the tab “PLC alarms” and in the inspector win-
dow, open the tab “Properties > General > Texts”.
B Pﬁ alarms
Mame Type I} Range Location Alarm text Info tex  Alarm clas
1 = Alarm Alarrn ALARLI & I &3 Syster
Alarm instances -
Mame  Type D Location Alarm text Info text
‘Q Properties “_A.. Info % Diagnestics
General
f:;;m‘ Texts
Attributes
1 ::Ttixt = e
2 Alarm text P
3 | Additional text 1 il
e Under “Alarm texts” please enter the message text for the ALARM_S.
e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.
14. In the inspector window, please open the tab “Properties > Properties > Attributes”.
|gPlopelties ”‘_i..lnfo Hi Diagnostics |
General
f:l” a Attributes
N _
Display class |0 - Report K
Friority |0 = [ With acknowledgment [
Alarm class | Systern_Acknowledgement (v
Group Ik | 0 -~
e Under “Alarm class”, please select “System_Acknowledgement”.
In Chapter 3.4, you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM message.

e Under “Priority”, choose a priority for the display of the ALARM message. The priority influ-
ences the display of the message in an alarm display. Alarms with a high priority come be-
fore alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM message. Alarms that
belong to the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledge-

ment is possible. If you use alarm blocks without the possibility of an acknowledgement, this

option has not function.
15. Right-click on the CPU in the project navigation.
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No. Action
16. Select “Compile > Software (rebuild all blocks)” in the context menu.
- ) EEE
PLC alar

Narne

N

3 3
Open 4
Openin new editor 5
» x cut Crlx @
* 1B copy ctrl+C 7 i
» U [0g Faste Ctrley 8 =
* 15 Delete Del 9| = Ne
D Renarme F2
»
<[]
4 -
Alarm ir

=]
—

et Hardware configuration
e 9

» 5 ctrlelc o

corlebt Software (rebuild all blocks)

ctrl+D

» [ onl §

v [ sy

Show foree values

17. Transfer the configuration into the PLC.
The configuration of the ALARM message is now complete.

Display of the alarm message in runtime

If you want to display the Alarm message, an alarm display must have been con-

figured in your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.
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4.3.6

Configuration of ALARM_8 messages

With an ALARM_8 message block, up to 8 signals can be monitored. Every single

signal can generate a partial message. After a signal change of at least one of the

8 signals (rising edge and falling edge), two partial messages are created for every
signal and they are sent to all the participants in the message procedure.

Parameters of the ALARM_8 message block

Table 4-41

The following table shows all the parameters of the ALARM_8 message block.

Parame-
ters

Declaration

Data type

Memory area

Description

EN_R

Input

BOOL

E,A M,D,Lor
constant

Control parameter enabled to re-
ceive causes the output
ACK_STATE to be updated when
the message block is called
(EN_R=1) or not updated (EN_R=0).

SIG |,
1<i<8

Input

BOOL

E,AMD,L

i-th signal to be monitored

Input

WORD

E,A M,D,Lor
constant

Data channel for the messages:
W#16#EEEE
ID is only evaluated at the first call.

EV_ID

Input

C_ALARM 8
(DWORD)

E,A M,D,Lor
constant

Message number (not allowed: 0)
EV_ID is only evaluated at the first
call.

Afterwards, the message number
used for the first call is applicable for
every call of “ALARM_8" with the
respective instance DB.

The message number is assigned
automatically. This ensures the con-
sistence of the message numbers.
The message number must be
unique within the user program.

SEVERITY

Input

WORD

E,A M,D,Lor
constant

Weight of the event.

Possible values: 0 to 127 (value 0
means the highest weight)

This parameter is not relevant for
processing the alarm.

DONE

Output

BOOL

E,AMD,L

Status parameter DONE:
Message generation completed.

ERROR

Output

BOOL

E,AMD,L

Status parameter: ERROR:
ERROR=TRUE means that an error
occurred during editing. See
"STATUS" parameter for details.

STATUS

Output

WORD

E,AMD,L

Status parameter STATUS: Display
error information
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Parame- Declaration Data type Memory area Description
ters
ACK_STA | Output WORD E,AMD,L Bitfield with the current acknowl-
TE edgement status of all 8 messages

(1: event acknowledged, 0: event not
acknowledge):

Bit 0 to 7 is represented on the event
come at SIG_1 to SIG_8.

Bit 8 to 15 is represented on the
event gone at SIG_1to SIG_8.
Initialization status: W#16#FFFF, i.e.
all the coming and going events are
acknowledged.

Configuration in STEP 7 Professional

For the configuration of an ALARM message in STEP 7 Professional and WinCC
Professional, proceed as follows:

Creating a function block
Table 4-42

No.

Action

In the project navigation under the folder of the CPU you created, open the “Project blocks”.

Project tree
Devices

OO

2 Main [0B1]

» [ Technolag,

b [} External
» L@ FLCtags

3 dat.

Open a function block with a double click in which you would like to configure the ALARM_8
message or create a new function block and open it.
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No.

Action

Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.

~ |§Exten(le(l instructions

Name

2 ALARM_SF

2 HNOTIFY

- |Technn|ngy

Description Version

Reportup to eight sign. V1.0
Create PLC alarms wat.. W11
Creats PLC alarms wit..
[

asignal change V11

t.. V11

ate PLC alarms

Generate alarm mes

Generate alarm mess

Create permanentl

Create acl

Determine the

Write a user diagn

Send archive data V1.1

Enable PLC alarms V10

e FLC alanms

Drag & drop the message block “ALARM_8" into an empty network of your FB.

¥ Block title:

Comment
- Network 1:  Alarm_s
Comment
HALARM_E_
Instance_1
ALARNI_E
— EN
FALSE = EN_R
FALSE == 351G _1
FALSE — 31G_2
FALSE == 51G_3
FALSE == 351G_4
FALSE mem S1G_5
FALSE == S1G_6&
FALSE = SIG_7 DOME —
FALSE == SIG_B ERROR —
\W#162EEEE o STATUS
EV_ID ACIK_STATE
V#1640 — SEVERITY EHO —

BALARM_B_Instance_1
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No.

Action

In the block interface of the function block, declare the static variables the parameters of the
message block.

Please find the required parameters in the section "Parameters of the ALARM_8 message
block".

KRS S EE%! CO‘;Q% == T

Interface
Narme Data type Offset  Defaultvalue  Visible in

1@« Input
2 an EILF Boal false =]
3 @ns S1G_i Baal o false =
4 |lq = EV_ID C_slarm_a 20 =]
5 @-n SEVERITY Ward 60 =
5 <@ w Output
7 @@= ©one Bool g0 false =]
E @@= ERROR Boal g1 false =]
9 @ STATUS Ward 10.0 0 =]
10 4@ = ACK_STATE ward 12.0 =]
11 <@ = InCut
12 . seld new
15 <@ v Static
14 <@ = b ALARM_8_Instance ALARN_S 14.0 =]
15 4 = Temp
] = Add new

Note on the input “ID”

The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without
using an additional variable.

If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.

Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.

» Block title: .

- Network 1:  Alarm_s

Cormment

#ALARN_G_

Instance
ALARM_8
—Ell
DOMNE — #DOMNE
ERROR — #ERROF
W/#1 G#EEEE — D STATUS — #5TATUS
#alarn_8 — EV_ID ACK_STATE — #ACK_STATE
#SEVERITY — SEVERITY ENO —

Note

In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.

The configuration of the ALARM_8 message in the function block is now complete.
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Creating an instance data block

No. Action
8 Open an organization block (e.g. OB1) in your project.
9 Call the FB in your application program, for example in the OB1.
Then a dialog for creating the instance data block opens up.
w Block title:  "Main Fragram Sweep (Cycle)"
Data black
v {3Network 1:  ALARM_E Hame [~Lr1_5_DE [+
Camment Murnber l:@
? () Manual
TFET @) Automatic
"ALARIM_B" The call=d function black saves its data in its swn instance
N ENoL—| data block
. =EN_R DONER
— 5161, ERROR
EV_ID STATUS | .. Mors
SEVERITY ACK_STATE
Mo tags used
w Block title:  "Main Fragram Sweep (Cycle)"
1 O Comment
- MNetwork 1:  sL4pn_8
Camment
WoF BT
"ALARM_B8"
EN ENC
faloe — EN_R DOME 4
falee = 516 ERROR 4
E#16#1 —EV_ID
SEVERITY
11 The instance data block is now created and is called by the organization block.

Configuring the message text of the ALARM_8 message

No.

Action

12.

In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Project tree

Devices
OO

= ] Projekel
P

-

¥ L3 Technolo
fee

» @i Extemal

r [dFLCta

» [ FLC data

[ PLC alarms

3 rj] Local modules
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No. Action

13. Select the ALARM_8 message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.

=R
PLC alarms
Hame Type [l Range Location Alarm text Info tex  Alarm cle
1w [ Alarm_g Alarm_g &3 &3 3
2 Subalarm 1 Alarm_8 I P 27 syste
3 SubAlarm 2 Alarm_8 &3 P P
4 SubAlarm 3 Alarm_g &3 £ £
B SubAlarm 4 Alarm_8 i) % %
6 SubAlarm 5 Alarm_S o Pl o3
7 Subalarm & Alar i) £5 £%
8 SubAlarm 7 Alarrm_8 &3 P P
9 SubAlarm 8 Alarm_8 &t P £ syst
<[m »
|E‘ Properties ||"A.. Info H % Diagnostics
General
General
Texts
Teits
Attributes
Name Text
1 | Info text e
2 | Alarm text o
3 Addiional text 1 &

e Under “Alarm texts” please enter the message text for the ALARM_S.

e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.

Note
Makes sure that every signal in an ALARM_8 block has a separate message text.
14. In the inspector window, please open the tab “Properties > General > Attributes”.
‘Q.Pmpelties H:i..lnfo HL Diagnostics |
General
General R
T Attributes
Priority |0 - [ [ with acknowledgment [
Alarm class | Systern_Acknowledgement |= | ¥
aroup 10 0 | |g¥

e Under “Alarm class”, please select “System_Acknowledgement”.

In Chapter 3.4 you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM_8."

e Under “Priority”, choose a priority for the display of the ALARM_8.” The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM_8. Alarms that belong to
the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledge-
ment is possible. If you use alarm blocks without the possibility of an acknowledgement, this
option has not function.

15. Right-click on the CPU in the project navigation.
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No. Action
16 Select “Compile > Software (rebuild all blocks)” in the context menu.
Devices
EHQ@O 2|28 =
PLC alar
w ] ProfessionalRT_57_400 Narne
B Add new device 1 = Ale
7 & netwarks 2 | (FaAk
3 | F AL
Open 4 = Al
Openin new editor 5 AL
MUY cu Ctrlax 8 = Al
* g copy ctilsC 7 = Al
» §[0g Faste ctrlay 8 e
* 15 Delets Del - =l
D Fename F2
»
(<[ w]
: Alarm ir
v Al
] Hardware canfiguration
» 5 ctrlek .
» g on| § Ctrl+D
v [ sy
Show force values
17 Transfer the configuration into the PLC.
The configuration of the ALARM_8 is now complete.

Displaying the Alarm_8 in runtime

If you want to display the Alarm_8, an alarm display must have been configured in

your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.
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4.3.7

Configuration of ALARM_8P messages

With an ALARM_8P message block, up to 8 signals can be monitored. Every single
signal can generate a partial message.
After a signal change of at least one of the 8 signals (rising edge and falling edge),
two partial messages are created for every signal and they are sent to all the par-

ticipants in the message procedure.

An associated value can be configured to an ALARM_8P message which will be
displayed in addition to the alarm text.

Parameters of the ALARM_8P message block
The following table shows all the parameters of the ALARM_8P message block.

Table 4-43

Parame-
ters

Declaration

Data type

Memory area

Description

EN_R

Input

BOOL

E,A M,D,Lor
constant

Control parameter enabled to
receive causes the output
ACK_STATE to be updated
when the message block is
called (EN_R=1) or not up-
dated (EN_R=0).

Input

BOOL

E,AMD,L

i-th signal to be monitored

Input

WORD

E,A M,D,Lor
constant

Data channel for the mes-
sages: W#16#EEEE

ID is only evaluated at the first
call.

EV_ID

Input

C_ALARM 8P
(DWORD)

E,A M,D,Lor
constant

Message number (not al-
lowed: 0) EV_ID is only
evaluated at the first call.
Afterwards, the message
number used for the first call
is applicable for every call of
“ALARM_8” with the respec-
tive instance DB.

The message number is as-
signed automatically. This
ensures the consistence of
the message numbers. The
message number must be
unique within the user pro-
gram.

SEVERITY

Input

WORD

E,A M, D,Lor
constant

Weight of the event.

Possible values: 0 to 127
(value 0 means the highest
weight)

This parameter is not relevant
for processing the alarm.

DONE

Output

BOOL

E,AMD,L

Status parameter DONE:

Message generation com-
pleted.
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Parame-
ters

Declaration

Data type

Memory area

Description

ERROR

Output

BOOL

E,AMD,L

Status parameter: ERROR:
ERROR=TRUE means that an
error occurred during editing.
See "STATUS" parameter for
details.

STATUS

Output

WORD

E,AMD,L

Status parameter STATUS:
Display error information

ACK_STA
TE

Output

WORD

E,AMD,L

Bitfield with the current ac-
knowledgement status of all 8
messages (1: event acknowl-
edged, 0: event not acknowl-
edge):

Bit 0 to 7 is represented on
the event come at SIG_1 to
SIG_8.

Bit 8 to 15 is represented on
the event gone at SIG_1 to
SIG_8.

Initialization status:
Wi#16#FFFF, i.e. all the com-
ing and going events are
acknowledged.

SD |,
1<j<8

Input/Output:

BOOL (not al-
lowed: Bitfield),
BYTE, CHAR,
WORD, INT,
DWORD, DINT,
REAL, DATE,
TOD, TIME,
S5TIME,
DATE_AND_TIME

E,AMD,L

j-th associated value

The associated values are
applicable for all messages.
Note: When ANY-pointer
accesses a DB, the DB must
always be specified (e.g.:

P# DB10.DBX5.0 Byte 10).
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Configuration in STEP 7 Professional
For the configuration of an ALARM_8P message STEP 7 Professional, proceed as

follows:
Creating a function block
Table 4-44
No. Action
1. In the project navigation under the folder of the CPU you created, open the “Project blocks”.
Devices
EHOO

~ [ PLC_1[CPU 41
Iy Davic
% Online & diagnostics
Jregmion: |
& ~dd new black
2 Main [0B1]
» [ Tech
b [} External
» L@ FLCtags

CAPLE alarms
E] Text lists
2. Open a function block with a double click in which you would like to configure the ALARM_8P
message or create a new function block and open it.
3 Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.
- |5Exten(le(l instructions
Name Description Version

» [] FrofiEnergy Vi

Reportup to eight sign... V1.0
Create PLC alarms wit Vi

Create PLC alarms wit V1
P
Create PLC alarms vt V1.1

it asignal change V1.1

Generate alarm mess

Generate alarm m:

Create permanentl

Determine the ack
J auserdiagnaostc.. V1.0

Send archive data VI

Enable FLC alarms

1

PLC alarrns V1.0

narnicall 1
1

lynamically ass... V1.0

~ [ Technology
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No. Action
4 Drag & drop the message block “ALARM_8P” into an empty network of your FB.
w Block title: ...
Carnmeant
- Network 1:  Alarm_gp
Comment
#ALARM_BP_
Instance
ALARM_BP
— EN

FALSE == EN_R

FALSE == SIG_1

FALGE—SIG_ 2

FALGE mem GlG_3

FALSE = S1G_4

FALOE = SIG_S

FALGE mmm GlG_G

FALOE = SlG_7

FALOE = SIG_8

WA162EEEE 1=}
EV_ID
V3 E240 — SEVERITY
SD_
sD_2
SD_3
S0 4
SD_5
S0_6 DOME —
s0_7 ERROR —
s0_8 STATUS
50_9 ACI_STATE
sD_10 END —
B2LARNM_SF_Instance
5 In the block interface of the function block, declare the static variables the parameters of the

message block.

Please find the required parameters in the chapter “Parameters of the ALARM_8P message
block.

¢ AEEE@EE 63 == & T

WX =

Name Data type Offset  Defaultvalue | Visible in
| @ v Input
2 | EN_R EBool 0.0 false =]
3 @n S1G_i Baal o false =
4 |lq = EV_ID C_slarm_ap 20 =]
5 @-n SEVERITY Ward 60 =
5 <@ w Output
7T oan DONE 8.0 false =]
E @@= 8.1 false =]
9 @ 10.0 0 =]
10 @ = 12.( =2
11 <@ = InCut
12 < = S0 Ward 14.0 =]
15 <@ v Static
14 4@ = b ALARM_BF Instance  ALARM_BP 16.0 =]
15 4 = Temp
] = Add new

Note on the input “ID”

The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without
using an additional variable.

If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.
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No. Action
6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.
» Block title:

- Network 1:  2larm_sP

Comment

HALARM_SF_
Instance
ALARNM_BP
— Nl
#EN_R — EN_R
H#'31G_," — 31G_1
FALSE mem 51G_2
FALSE == SIG_3
FALSE = S1G_4
FALSE mem 51G_5
FALSE == 51G_6
FALSE = S1G_7
FALSE mem S1G_%
V#164EEEE (e}
#alarn_8F — EV_ID
ASEVERITY SEVERITY

sSD_& DONE — #DONE
s0_7 ERROR — ZERROR
s50_8 STATUS ASTATUS
sD_9 ACK_STATE AACE_STATE
s0o_10 ENG =

Note

In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.

7. The configuration of the ALARM_8P message in the function block is now complete.

Creating an instance data block

No. Action
8 Open an organization block (e.g. OB1) in your project.
9 Call the FB in your application program, for example in the OB1.
Then a dialog for creating the instance data block opens up.
w Block title:  "Main Program Sweep (Cycle)"
Data block
~ 4 Network 1:  ALARK_SP FEGS [ALARM_gF_DE ]
Cormment - l:@
imstonce () Manual
e _ @ Automatic
LG ik e oo i ey s e o s - e
EN ENO data black
—EN_F DOMER
- S1a_l ERRORH
EvV_ID STATUS Maors
SEVERITY ACK_STATE
S0
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No. Action

10. Click on “OK?” to confirm.

ated. The message number is entered at the input “EV_ID” automatically.
w Block title:  "Main Fragram Sweep (Cycle)”

Comment

- Network 1:  AL&RM_BP

Comment

Now, all the required parameters are automatically connected and a message number is cre-

%DE1
"LLARM_SF_DE"
%WFB1
"ALARM_SF"
ENC
DOME =
ERROR =
STATUS
] SEVERITY ACK_STATE
S0
1. The instance data block is now created and is called by the organization block.

Configuring the message text of the ALARM_8P message

No. Action

Project tree

Devices
OO

= ] Projekel

B ~dd nev

o Devices & net

~ [ PLC_1 [CPU 47

» L Local redules

12. In the project navigation under the folder of the CPU you created, open the “PLC alarms”.
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No.

Action

13.

Select the ALARM_8P message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.

w Block title:  "Main Frogram Sweep (Cycle)"

Cornrment

> {3Network1: .. i
Commeznt G Gptians —— =3

Data block

’ F Harne |AL4F1_gF_DE =]
BB | wwe [ 7]

sl ARI_BF" =
EN ENO CIManel

e DonEh
—GIG_I, ERROR - The called function black saves its data in its own instance
Alarm_gF STATUS Hatab Dec
SEVERITY ACK_STATE
5o

single

instance

(@) Autarnatic

Mare

Ho tags used

- Network 2: .

Comment

e Under “Alarm texts” please enter the message text for the ALARM_S.

e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.

Note
Makes sure that every signal in an ALARM_8P block has a separate message text.

14.

In the inspector window, please open the tab “Properties > Properties > Attributes”.

Call options X

Data block
F Harne ALARM_BP_DH -
BB | wener | 7]

() manual

Single
instance

@® Automatic

The callzd function block saves its data in its own instance
data block

Mare ..

e Under “Alarm class”, please select “System_Acknowledgement”.
In Chapter 3.4, you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the ALARM_8P.”

e Under “Priority”, choose a priority for the display of the ALARM_8P.” The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the ALARM_8P. Alarms that belong
to the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledge-
ment is possible. If you use alarm blocks without the possibility of an acknowledgement, this
option has not function.

15.

Right-click on the CPU in the project navigation.
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No. Action
16. Select “Compile > Software (rebuild all blocks)” in the context menu.
- ) EEE
PLC alar

Narne

N

3 3
Open 4
Openin new editor 5
» x cut Crlx @
* 1B copy ctrl+C 7 i
» U [0g Faste Ctrley 8 =
* 15 Delete Del 9| = Ne
D Renarme F2
»
<[]
4 -
Alarm ir

=]
—

et Hardware configuration
e 9

» 5 ctrlelc o

corlebt Software (rebuild all blocks)

ctrl+D

» [ onl §

v [ sy

Show foree values

17. Transfer the configuration into the PLC.
The configuration of the ALARM_8P is now complete.

Displaying the Alarm_8P in runtime

If you want to display the Alarm_8P, an alarm display must have been configured

in your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.
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4.3.8 Configuration of NOTIFY messages

A NOTIFY message is a PLC alarm that generates two messages after a signal
change (rising edge and falling edge) and sends them to all the participants in the
message procedure.

An associated value can be configured to a NOTIFY message which will be dis-
played in addition to the message text.

Parameters of the NOTIFY message block

The following table shows all the parameters of the NOTIFY message block.
Table 4-45

Parame- Declaration Data type Memory area Description
ters

SIG Input BOOL E,AMD,L The signal to be controlled.

ID Input WORD E,A M, D,Lor Data channel for the mes-
constant sages: W#16#EEEE

ID is only evaluated at the
first call.

EV_ID Input C_NOTIFY E,A, M, D,Lor Message number (not al-
(DWORD) constant lowed: 0)

EV_ID is only evaluated at
the first call. Afterwards, the
message number used for
the first call is applicable for
every call of “NOTIFY” with
the respective instance DB.

The message number is
assigned automatically. This
ensures the consistence of
the message numbers. The
message number must be
unique within the user pro-
gram.

SEVERITY | Input WORD E,A M, D,Lor Weight of the event.

constant Possible values: 0 to 127
(value 0 means the highest
weight)

This parameter is not relevant
for processing the alarm.

DONE Output BOOL E,AMD,L Status parameter DONE:
Message generation com-
pleted.

ERROR Output BOOL E,A,MD,L Status parameter
ERROR=TRUE means that
an error occurred during
editing. See "STATUS" pa-
rameter for details.

STATUS Output WORD E,AMD,L Status parameter STATUS:
Display error information
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Parame- Declaration Data type Memory area Description
ters

SD i, Input/Output: | BOOL (not al- E,AMDT,Z i-th associated value

1<i<10 lowed: Bitfield),
BYTE, CHAR, Note: When ANY-pointer
WORD, INT, accesses a DB, the DB must
DWORD, DINT, always be specified.
REAL, DATE, (e.g.: P# DB10.DBX5.0
TOD, TIME, Byte 10)
S5TIME,
DATE_AND_TIME.

Configuration in STEP 7 Professional

For the configuration of an NOTIFY message in STEP 7 Professional, proceed as
follows:

Creating a function block

Table 4-46

No. Action

1. In the project navigation under the folder of the CPU you created, open the “Project blocks”.

Project tree
Devices

2. Open a function block with a double click in which you would like to configure the NOTIFY mes-
sage or create a new function block and open it.
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No.

Action

3 Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.

- |5Exten(le(l instructions

Mame

» [] FrofiEnergy

2 ALARM_BF
& HOTIFY

- |Techno|ogy

Description Version
V11
V3.0

artup to eight sign... V1.0

Create PLC alarms wit Vi
Create PLC alarms wit Cal
Report @ signal changs V1.1

Create PLC alarms vt V1.1

Generate alarm mes V10

Generate alarm mess 1.0

Create permangntl 1.0

Create acl a 10

Determine the w.. V1.0
Witz a user diagn 1.0

Enable FLC alarms V1.0

= PLC alarrns V1.0

dynamically V10

dynarmically

4. Drag & drop

¥ Block title:

Corament

BNOTIFY _Instance

the message block “NOTIFY” into an empty network of your FB.

- Network 1:  notify
Camment
ZNOTIFY_Instance
NOTIFY
—EN
FALSE = SIG
VA1 GHEEEE o
EV_ID
VA1 ER40 SEVERITY
SD_
so_2
S0_3
SD_4
S0_5
SD_6
sh_7 COME —
sD_8 ERROR —
sD_9 STATUS
sSp_1o END —
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No. Action

5. In the block interface of the function block, declare the static variables the parameters of the
message block.

Please find the required parameters in the chapter “Parameters of the NOTIFY message block®.

s AEDBLEEN €63 = &=

Data type Offset  Defaultvalue | Visible in
| @ v Input
2 @n 315 Boal 0.0 false =]
3 @. EV_ID C_Matify 20 =
4 @a-= SEVERITY word 6.0 )]
5 <@ w Output
6 @@= DONE Boal 80 false =]
7 @ ERROR Boal g1 false =]
8 @= STATUS Ward 100 0 )]
9 <@~ Inout
10 . 4ddl ne
11 <@ « Stahc
12 <0 = » NOTIFYV_Instance HOTIFY 12.0 @
13 <@ = Temp
14 . Adlel new

Note on the input “ID”

The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without
using an additional variable.

If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.

6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.

» Block title: .

- Network 1:  Hotify

Camment

HMOTIFY_Instance
HOTIFY
—EN
#5165 — SIG
D
EV_ID
SEVERITY
50_1
50_2
503
504
505
50_6
50_7 DOMNE — #DONE
508 ERROR = HERROR
50_9 STATUS — #STATUS
50_1 EHO —

Note

In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.

7. The configuration of the NOTIFY message in the function block is now complete.

Creating an instance data block

No. Action

8. Open an organization block (e.g. OB1) in your project.
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No. Action
9. Call the FB in your application program, for example in the OB1.
Then a dialog for creating the instance data block opens up.
< GIRGSEER D R ETee (P CaIrBptians —————————
Cormment Data hlock
¥ 3 Network 1:  NOTIFY tiams [nomey_oe [-]
mamber [ TF]
instance () b
. — (@) Autematic
"NgTTIjY" The called function black saves its data in its own instance
data block.
EN ENG
=56 DONER
EV_ID ERRORH R
SEVERITY STATLS -
e tags used
10. Click on “OK?” to confirm.
Now, all the required parameters are automatically connected and a message number is cre-
ated. The message number is entered at the input “EV_ID” automatically.
w Block title:  "Main Fragram Sweep (Cycle)”
Camment
- Metwork 1:  HOTIFY
Carmmant
%DE1
"HOTIFY_DE"
WFET
"MOTIFY"
EN ENO
false <516 DONEA
Bx1&31 Ev_ID ERROFR -
SEVERITY STATUS
11. The instance data block is now created and is called by the organization block.
Configuring the message text of the NOTIFY message
No. Action
12. In the project navigation under the folder of the CPU you created, open the “PLC alarms”.
Devices
0O
- ] Projektl

» @ Extarnal
r [dFLCta
» [ FLC data

08 Prograrn info
E] Textlists
3 rj] Local modules
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No. Action
13. Select the NOTIFY message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.
PLC alarms
Narne Type D Range Location Alarm text Info tex | Alarm c
1 = Motity Hestify HOTIFY i e e
|§.Plopelties ||1i..lnfo Hi Diagnostics
General
f:;:m‘ Texts
Attributes
1 I:W::‘tz!t = Pl
2 | Alarm text Pl
3 | additional text 1 Pl
e Under “Alarm texts” please enter the message text for the ALARM_S.
e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.
14. In the inspector window, please open the tab “Properties > Properties > Attributes”.
‘gPlupelties H"_i..lnfo ||L Diagnostics |
General
f::ral Attributes
w _
Display class | - Report K
Friority | 0 = [ With acknawledgment [ ¥
Alarm class | System_Acknowledgement =
Group D | © -
e Under “Alarm class”, please select “System_Acknowledgement”.
In Chapter 3.4, you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the NOTIFY message.

e Under “Priority”, choose a priority for the display of the NOTIFY message. The priority
influences the display of the message in an alarm display. Alarms with a high priority come
before alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the NOTIFY message. Alarms that
belong to the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledge-

ment is possible. If you use alarm blocks without the possibility of an acknowledgement, this

option has not function.
15. Right-click on the CPU in the project navigation.

Messages in WinCC (TIA Portal)
V1.0, Entry ID: 62121503

170




4 Configuration of messages in WinCC Professional

Copyright © Siemens AG 2012 All rights reserved

No. Action
16. Select “Compile > Software (rebuild all blocks)” in the context menu.
PLC alar
Harne

w ] Frofess
B~
&

E E LC_1 [CPU 416-3 FN."DP]

Open

Openin new editor 5

M ocut Ctrlex
B copy ctrl+C
g Faste Ctrley

¥ Delete Del
Renarme F2

[ ]
Alarm ir
Al
quration
| § Softy
8| ¥ o Software (rebuild all blocks)
» [ On| G Online & diagnostics Ctrl+D

v [ sy Receive alarmns
Show foree values

17. Transfer the configuration into the PLC.
The configuration of the NOTIFY message is now complete.

Display of the NOTIFY message in runtime

If you want to display the NOTIFY message, a message display must have been
configured in your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure
alarm display”.

4.3.9 Configuration of NOTIFY_8P messages

With a NOTIFY_8P message block, up to 8 signals can be monitored. Every single
signal can generate a partial message.

After a signal change of at least one of the 8 signals (rising edge and falling edge),
two partial messages are created for every signal and they are sent to all the par-
ticipants in the message procedure.

An associated value can be configured to an NOTIFY_8P message which will be
displayed in addition to the alarm text.

Parameters of the NOTIFY_8P message block
The following table shows all the parameters of the NOTIFY_8P message block.

Table 4-47
Parame- Declaration Data type Memory area Description
ters
SIG_j, Input BOOL E,AMD,L i-th signal to be monitored
1<i<8
ID Input WORD E,A M, D,Lor Data channel for the mes-
constant sages: W#16#EEEE
ID is only evaluated at the
first call.
EV_ID Input C_NOTIFY_8P E,A MD,Lor Message number (not
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Parame- Declaration Data type Memory area Description
ters
(DWORD) constant allowed: 0)
EV_ID is only evaluated at
the first call. Afterwards,
the message number used
for the first call is applicable
for every call of
“‘NOTIFY_8P” with the
respective instance DB.
The message number is
assigned automatically.
This ensures the consis-
tence of the message
numbers. The message
number must be unique
within the user program.

SEVERITY | Input WORD E,A M, D,Lor Weight of the event.

constant Possible values: 0 to 127
(value 0 means the highest
weight)

This parameter is not rele-
vant for processing the
alarm.

DONE Output BOOL E,A,MD,L Status parameter DONE:
Message generation com-
pleted.

ERROR Output BOOL E,AMD,L Status parameter
ERROR=TRUE means that
an error occurred during
editing. See "STATUS"
parameter for details.

STATUS Output WORD E,AMD,L Status parameter STATUS:
Display error information

SD i, Input/Output: | BOOL (not allowed: E,AMDT,Z i-th associated value

1=i<10 Bitfield), BYTE,

CHAR, WORD, INT, Note: When ANY-pointer
DWORD, DINT, accesses a DB, the DB
REAL, DATE, TOD, must always be specified.
TIME, S5TIME, (e.g.: P#DB10.DBX5.0
DATE_AND_TIME Byte 10)

BOOL (not allowed:

Bitfield), BYTE,

CHAR, WORD, INT,

DWORD, DINT,

REAL, DATE, TOD,

TIME, S5TIME,

DATE_AND_TIME

Configuration in STEP 7 Professional

For the configuration of an NOTIFY_8P message in STEP 7 Professional and
WinCC Professional, proceed as follows:

Creating a function block
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Table 4-48
No. Action
1. In the project navigation under the folder of the CPU you created, open the “Project blocks”.

Project tree

Devices
OO

- ] Frajektl

2 Main [0B1]
» [ Techn
b [} External
» L@ FLCtags

sgrarn info
PLC alarms

E] Text lists
2. Open a function block with a double click in which you would like to configure the NOTIFY_8P
message or create a new function block and open it.
3 Under the task card “Instructions > Extended Instructions”, open the folder “Alarming”.
- |5Exten(le(l instructions
Name Description Version
» [] FrofiEnergy Vi
» L Ile paramet. V30
» [ V3.0
g
B NOTIFY_EP Reportup to eight sign... V1.0
B ALARN_E e PLC alarms wit
2 ALARM_BF ite FLC alarms wit

1

1

1
art a signal change V1.1
e PLC alarms wit.. V1.1
Generate alarm mess 1
Generate alarm me 1
Create perrmanently

Create ack

1

PLC alarrns V1.0

ynarnically 1
1

dynamically ass. V1.0

» [7] Table V3.0

~ [ Technology
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No.

Action

Drag & drop the message block “NOTIFY_8P” into an empty network of your FB.

w Block title:

Comrment

- Metwork 1:  notify_SP

Camment

#HOTIFY_8F_
Instance
HOTIFY_8P
—El
FALSE = S1G_1
FALSE = 51G_2
FALOE mem 51G_3
FALSE = 51G_4
FALSE = 51G_S
FALDE mem 51G_G
FALSE = S1G_7
FALSE == 51G_8
WHTG2EEEE D
EV_ID
#16440 SEVERITY
so_1

SO,
S0_4

SD_S

SD_6

SD_7 DONE —
sD_8 ERROR —
5D_9 STATUS
50_10 ENO —

#NOTIFY_8F_Instance

In the block interface of the function block, declare the static variables the parameters of the
message block.

Please find the required parameters in the chapter “Parameters of the NOTIFY_8P message
block.

iy B =8 E

Interface’

[EEE B == @ T

Marmne Data type Offset Detfault value Visible in ...
1 <@ - Input
2 a@an- SIG_I Eaal 00 false
3 @ s EV_ID
4 4@ SEVERITY Word
S < - Output
6 = LONE
a
10

false

@ o

. ERROR.
= STATUS
< w InCut

DD DE®

false

L} Add new
11 <@ - Static
12 <@ = » NOTIFY_SF_Instance HOTIFY_8F 120
15 <@ ~ Temp
14 = Add new

]

Note on the input “ID”

The input “ID” for the data channel of the alarm messages must be assigned with the value
“W#16#EEEE”. In this sample configuration the value is directly written at the input without
using an additional variable.

If you have set a static variable for the input “ID”, enter the value “W#16#EEEE” as the default
value of the variable.
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No. Action
6. Connect the variable you set with the inputs and outputs of the message block.
Then enter the value “W#16#EEEE” at the input “ID” of the message block.
» Block title: ..
- Network 1:  totify_SF
#NOTIFY_8F_
Instance
— EN -
el
e
sveczz N
#hlotify_8F — EV_ID
— T
s
SD_5
DOMNE — #DONE
ERROR = ZERROR
Note
In this sample configuration, the input “ID” is directly filled with the value of the data channel for
the alarm message. Please also take the note under number 5 of the table into account.
7. The configuration of the NOTIFY_8P message in the function block is now complete.
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Creating an instance data block

instance

WFE1

"NOTIFY_8F"
EN
—Isi6_i
EV_ID
SEVERITY

END
DOME
ERROR|
STATUS

Mo tags used

The called function black saves its data in its awn instance

data block.

Mare.

@) Autormatic

No. Action
8. Open an organization block (e.g. OB1) in your project.
9. Call the FB in your application program, for example in the OB1.
Then a dialog for creating the instance data block opens up.
w Blocktitle:  "Main Fragram Sweep (Cycl=)" m
Comment Data block
~ (3 Network 1:  1OTIFV_8F ' Mame  [HOTIFY_sF_DE [~
Cormrment [o]:] Hurmnber l:@
Single O Wanual

10. Click on “OK?” to confirm.

w Block title:  "Main Program Sweep (Cycle)"

Comment

- Network 1:  NOTIFY_sP

Camment

Now, all the required parameters are automatically connected and a message number is cre-
ated. The message number is entered at the input “EV_ID” automatically.

%DB1
“MOTIFY_SF_DE"
WFET
"HOTIFY_&F"
ENl END
false < 51G_i DOMEMA
EZ1641 EvV_ID ERFOR -
SEVERITY STATUS
11. The instance data block is now created and is called by the organization block.

Configuring the message text of the NOTIFY_8P message

No.

Action

arn
[ PLC alarms

E] Textli
3 rj] Local modules

12. In the project navigation under the folder of the CPU you created, open the “PLC alarms”.

Project tree

Devices
OO
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No.

Action

13.

Select the NOTIFY_8P message you created, under the tab “PLC alarms” and in the inspector
window, open the tab “Properties > General > Texts”.

PLC alarms

Narne Type o] Range Location Alarrn text Info tex  Alarr cl
1 = (= Motify_8P HNatity_sp HOTIFY_SP i
2 Subslarm 1 Matify_Sp HOTIFY_8F o
Subslarm 2 Matify_gp HOTIFY_EF
SubAlarm 3 Mot HOTIFY_8F
ap MNOTIFY_8F
ap HNOTIFY_SF

o

e

)

\’1\\ Lt
T

o
ok

¥
¥

o,
k

Subhlarm 4 Mot

"y ¥
w

SubAlarm 5 Mot

¥
¥

&
)

Subslarm & Matify_Sp HNOTIFY_8F

sp HOTIFY_8F

¥
¥

© @ e s W
wlh
5]

SubAlarm 7 Mot

¥
¥

Subslarm &  Matify_Sp HOTIFY_8F

o
i

¥
¥

<[ m ¥

|3 Properties ”'3.. Info " L Diagnostics

General

General

Texts

Texts
Attributes
Mame Text
1 Info text &

Alarm text &

r

3 additional text 1 Pl

e Under “Alarm texts” please enter the message text for the ALARM_S.

e Optionally, you a "Tooltip” to this message can be configured under “Info text”.
With a tooltip you can provide the system operator with further information and instructions
in addition to the alarm text.

Note
Makes sure that every signal in an NOTIFY_8P block has a separate message text.

14.

In the inspector window, please open the tab “Properties > General > Attributes”.

|gPro|)elties H"j..lnfo Hi[}laqnostlrs |

General

General

Attributes

Texts

Attributes

Friarity | 0 ~| [ [ with acknowledgment [
Alarm class | Systermn_Acknowlsdgement |w | |2

Graup D | o ||

e Under “Alarm class”, please select “System_Acknowledgement”.
In Chapter 3.4, you will find more detailed information about alarm classes.

e Under “Display class”, choose a display class for the display of the NOTIFY-8P message.

e  Under “Priority”, choose a priority for the display of the NOTIFY_8P. The priority influences
the display of the message in an alarm display. Alarms with a high priority come before
alarms with a low priority.

e Under “Group ID”, choose an ID for the assignment of the NOTIFY_8P. Alarms that belong
to the same ID can be acknowledged together.

e If you want to print the alarm on a standard printer, please activate the option “Report”.
When the alarm comes, it will then be output on the standard printer of the control panel

Note on the option “with acknowledgement"

Deactivating the acknowledgement only influences message blocks where an acknowledge-
ment is possible. If you use alarm blocks without the possibility of an acknowledgement, this
option has not function.

15.

Right-click on the CPU in the project navigation.
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No. Action
16. Select “Compile > Software (rebuild all blocks)” in the context menu.
Devices
PLC alar
Harne
1 = Al
2 » 3R
alr 5
4
Openin new editor 5
MUY cu Ctrlax 6
* 1B copy ctrl+C 7
» U [0g Faste ctrley g
* 5% Delets Del ol
D Fename F2
4 - -
- - ) Alarm ir
o o device L3
G & Ctrl+k
culah
s )
17. Transfer the configuration into the PLC.

The configuration of the NOTIFY_8P message is now complete.

Display of the NOTIFY_8P message in runtime.

If you want to display the NTIFY_8P message, an alarm display must have been
configured in your project.

You will find all the information concerning the configuration and setting of an alarm
display in the WinCC Professional under system manual, under the title “Configure

alarm display”.
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4.3.10 Additional information concerning PLC alarms

In this chapter, you will find more detailed information about the configuration of
PLC alarms.

Triggering PLC alarms

A PLC alarm (for example an ALARM_S message) is triggered by the signal of the
tag that was configured at the input “SIG” of the message block.

Once the signal is set, the next call of the message block in the user program trig-
gers the respective PLC message.

If you use a message block with several possible signal sources (e.g. an ALARM_8
message block), one of these signals is sufficient to trigger the alarm.

Acknowledgement of a PLC alarm

A PLC alarm (e.g. ALARM_SQ message) is acknowledged directly in the control
panel. If a PLC message that needs to be acknowledged is pending at the control
panel, it has to be acknowledged by means of the acknowledgement button in the
message display.

The information concerning the acknowledgement is only sent to the PLC which
triggered the alarm. Then the PLC sends the information about the acknowledge-
ment to all the participants in the message procedure.
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4.4

Using alarm classes in WinCC Professional

During the operation of the system, alarms of various priorities occur. These mes-
sages are categorized in different alarm classes depending on their importance.

The system operator can see which messages have a higher priority and impor-
tance and must be handled first.

Function of the alarm classes

Note

When new messages are created, every message must be assigned to an alarm
class.

The alarm class defines
o the display

o the acknowledgement concept (single acknowledgement, double acknowl-
edgement, alarm annunciator)

o the storage
of a message assigned to an alarm class

The scope of functions of the alarm classes depends on the configured control
panel used.

Types of messages classes

WinCC (TIA Portal) provides the following types of alarm classes.

¢ Pre-defined alarm classes

You will find pre-defined alarm classes on the tab “Alarm classes” under “HMI
alarms” in the project tree. The alarm classes cannot be deleted and can only be
edited in part.

e User-defined alarm classes

For every control panel, you can add more alarm classes on the tab “Alarm
classes” under “HMI alarms” in the project tree. In these alarm classes the display
and the acknowledgement concept of the respective message can be configured
individually.

e Project-wide alarm classes

Project-wide alarm classes can be used on all the control panels in the whole pro-
ject. These alarm classes are displayed in the project tree under “Common Data” >
“Alarm classes” and new project-wide alarm classes are configured there.

Messages in WinCC (TIA Portal)
V1.0, Entry ID: 62121503 180



Copyright © Siemens AG 2012 All rights reserved

4 Configuration of messages in WinCC Professional

4.5

Using alarm groups in WinCC Professional

During system operation, messages concerning different processes and sections
occur. In order to organize these message to get a better overview (for example
depending on the sector of the system), you can classify these messages in alarm
groups.

Types of alarm groups

WinCC (TIA Portal) provides the following types of alarm groups.

e User-defined alarm groups

User-defined alarm groups are created when needed. These alarm groups contain
messages that need to be acknowledged and can contain further alarm sub-
groups. Alarm sub-groups can be organized hierarchically with up to five sub-
groups.

¢ Alarm groups from alarm classes

For every pre-defined alarm class, an alarm group has been created in WinCC Pro-
fessional. These alarm groups are called class groups. All the alarms of these
alarm classes are also contained in the respective class groups.

Scope of functions of alarm groups in WinCC Professional

Purpose

In WinCC Professional, an alarm group contains several tags. These tags address
the features of all messages assigned to this alarm group. If settings are made in
an alarm class, the settings in the respective alarm group are automatically up-
dated.

The use of alarm groups is recommended for:

e combining alarms with the same cause.

e combining similar messages.

e monitoring and sorting alarms from one section of the system.
e monitoring and sorting alarms that are part of a process.

¢ handling alarms from one part of the system together (e.g. acknowledgement,
blocking, display suppression).

e visualizing states of system sections.
e preventing the processes of the system (e.g. by acknowledging the alarm).
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4.6

4.6.1

The acknowledgement concepts in WinCC Profes-
sional

Define the acknowledgement concept for an alarm class. All the messages that are
part of this alarm class will then be acknowledged according to the same concept.

In WinCC Professional there are the following acknowledgement concepts, distrib-
uted in more sub-concepts.

e message with acknowledgement
e message with a single acknowledgement
e message with double acknowledgement

In the following chapter, the acknowledgement concepts are explained in greater
detail.

Message with acknowledgement
After a message without acknowledgement, the operator does not necessarily have

to react to the message. The message comes and goes without an acknowledge-
ment being necessary.

Alarm without status “gone” without acknowledgement

As long as the event that triggered the alarm is pending, the alarm remains pend-
ing. If the event that triggered the alarm is gone, the alarm will not be displayed any
more. The alarm will be archived and does not have to be acknowledged.
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4.6.2 Message with a single acknowledgement

The message is caused by an event.

The message is displayed with the status
“Come" in a message display / message
window.

The operator registers the message as requiring
an acknowledgement and acknowledges the
message.

The status of the message changes
to “Come + aknowledged".

The operator removes the cause that triggered
the event.

The status of the messages changes
to “Gone + acknowledged®.

[ The message is no longer pending. }

An alarm with a single acknowledgement requires an acknowledgement as soon as
the event that triggered the alarm occurs. The alarm remains pending until the op-
erator acknowledges the alarm.

Alarm without status “gone” with acknowledgement

The alarm remains pending as long as the event that triggered the alarm is pending
and the alarm has not been acknowledged. If the event that triggered the alarm is
gone and the alarm is acknowledged, the alarm will not be displayed any more.
The message is archived.

Initial value alarm - flashing and single acknowledgement

An initial value message is a message within an alarm class. The alarm of which
the status has first changed after the last acknowledgement is highlighted by a
flashing in the alarm window. This alarm is called initial value alarm.

New value alarm - flashing and single acknowledgement

New value alarms are alarms within an alarm class. The alarms of which the states
have changed after the last acknowledgement are highlighted by a flashing in the
alarm window.
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4.6.3

Message with double acknowledgement

The message is triggered by an event.

“Come" in a message display / message

The message is displayed with the status
window.

The operator registers the message as requiring
an acknowledgement and acknowledges the
message.

The status of the message changes
to “Come + acknowledged®.

The operator removes the cause that triggered
the event.

The status of the message changes
to “Gone“.

The operator has to acknowledge that the
cause was removed.

The status of the message changes
to “Gone + acknowledged®.

{ The message is no longer pending. }

A message with a double acknowledgement requires an acknowledgement as
soon as the event that triggered the alarm occurs and an additional acknowledge-
ment when the event is no longer pending. The alarm remains pending until the
operator has acknowledged the alarm twice.

New value alarm - flashing and double acknowledgement

New value alarms are alarms within an alarm class. The alarms of which the states
have changed after the last acknowledgement are highlighted by a flashing in the
alarm window. These alarms must be acknowledged with the states “coming” and

“going”.
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4.6.4 General Information on acknowledgement concepts

Acknowledgement of several messages at one time

The acknowledgement of several alarms at one time can be made by a group ac-
knowledgement of an alarm group.

e Group acknowledgement in the message display
All the visible, pending alarms that require acknowledgement can be acknowl-
edged in one time with the button “Group acknowledgement” in a message
display.

Note Alarms with activated for which a single acknowledgement has
been activated, cannot be acknowledged by group acknowl-
edgement.

e Acknowledgement with alarm groups
If you want to acknowledge several alarms at one time, these alarms must be
assigned to the same alarm group. This means that if one alarm from this
alarm group is acknowledged, all the other alarms from this alarm group will
also be acknowledged. Therefore it is no longer necessary to acknowledge
each alarm separately.

You will find further information on the alarm groups under Chapter 4.5.

Alarm annunciator

When an alarm annunciator was configured for an alarm requiring acknowledge-
ment, there are the following possibilities of acknowledging the alarm annunciator.

o The operator acknowledges the alarm annunciator together with the alarm re-
quiring acknowledgement.

e The operator acknowledges the alarm annunciator with the button “Acknowl-
edgement alarm annunciator” in an alarm display.

e The alarm annunciator is acknowledged by a tag.
The settings for the acknowledgement of the alarm annunciator are made in the
settings for the alarm class. These settings are applicable separately for every
alarm class requiring acknowledgement.

Emergency acknowledgement

With the button “Emergency acknowledgement” of an alarm display, alarms requir-
ing acknowledgement can be directly acknowledged with the alarm number in case
of emergency.

NOTICE The acknowledgement bit is also sent to the PLC, if the alarm with the re-
spective alarm number is not pending.

Only use the emergency acknowledgement in case of emergency.

Note You will find further information concerning the acknowledgement of alarms in
WinCC Professional at the following link:

http://support.automation.siemens.com/WW /view/en/55622122

Messages in WinCC (TIA Portal)
V1.0, Entry ID: 62121503 185


http://support.automation.siemens.com/WW/view/en/55622122

Copyright © Siemens AG 2012 All rights reserved

5 Links & Literature

5 Links & Literature

Internet links

The following list is by no means complete and only provides a selection of appro-
priate information.

Table 5-1

Topic

Title

\\

Reference to the
document

http://support.automation.siemens.com/WW /view/en/62121503

\2\

Siemens Industry
Online Support

http://support.automation.siemens.com

\3\

System Manual
WinCC Advanced
V11.0 SP2

http://support.automation.siemens.com/WW /view/en/57 358923

\4\

System Manual
WinCC Profes-
sional V11.0 SP2

http://support.automation.siemens.com/WW /view/en/57341024

\5\

System Manual
STEP 7 Profes-
sional V11.0 SP2

http://support.automation.siemens.com/WW /view/en/57 185407

\6\

SIMATIC HMI
control panels
Comfort Panels

http://support.automation.siemens.com/WW /view/en/49313233

6 History

Table 6-1
Version Date Change
V1.0 09/2012 First issue
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